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Chapter 1: Getting Started

In this chapter you will learn how to:

Recognize the difference between the Windows versions
Log in

Recognize parts of the desktop

Use the mouse and keyboard

Use the Getting Started Center

Use the desktop, taskbar, Start menu, and System Tray
Log off, restart, and shut down the computer
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1.1 Basics of Windows 7

Windows 7 is the seventh major Windows release from Microsoft.

Windows 7 takes your personal safety to heart when it comes to working with online
and third-party material. Internet Explorer 8, Windows Firewall, Windows Defender,
and the core of Windows 7 itself all work together to block nearly all potentially
dangerous content from harming your computer. In fact, it's almost hard to cause
trouble!

Just keep this general rule about Windows 7 (and all computers) in mind: if something
flashes on the screen and then goes away before you can read it, chances are you
didn’t need to see it. On the other hand, if something appears on the screen and won't
let you work around it, then you need to pay attention.

What's New in Windows 7?

If you have used a previous version of Microsoft Windows, such as Windows ME,
2000, XP, or Vista, Windows 7 will contain some familiar features as well as a number
of changes which are designed to help you enhance your working ability and
productivity.

An operating system is a complex computer program that provides an interface
. between the user and the computer hardware.

If you have never used a computer before or only had very limited experience,
Windows 7 is very graphically-oriented and boasts many intuitive controls/features
described in plain English. Even if you are a new user, take some time to go over this
list of features. You are not expected to understand everything out of the gate, but
most of the basic Windows 7 programs and interface enhancements mentioned here
will be discussed in detail later in this manual.

Searching & Every folder in Windows 7 contains a search area that is

Organizing used to find a particular file. Just type the name of the file
you are looking for, or even type some information
contained in the file. The background indexing of files is
much less intrusive compared to Vista, and new
organization folders called libraries help to organize your
information. Enhanced biometrics support (fingerprint
readers, etc.) and a central Credential Manager hold all of
your personal identification information.

Security Vista added many new security features to protect your
data and your family from malicious content. Windows 7
expands on these security features while making them
work more in the background.

(Vista users rejoice!) User Account Control (UAC) warnings
are now easily customizable and much less intrusive.
Windows Defender and Windows Firewall have also been
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Internet Explorer 8

Ease of Access
Center

Parental Controls

Back Up and
Restore

Action Center

Windows Media
Center

Tablet PC Features
& Touch Screen
Capability

Problem Steps

improved.

Windows 7 includes Internet Explorer 8, an enhanced
version of Internet Explorer that includes tabbed browsing,
Web Slices, Microsoft Silverlight, and more.

Windows 7 offers a helping hand to users who are hard of
seeing, deaf, or have other physical disabilities. Speech
recognition, an on-screen keyboard, enhanced contrast and
colors, and other accessibility options allow virtually
anyone to interact with a computer. (These options replace
the Accessibility Options in previous versions of Windows.)

The computer is as common a tool in the classroom as a
ruler or pencil, and most homes have at least one
computer. Windows 7 includes enhanced and expanded
parental controls to limit the time a child can spend on a
computer, prevent games with offensive content, control
Internet content and usage, and prevent children from
running specific programs.

Windows 7 can back up settings, files, and programs to
CD, DVD, USB flash drive, hard drive, or another computer
on a network. Windows 7’s backup utility is much more
flexible than previous versions and gives you much finer
control over what gets saved. You can perform these steps
manually or use the automated scheduling option via the
Action Center (described below).

The Action Center is an easily accessible feature that
combines security issues, troubleshooting, and recovery
options together in one location instead of three. Many
more advanced options are also available here, so we will
give you a brief overview of the Action Center later in this
manual.

Turn your computer into an easy-to-use platform for all
your multimedia needs. Watch live or recorded TV, movies,
music, and pictures all in one place. The Media Center
version in Windows 7 has a few interface upgrades, but the
majority of improvements have been made in the
background, allowing more support for digital cable and
channel guides, and an enhanced Personal Video Recorder
(PVR) interface including a commercial-skip option.

A tablet PC works like a laptop, except that the screen can
be written upon using a stylus or your finger. Improved
handwriting recognition and navigation shortcuts allow
tablet PC users to improve productivity while on the go.
Windows 7 also features an equation converter; support for
dual touch input, text tuning, and color calibration; and
more.

Windows 7 lets you take support one step further with
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Recorder

ISO Burner

PowerShell V2

Interface
Enhancements

XP Mode

Enhanced
Performance

Problem Steps Recorder (PSR). This program is similar to
screen-capture software that captures every user action
(keystrokes, mouse movements, clicks, etc.) and saves
them in a file you can view separately. No more trying to
figure out what was clicked; now you will know precisely
what happened!

Windows 7 very handily adds ISO (CD/DVD image files)
support to burn these files to CD or DVD. All you have to
do is insert a blank CD or DVD, double-click the ISO file,
and Windows will burn it for you. No third-party
applications are required.

Windows PowerShell V2 lets computer administrators set
up and run scripts in a UNIX-like environment. These
scripts can be used to automate nearly every computer
function.

Windows 7 has a redesigned taskbar, window management
controls, Jump Lists, and more.

Even the old standbys of Paint, Calculator, and WordPad
have been given a much-deserved facelift!

Windows XP was the most used version of Windows made.
Using virtualization technology (creating a fully-operational
computer containing its own memory and hard drive space
within your computer), you can use XP Mode to install and
run your programs in a Windows XP environment.

Windows 7 is capable of running on a wide variety of
computers (even most machines that came installed with
XP) and takes advantage of fast hardware.

Windows 7 Versions

Windows 7 comes in two

main flavors, but there are six versions. Here is the

difference between the different versions:

Home Premium

Professional

Specialized

The core elements of Windows 7 are included here,
including Windows Media Center and all the standard
programs. For the vast majority of people, this version
offers everything they should need.

Home Premium features + XP Mode, business networking,
and automatic backup capabilities.

There are four versions in this category:
= Starter is the most basic version
= Home Basic includes some specialty programs,
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about 1/3 of what you would get with Home
Premium

» Enterprise contains Professional elements + extra
security and advanced networking

= Ultimate contains professional and Enterprise
elements as well as other Windows and Microsoft-
specific technology

Logging In

When you turn on your computer, you will see a login screen that contains a small
picture with either your user name or the account named “Administrator.”

In the bottom left-hand corner of the login screen you will see a blue link for the Ease
of Access Center, a place where you can set accessibility options:

On the bottom right-hand side, there is a red power button symbol. Click the ()
button for options to shut down or restart the computer:

o1

Move your mouse and point to your user name. Then press and release (click) the left
mouse button somewhere inside the white text area under the picture.

Enter your password on the keyboard and press the Enter key or left-click the blue
arrow button:

(If you don’t have a password on your account, the computer will simply log you in.)
After a few moments, you will see the desktop appear.
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The Windows 7 Desktop

A few moments after logging in, you will see the desktop:

1:224 PM

[ )
Al ) g 8000

Let’s quickly explore the different components of the screen in front of you.

The Recycle Bin icon is in the upper left-hand corner; any files that are going to be
erased from your computer are stored here until the bin is emptied.

The bar along the bottom of the screen is collectively known as the taskbar. It
contains four distinct objects/regions. On the far left is the Start button which allows
you to access programs and regions of your computer:

>

To the right of the Start button is the main area of the taskbar. By default, there are
three icons here that are used to start and move between programs. From left to
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right, they are Internet Explorer 8, Windows Explorer, and Windows Media
Player:

When you click any of these icons, a new window will appear and you can begin to use
the program. Let’s imagine you have clicked Internet Explorer. A window containing
Internet Explorer will open, and the Internet Explorer icon in the taskbar will have a
border around it (look at the red arrow below):

N http://www.msn.com/

¢ Favorites | 5 (@ Suggested Sites v 2| Web Slice Gallery v
| % MSN.com o~ v [ dwh v Pagev Safetyv Tookv @~

1 FLAT stomach rule: You must OBEY Tuesday, August 18, 2009

Web | MSN | Images | Videos | Shopping | News | Maps

Airfa & E i s /Rental

Autos n Shopping White |

Careers & Jobs Health & Fitness Vi Sports Wonde

City Guides Horoscopes usic Tech & Gadgets Yellow
Lifestyle v

» Sign in
Make MSN your homepage
Customize your Page v

BMW Advanced Die

Conscience clearer.
580 Miles/Tank
Up to 36 mpg e |
Next > 20%Less CO, 4 quw mmy
_ e R
Robert Novak [Loammore | =

Columnist, TV
i commentator i,
dies of cance

»
@ Internet | Protected Mode: On G v ®10% v

w27em |

- )
A0 18000

If you happen to have several windows from the same program open at once, the
program icon becomes layered, like this:

Finally, in the bottom right-hand corner, there is a listing of active services that are
running in the background on your PC. This area is called the System Tray:

The small icons on the left show the status of some computer function or program. In
the middle you can see the date and time. And in the very bottom right-hand side of
your screen is the Show Desktop button. You would click this button to minimize all
open windows and view your desktop.
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1.2 Interacting with the Computer

Windows 7 is an operating system designed around a graphical user interface
(GUI) so the mouse plays an integral role. It is your virtual hand that moves,
commands, and interacts with your computer.

Pointing the Mouse

You are likely a bit skilled with this by now, particularly with the previous lesson’s
exercises. As you move your mouse, the cursor on the screen will follow the
movements. Sometimes your mouse might seem to be “getting away” from you; that
is, you might have your arm stretched across the desk trying to move the cursor. This
is not necessary; simply pick up your mouse and place it in a more comfortable spot,
and then continue moving your mouse to the destination.

Using Click and Double-Click

The mouse is designed for use by right-handed people. Your mouse has two main
buttons that are used by your index and middle fingers: your index finger presses the
left button and your middle finger presses the right. (Windows includes an option to
reverse this for left-handed people.)

In this manual (and just about in every other computer book or reference), when you
are told to “click” something, this means moving your mouse pointer on top of the
object and pressing then releasing the left mouse button. The majority of controls in
Windows, and on a Web page when using the Internet, are “clickable.”

When you are asked to “double-click” something, it means you need to press and
release the left mouse button twice quickly. This operation is usually used to open a
folder (double-click this folder to open it and view its contents) or start a program.

Using Click and Drag

Click and drag is an operation that is used to interact with different objects, such as
an icon on your desktop or a program control such as a slider bar. The “click and
drag” operation is performed with the left mouse button. Position your mouse over the
thing you are going to interact with, press and hold the left mouse button, and then
move your mouse. You will drag the item along as you move your mouse pointer.

The click and drag operation has a broad use in word processing programs (programs
that let you type letters and documents on your computer). Consider the following
sample text that was written using WordPad, a word processing program included with
Windows 7:

DIII

4 1 2 3

The quick brown fox jumped over the lazy dcug.|

You can “highlight” or “select” the text by placing your cursor in front of the sentence:



MS Windows 7 Foundation Manual

FAEREEEES SRR AN RN

The quick brown fox jumped over the lazy dog.

Then press and hold the left mouse button down and drag across the text, releasing
the button at the end of the sentence:

Gl 23

he guick brown fox jumped over the lazy dog.

Now that the text is selected, it can be italicized, have a color added, made bigger or
smaller, moved, and more.

Using Right-Click

You can right-click an object the same way that you left-click something: you hover
your mouse over the object and then press and release the right mouse button. The
act of right-clicking is a skill you should learn because many shortcuts to operations
are contained in a right-click menu.

For example, if you right-click on some highlighted text in WordPad, you will see the
following menu appear by the mouse pointer:

FAEEEEEEE SRR R

Copy
Paste
Paragraph
Lists

For the rest of this manual, assume that every time you see the word “click,” we
mean you should left-click the object. Any right-click operations will be labeled just
that!

Now that you know more about the mouse, let’s quickly review the click operations:

Left Click Button

= Used to select, highlight, or open an item.

= Has a single-click and double-click option. (The default
Windows settings are single-click to select or highlight an item
and double-click to open it.)

= The left mouse button can also be used to drag or highlight an
item. This can be done by clicking and holding down the left
button, dragging or highlighting your desired item(s), then

9
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releasing the left button.

Right Click Button
= Often used to bring up a short-cut menu.
» This menu will change depending on what you are right-
clicking, but it is there to help you access a feature faster.

When doing things on a computer, you will often have to dig a little bit through a
program sorting method to find what you want. For example, to open WordPad, a
basic word processing program, you have to click the Start button, and then click All
Programs, and then click Accessories, and finally click WordPad. Rather than writing
all of that out, we’ll denote that path of commands like this:

Click Start > All Programs > Accessories > WordPad

We will use this notation for the rest of this manual.

Using the Keyboard

A standard PC keyboard looks something like the one shown below. A laptop keyboard
is a bit smaller and usually doesn’t have the numeric keypad shown on the right:

NUM  CAPS SCROLL
F§ FidQ Fi1 Fi2 LOCK LOCK LOCK

o Q o

SHAHEERAHNNEEES IDRRIBNEaE
= lao|wle[r[T]v]u] JREEE P 12 E2 ) 1 +
EAE FlalH]u|k|L] |@] &= < ° 5
powe Jz|x[clv]B[N[M[][7]7 s o t Ll e -
= 1] ~ o ve 2] = [V [S)2 b |

A keyboard has a QWERTY layout, defined by the first six letters on the top row of
keys. Many smart phones use this layout to make typing e-mail and text messages

easier.

Main Keypad
(largest
portion of the
keyboard)

Function
Keys
(F1-F12)

Consists of the alphabet keys with number keys above. You may
also see one or two Windows keys, which have a picture of the
Windows logo on them. The Windows key is used to show the Start
menu. To the left of the right-hand Ctrl key is the short-cut key
which brings up a shortcut menu (the same as the right-click of
your mouse).

Used differently depending on the application being used. For
example, in Internet Explorer, the F5 key is used to refresh that
window (meaning it reloads the information on the Web page you
are viewing). Almost every program uses the F1 key to display the
Help file. You will become more experienced with the function keys
as you use more programs on your computer.

10
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Number Pad

Editing Pad

Also called the numeric keypad, these keys are located on the right-
hand side of the keyboard. These keys serve a dual function. With
the Num Lock key (located on the top left of the number pad)
toggled to ON, the numbers are displayed. With the Num Lock key
toggled to OFF, the secondary function of the key will work. Most
keyboards will also have indicator lights for the Num Lock key (as
well as Scroll Lock and Caps Lock).

1 This is the keypad number 8. With the Num Lock key
turned ON it would type the humber 8 in a document.
With the Num Lock key turned OFF the up arrow would

be used to move the cursor up.

.-

.,

\
| .
. 4

M

This section of the keyboard is the column of keys between the
main keypad and the numeric keypad. The top three keys are the
Prt Scr/Sys Rq key (print screen and system request), the Scroll
Lock (used to lock the scrolling function), and the Pause/Break key
(used to pause the computer during certain functions).

Below these keys are the Insert and Delete keys, the Home and End
keys, and the Page Up and Page Down keys. These keys (in
conjunction with the arrow keys below the Editing Pad) are mainly
used in word processing and other applications to view/edit
documents.

11
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1.3 A Quick Look at Windows 7

In this session you will cover the Getting Started Center, discuss how to use items on
your desktop, learn about the different sections of the Start Menu, and learn about
the toolbars accessible from the desktop.

Using the Getting Started Center

To view the Getting Started Center, click the Start button. The Getting Started item
should be near the top of the menu. Click this item to open the Getting Started
Center:

‘j’ Getting Started %

Q Windows Media Center NEEE

= Documents

.| Calculator

Pictures

Sticky Notes

Music
% Snipping Tool

If you don’t see this item in your Start menu, click Start - Control Panel, found on
the right-hand side of the Start Menu. When the Control Panel window appears, click
the View by: Category command and then click either Large or Small icons. Find
Getting Started in the list of items (they’re in alphabetical order) and double-click it to
open the Getting Started Center.

In order to get the most out of the Getting Started Center, you will need access to the
Internet.

This program was designed to help novice computer users and people new to
Windows 7 find their way around.

bl

1 L)’ =i » Control Panel » All Control Panelltems » Getting Started

Go online to find out what's new in Windows 7
« Discover new features that can help you be productive, stay safer, and have fun

» Find out everything you need to know about setting up your computer = Go online to learn more

f Go online to find out what's new in f N . ‘i Transfer files and settings from
g: Windows 7 | Personalize Windows k\s another computer
) X
Use a homegroup to share with Choose when to be notified about t\, Go online to get Windows Live
Q other computers in your home \ changes to your computer ‘ Essentials
>

'a\g Back up your files % Add new users to your computer ! SC:"::;Q‘E the size of the text on your
= 3

There are three basic parts to this window.
12
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At the top are two text boxes. The left one tells you where in Windows you are;
specifically we are viewing Control Panel > All Control Panel Items > Getting
Started. On the right, there is a place for you to type a question or a term in order to
search and find more information in the Windows 7 Help file. (We will explore the Help
file later.)

The light blue area in the middle provides information about the specific item that has
been selected. By default, the “Go online to find out what’s new in Windows 7" link is

shown here. On the right-hand side of this middle area is a green arrow with “Go
online to learn more” written beside it. This text is actually a special item called a

hyperlink.

You may have heard the term “hyperlink” or “link” before as it is used on the Internet.
If you click that bit of text, Internet Explorer will open and direct you to a Microsoft
Web page that details some of the new features of Windows 7.

The bottom part of this window, with the white background, lists all of the other links
in the Getting Started Center. Here is a brief overview of the other options:

Personalize Windows

Transfer files and
settings from another
computer

Use a Homegroup to
share with other
computers in your home

Choose when to be
notified about changes
to your computer

Go online to get
Windows Live Essentials

Back up your files

Add new users to your
computer

Modify the style of your desktop, screen saver, and theme.

If you have purchased a new computer with Windows 7
and want to transfer all of your personal files and folders
from another computer, this option will open Windows
Easy Transfer and walk you through the process.

This option lets you create and use a simple network
between two or more computers in a local area, like an
office or your house. This network will let you share
pictures, music, videos, documents, and printers with other
members of the network.

Use this option to modify User Account Control settings,
which warn you about changes that are about to be made
to your computer. These settings are beyond the scope of
this manual, so we recommend you leave these options
alone. The default options will help keep you safe.

This link will let you download Windows Live, a
comprehensive program that lets you stay in touch with
friends, write blog posts (a journal on the Internet anyone
can read), and send/receive e-mail messages for free. We
will cover the basics of Windows Live Essentials later in this
manual.

You can have Windows 7 automatically back up your files
and folders in case something should go wrong with your
computer.

Windows features the ability for several people to use the
computer (though not necessarily at the same time!). If
you have administrative rights, you can set up user
accounts that let each person have their own personal files

13
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and settings.

Change the size of the If you are hard of seeing or just like to use a large font,

text on your screen use these settings. You can also change the screen
resolution (how much information you can fit on the screen
at once).

Using the Desktop

The Windows 7 desktop is designhed to be used just as you would your desk or table at
work. Items can be arranged in any order, folders and files can be saved on the
desktop, and most programs run in separate windows on the desktop.

Earlier, we learned a little bit about the different components (Start menu, taskbar,

Recycle Bin, etc.) on the screen. Now we will focus on working area of your screen.
Let’'s examine a sample desktop with a few different items:

»
2
-

[RECYCISIE T

|
S0oppInCisy [CXETCISEIRI[ES

it

There are four icons on this desktop, with part of a picture (called the wallpaper) in
the background. The Recycle Bin is a storage area for old files or folders that are
ready to be deleted.

There is a folder called Exercise Files that contains data. Windows 7 changes the icon
of a folder to reflect its content. If you look carefully at the Exercise Files Folder, you
can see it is displaying a folder inside the main folder. If there was a folder on your
desktop with some pictures inside, you would see small thumbnail images of some of
those pictures poking out of the folder.

The “shopping list” file is a file that was created in Notepad (a very basic text editor)
and saved on the desktop. This means that the file will always be there on the
desktop until I move it or delete it.

Finally, the last icon is used to open the game Minesweeper. This is a special type of
icon called a shortcut. Shortcuts are direct links to files, folders, or (most often)
programs. They are identified by the small arrow in the corner of the icon.

14
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Clicking any of these icons will highlight the icon, such as the shopping list:

Double-clicking the icon will open the file/folder or launch the program. Here we can
see an empty Recycle Bin:

[ [ ———

(M= > RegteBin |4 SochRegcefin 0]
-+ 0O @

Organize =

0 Favorites
B Desktop
1 pics

Bl Desktop

- Libraries
@ Documents
Jl Music
[E5| Pictures
@ PV Business
Eﬁl Velsoft
m Videos
A BOK-JOHN

1M Computer
£ Local Disk (C:)

0 items
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You can also right-click an icon to see some different options available for that
particular item. This right-click menu varies from item to item:

& Empty Recycle Bin

Create shortcut

Rename

Properties

dupplugll | Sl

Icons can be moved one at a time around the desktop by clicking and dragging, and
then releasing the icon at the desired location. You can actually move files in and out
of folders using this method.

To move many icons at once, click and drag a box around the icons first. You will see
a blue area outlining where you have dragged. This means that the items are
selected. Below, we have selected three items:

16
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Now if you click and drag any of the selected icons, you can move all of the selected
icons as a group:

o
\ e

G L
o
g > o
%ﬁt‘j@ﬂ” BECYOIEIE [T
= ,si
‘ i
(EXETCISEInI (€8 Aisyaiaiing s
IVHHESTEERED

We have seen that you can access different properties and commands by right-
clicking on an object. This is also true for the desktop. Right-click in any empty space
that does not have an icon and make a selection:

'>5 View 3
Sort by 3
Refresh
Paste

Paste shortcut
Undo Delete Ctrl+Z

Mew 3

B Screen resolution
i Gadgets

g Personalize

You can see from the picture that some items in the right-click menu have a small
arrow on the right-hand side of the option. If you hover your mouse over this menu
option, a submenu with more options related to the main option will appear. In the
image above, you can see options to View and Sort icons on the desktop, create a
new file or folder, and customize display options.

Using the Start Menu

The Start menu is the primary gateway to everything your computer has to offer. All
installed programs can be accessed here, you can view different locations on your
computer, and you can use it to search for files.

17
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Click the blue Start button in the lower left-hand corner of your screen to view the
Start menu:

—
\j’ Getting Started

@ Windows Media Center Velsoft

Documents
Calculator

Pictures
Sticky Notes

Music
% Snipping Tool
=y Games
'Ej Paint

Computer
% Remote Desktop Connection

Control Panel

Jf Magnifier

‘. b‘ Solitaire

@ Snaglt 8

Devices and Printers
Default Programs

Help and Support

»  AllPrograms

I Search programs and files
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There are five different sections in the Start menu. Let’s go over what each section

does:

Program Listing

_l[ Getting Started

Q Windows Media Center

Cal

Calculator

Sticky Motes

% Snipping Tool
,ﬁ/:f Paint

Remote Desktop Connection

Q Magnifier

-"i Solitaire
@ Snaglt 8
b

All Programs

On the left is a list of programs that have been
recently used on your computer.

At the bottom of the list is the All Programs Link. If
you click this item, a list of all programs that are
installed on your computer will appear. Click a
program name to launch that program. Click any
folder to view the contents of that folder.

'@ Default Programs

. Desktop Gadget Gallery

& Internet Explorer (64-bit) Programs
& Internet Explorer

"-'éJ Mew Microsoft Office Document

= Open Microsoft Office Document

€ Windows DVD Maker

E2] Windows Fax and Scan RECEH"."Y
 Windows Media Center Installed

[2] Windows Media Player Programs

£ Windows Update
- XP5 Viewer
. Accessories “‘ Folder

, Games

, Maintenance
. Microsoft Office
. Microsoft Visual Studio 2005

. Snaglt &
? Back to
. Startup :
. Windows Live Previous
Menu

19



MS Windows 7 Foundation Manual

Search Bar

| |Se:.'r':h programs and files

P

Located just above the Start Button is the Search
Bar. If you type the name of a program or file,
Windows will automatically look for the item based
on the search criteria you entered. Any relevant
results will be displayed at the top of the Start
menu.

For example, here we have started to type
“wordpad” into the Search Bar:

Programs (1)

| [El wordpad

Documents (3)
|| Windows 7 F Draft

| |windows 7 outline
I@]‘|.I"|"ir1u:iu:n.w.rs‘l.n"istaUItimatv.='__F|:rur1u::latiu:rn_Instrl.J ctorGuide

j,'_; See more results

| wordp| f— % || Shutdown | » |
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Quick Links

Velsoft

Documents

Pictures

Music

Games

Computer

Computer Control

Control Panel
Devices and Printers

Default Programs

Help and Support

The Quick Links area displays your user name and
picture, as well as links to your Documents,
Pictures, Music, and Games. Clicking any of these
links will open the associated folder on your desktop
to show you the contents:

-

Organize « Options Tools = Parental Controls 52

4 (3ame Providers (1)
y More Games from Microsoft *

) Microsoft Corporation

4 Games (11) =

Chess Titans
Microsoft Corporation Check your computer's
Performance Information:

FreeCell
B ) Current System ﬂ
Microsoft Corporation ¥ "_FJ-'
Learn mere about these

Hearts scores
Microsoft Corporation

=
P Internet Backgammon
f Microsoft Corporation

e !
(7788 Internet Checkers

*’ 12 items

The Computer Control area lets you perform more
advanced tasks related to your PC.

The Control Panel option lets you customize nearly
every detail of Windows 7. Devices and Printers
lets you view and modify properties of external
devices connected to your computer. Default
Programs assigns a certain program to open
automatically when a certain action must be
performed, and the Help and Support Center
provides a full help manual for Windows 7.

We will explore the Help and Support feature later
in this manual.
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Power Options These controls are used to power down your
computer or lock it so no one else can use it while
rE— m | you are away. By default, Shut down is displayed.
- | Click this button and your computer will close any

open programs, log you off of the computer, stop
using Windows 7, and then power itself down.

If you click the arrow beside Shut down, you will
see these options:

Switch user
Log off
Lock

Restart

Sleep

Switch user will not log you out of the computer;
you will be returned to the login screen and your
user account will be shown as currently signed in.
You will need to enter your password to use the
computer again. Log off will close any open
programs and return you to the login screen. Lock
will make the computer inactive so only you can use
it. Restart is similar to Shut down, only the
computer reboots (power cycles) itself and doesn’t
actually power off. Finally, Sleep will put the
computer in a low-power usage state and act like it
has been shut down.

We will explore these power options in more detail
in the next lesson.
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Using the Taskbar

The taskbar is located between the Start menu and the System Tray. This is where all
open programs, files, and folders are displayed:

R e ™ - e o e

By default, the three icons on the left of the above image are displayed. They are,
from left to right, Internet Explorer 8, Windows Explorer, and Windows Media Player.
There are also three other program icons. Notice that Windows Explorer has two
borders indicating that there are two open Windows Explorer windows.

If you hover you mouse over an icon for a program that is not currently running, you
will see the program name appear:

Internet Explorer

If you hover your mouse over a program icon that has one or more instances of the
program open at once, you will see a thumbnail view of what the program looks like.
For example, here are the two open Windows Explorer windows:

B Windows70

R -

We will cover how to work with windows on the taskbar later in this manual.

As you open and use more programs at once, new program icons will be added to the
right of the last taskbar item. You can click and drag these icons (including the three
default ones) wherever you like. For example, if you wanted to put the Windows
Explorer icon in the first (leftmost) position on the taskbar, just click and drag the
Windows Explorer icon to the left of Internet Explorer.

Right-click the taskbar to display extra options:
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Toolbars Address

Links

Tablet PC Input Panel
Desktop

Cascade windows
Show windows stacked

Show windows side by side

Show the desktop Mew toolbar...

Start Task Manager

Lock the taskbar
Properties

The Toolbars option shows a list of all toolbars that can be shown on the desktop and
taskbar. The other options in this menu allow you to organize the windows on your
screen in a certain way. The Task Manager allows you to monitor all programs and
processes that are currently running.

Using the System Tray

When you first log in to Windows 7, there are a few services and background
programs that start in order to provide extra functionality for the computer. These
programs usually have an icon in the system tray, located in the bottom right-hand
corner of your screen by the date and time:

10:22 AM
772872009

Mz % W

In the bottom-rightmost corner of your screen, there is a rectangle to the right of the
date and time. This is the Show Desktop button. Click this to minimize (hide) all open
windows. We will discuss how to manage windows later in this manual.

As you become more familiar with Windows and install more programs, more icons
will be added to this area. Sometimes, certain icons that were visible in the system
tray will hide themselves in order to make more room on the taskbar.

To see any hidden items, click the (©) icon in the system tray:

10:27 AM | |

/28720098

- [mz Ll WD

This will show all icons for the background programs or services that are currently
running but are inactive:
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Most icons can be interacted with by clicking, double-clicking, or right-clicking the

Windows 7
‘ation copy. Build 7100

icon. For example, the clock is displayed by default in the system tray. If you click the
time, you are shown a basic calendar and you can modify the date and time shown by

your computer:

Tuesday, August 18, 2009

August, 2009

Mo Tu We
27 28 29
3 & 5
{1 2% el
17 i8] 19
24 25 2
31 1 2

Change date and time settings...

Th
30

6
13
20
27

2
y

1:35:30 PM

1:35 PM
8/18/2009
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1.4: Exiting Windows 7

When you have finished your work for the day or have finished using your computer,
it is @ good idea to turn off your computer and save energy. Windows 7 offers a few
options besides simply powering off your computer, which we will explore in this
lesson.

Shutdown Options

There are two different shutdown options available in the Start Menu:

Switch user
Log off
Lock

Restart

Sleep

Sleep Your computer uses RAM (Random Access Memory, or simply
“memory”) to operate programs and processes on your
computer. The Sleep function makes the computer save all the
contents of the memory on the hard disk, closes all open
programs, logs you off, and then physically cuts the power to
your computer.

When you press the power button on your computer, move the
mouse, or press a key on the keyboard after it has gone to
sleep, Windows will automatically log you back in, re-open the
programs you had open, and restore the memory. The
advantage of using the Sleep function is that it usually takes less
time to start your computer.

Shut Shut Down requires you to save any work you may be doing,

Down closes all programs, logs you off of the computer, and then turns
off the power. The advantage of shutting down is that although
it takes longer to start your computer than Sleep, it starts the
computer with a clean slate. No programs other than the default
startup programs will be operating yet, and the memory is
operating at its most efficient level.
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Logging Off the Computer

Logging off allows another user to operate the computer under their own account. We
mentioned earlier that Windows has the capability to store the data and settings for
many users so that one person can log on, do their work, log off, and then a different
person can log onto a different account and do their own work.

To log off, click the Start button, point to the (>) icon beside Shut down, and then
click Log Off:

Switch user
Log off
Lock

Close pr
Restart

Sleep

You will be asked to save any open documents before Windows shuts down all
programs and log you out of the computer. The next person can click their user
account and enter their password to log into their own environment.

The Switch User options works similarly to Log Off; however, you do not have to close
or save your programs. It is simply a way to get up and let someone else use the
computer under their own account. When they have finished their work and log off,
you will notice a small “Logged In” label under your profile name. Click your profile,
enter your password, and keep working where you left off.

Restarting the Computer

Restarting the computer is just like shutting down the computer, except that the
computer never actually powers off. All cooling fans and hard drives are still
operating. The computer will then start to load Windows again, with clean memory.
Once you begin to install your own programs onto Windows, you will become familiar
with restarting your computer. Restarting ensures that any files used during
installation are removed and the program listing inside the core of Windows is
properly updated.

If you are going to do a performance-demanding task, such as run a large
spreadsheet or play a 3D game, it is recommended you restart your computer first.
This will ensure that no other programs are occupying memory unnecessarily, and
also allows the central processing unit (CPU, the brain of your PC) to concentrate on
your specific task.

Restart your computer by clicking the Start button, pointing to (>) beside Shut down,
and clicking Restart:
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Switch user

Default Program

Log off

Help and S
elp and Suppo Lock

Restart

: Sleep [¢joses all open programs, shuts down Windows, and

then starts Windows again.

Turning off the Computer

Turn off your computer by clicking the Start button and then clicking Shut Down:

Closes all open programs, shuts down Windows, and then turns off your computer.

Bws=

You should always shut down the computer using this shortcut. However, this may not
always be possible if a program has frozen, crashed, or become otherwise
unresponsive. You should first try to manually stop the program using the Task
Manager (more on this later) but if even that should fail, push and hold the power
button on your PC for a few seconds. Once the computer has powered off, wait at
least 30 seconds before powering it back on.
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Chapter 2: Working with Windows 7

In this chapter you will learn how to:

» Start a program
Recognize the different parts of a program's interface
Launch Help from within a program
End a frozen program
Exit or close a program
Use Minimize, Maximize, and Restore
Resize windows
Manage windows
Use different Aero Desktop features
Use files, folders, and Libraries
Navigate through your computer
Use menus and the Ribbon interface
Use shortcut keys and shortcut menus
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2.1 Application Basics

Windows 7 is an operating system; a complex program that lets you interact with the

computer hardware and run other programs. Windows manages the memory, hard

drive, and CPU usage for all programs running to ensure that each program gets their

share.

Starting a Program

There are three different ways to start a program in Windows 7, the most common

being the Start menu:

’3' Getting Started

@ Windows Media Center

-

Calculator
Sticky Notes
Snipping Tool
_,é;“.g"‘- ) Paint
Snaglt 8
' Remote Desktop Connection

Magnifier

“ Solitaire

»  All Programs

I Search programs and files

Velsoft
Documents
Pictures

Music

Games

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

Programs are accessible in the left-hand pane of the Start menu. The programs listed
in the menu above are programs that have been recently used. The higher in the list,

the more often it has been used.
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All other programs are available by clicking All Programs (just above the Search bar)
and then selecting a program, or clicking a folder to open it and then selecting a

program:

0 Default Programs

[ Desktop Gadget Gallery

@ Internet Explorer (64-bit)

@ Internet Explorer

E New Microsoft Office Document

=

Open Microsoft Office Document

& Windows DVD Maker

&%) Windows Fax and Scan
 Windows Media Center
@ Windows Media Player

(’J

Windows Update

~# XPS Viewer

b
b
b
¥

Accessories

Catalyst Control Cepfter

Games

Maintenance

@ Backup and Restore

k Create a System Repair Disc

@ Help and Support_ *— |

1

ad. Windows Remot h'}sis'tance

Back

Search programs and files

Velsoft
Documents
Pictures

Music

Games

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

The second way to launch a program is to click its icon in the taskbar, such as
Windows Media Player:

Windows Media Player

T = RE:
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The final way to launch a program (if applicable) is to double-click a shortcut on the
Desktop, such as this shortcut to Internet Explorer:

Shortcuts are denoted by a small arrow on top of their icon. When double-clicked,
these shortcuts tell the computer to start the program.

Parts of the Application Window

Though every program is different in its own way, most program user interfaces have
similar features. For this example we will use Notepad, a very basic text editor that is
included with Windows. Notepad can be found by clicking Start > All Programs >
Accessories > Notepad.

.. Accessories
l:l Calculator
E¥ Command Prompt Velsoft

@2 Connect to a Network Projector
B Connect to a Projector Documents
=) Getting Started
&) Math Input Panel Pictures

M_7] Notepad \
2l Paint
b Remote[{ Creates and edits text files using basic text formatting,
i3] Run Games
% Snipping Tool

'_, Sound Recorder
7 Sticky Notes
@ Sync Center

4 Windows Explorer
B WordPad

\. Ease of Access Default Programs
1. System Tools

.. Tablet PC Help and Support

Music

Computer

Control Panel

Devices and Printers
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Notepad
= C(Click Start > All Programs > Accessories - Notepad
» Notepad is a very basic text editor which is useful if you need to quickly
jot something down and save it for later.

Notepad will launch in its own window on the desktop:

File Edit Format View Help ﬂ

The interface of this program has the following three components. (In fact, just about
every program has these items.)

Title Bar Every window has a title bar that consists of the document name and
application name, as well as the Minimize, Maximize, and Close
buttons, which we will explore in the next lesson:

Menu Bar Menus provide a tree structure that allow you to use different features

of a program:

File Edit Format View Help
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Working This is the largest section of the program in which you create, view,
Area and modify files using the program:

e !

Mj shopping list - Notepad RSN X
| File Edit Format View Help

Eggs P
i T

Peanut butter
Tomatol

Notepad is very basic so it doesn’t have much to offer in the way of a fancy interface.
There are some other important interface components that you should know about, so
let’s quickly go over some of them by looking at some different programs.

For example, many programs use icons; small pictures that denote a particular
command or action. Look at the top of Internet Explorer 8:

& MSN.com - Wi I Expl 1 [E=EEN
é’\ 7com indows Internet Explorer l} --j» ‘
@U > }\’ http://www.msn.com M | "| A—m-" Songle — & ‘VJ

¢ Favorites | 5 (@ Suggested Sites v @] Web Slice Gallery v

>»

% MSN.com ’-’} > D v [] @, v Pagev Safetyv Tools~ ‘Q»v H

As you can see, there is a lot happening here! But there is a place for everything, and
everything is in its place. There is an Address bar that lets you type a web address,
like www.teia.edu.au. To the right of that is the Search bar, a place to type a word or
words and use a search engine on the Internet to track down relevant information.

Under the Address bar is a series of icons that let you flag certain Web sites as
Favorites (sites you like and want to visit again), return to your home page (the page
that loads when you first start Internet Explorer), send e-mail, print something, and
more. This area can be referred to as the command area; a place where you interact
with program functions.

At the bottom of Internet Explorer (and many other programs), there is a Status bar:

@} @ Internet | Protected Mode: On Fg  H100% -

As the name implies, this area gives at-a-glance details about the program itself. We
can see that we are browsing the general Internet (as opposed to an internal network

34


http://www.teia.edu.au/

MS Windows 7 Foundation Manual

location), Protected Mode is on, and the page is currently being viewed at 100%
zoom.

We will go over the details of Internet Explorer 8 later in this manual. We will also
introduce the Ribbon-style interface later in this manual, used by Microsoft in the
latest versions of WordPad and Paint, in most Microsoft Office 2007 programs, and in
all Microsoft Office 2010 programs.

Moving Around in a Program

As we stated before, every program is different in its own way. However, like the
general layout of the program, navigation through the program or content is very
similar for most programs. Let’s start with the menu bar.

Most programs have three or four menus in common, such as the menus for Internet
Explorer: (Don't worry if you didn't see these before; the menu bar is hidden by
default because the majority of program commands are already visible in the
command area.)

I £ MSN.com - Windows Internet Explorer

S i "f http:/waww.msn.comy

File Edit View Favorites Tools Help

57 Favorites | 55 & Suggested Sites & | Web Slice Gallery ~

\" MSEN.com _ M-

= The File menu lets you manage different aspects of a file. You can open, close,
or save a file with the File menu. Most File menus include a Print command as
well.

» The Edit menu deals with operations that can be performed on the data in a
file. Common commands include Cut, Copy, Paste, as well as Find & Replace.

* The View menu is not as common as the previous two, but is used in most
programs to display the data on your screen in different ways.

* Finally, almost every program has a Help menu. This menu contains a help file
for the particular program as well as licensing information specific to the
program or document. Many programs also have some sort of help icon, which
usually looks like this: @
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Interacting with a menu is easy; simply click a menu heading and then click a
command:

P

j shopping list - Notepad

File | Edit Format View Help
Mew Ctrl+M
Open.. Ctrl+ O
Save Ctrl+5
Save As...

Page Setup...
Print... L} Ctrl+P
Exit

Quite often a menu will have a sub menu as well. Hover your mouse pointer over the
(>) symbol (like the one next to the Rotate command) to show a sub menu with
commands specific to a topic:

Image Colors  Effects  Help

= Bip

E Mirror
Resolution...

Resize Canvas...

| Rotate 90° clockwise
Scale k 180 clockwise

270° clockwise

Customn Angle...

Commands that are shown as icons in the command area of a window occasionally
require some data or object to be selected first. For example, if we want to make text
bold in WordPad, first highlight the text you want to make bold by clicking and
dragging:

g---l---l---l---z---l-
he quick fox jumped over the lazy dog.

The quick fox jumped over the lazy dog.
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Then click the Bold command in the Command area:

.~ =
,E, | = = |Ducument—: Wmdpa
Home View

W
Cut U | [ —
&= calibri n RN E
E Copy e
Pafte B%I U abe X. | 3* |47 - év == ==|l=- Dattin
Clipboard Font Paragraph L
Bold 1 I . I

Change to a heavier font.
iiie quick 1ox jumped over the lazy dog.

The quick fox jumped over the lazy dog.

- = B B R W —
,E, | & 5 + | Document —: Wmdpa
Home Wiew

Cut a - —— | [a—
& calibri i1 ~||A A7 |EEEE = E
Copy
e B 7 U e x £-A- |EEE=EE = D=
Clipboard Font Paragraph F]

H
D—q
;
.;

el The quicck fox jumped over the lazy dog,|

The quick fox jumped over the lazy dog.

We know that the mouse is used for nearly everything on your computer. However, as
you become more comfortable with different programs, you may find yourself using
different keyboard shortcuts in order to navigate around a program. For example, you
can switch from one text box to another by moving your mouse and then clicking in
the next text box:

Sign in

.f? Windows Live ID: billgates@hotmail.cam
il.com)

(example555@

Password:
Forgot your password?

Remember me on this computer (7)
[ Remember my password (7]

Use enhanced security
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You can also press the Tab key on your keyboard. This will automatically move the
cursor from the Windows Live ID text box to the Password text box in the diagram
above. Pressing the Tab key will advance through text fields or other commands in the
program.

Keyboard shortcuts will become second nature to you as you become more familiar
with computers. For example, if we look at the File menu of Internet Explorer, we can
see that some commands have a keyboard shortcut beside them (Ctrl + a letter):

m&lit View Favontes Tools F

Mew Tab Ctrl+T
Duplicate Tab Ctrl+ K
Mew Window Ctrl+MN
Mew Sessicn

Open... Ctrl+0
Edit

Save Ctrl+5
Save As...

Close Tab Ctrl+W
Page Setup...

Print... Ctrl+P

Drimt Draarizase

If you click File > Print or press and hold Ctrl and then press P (Ctrl + P), you will
open the Print dialog, which you would use to print a Web page.

Launching Help from Within an Application

We know that nearly every program has a Help menu in the menu bar. Click Help >
View Help or Help > Topics to see the help file. Some programs also have a small
question mark icon which will launch the help file for that application:

| e
—p &

Most programs employ some form of keyboard shortcut as well. Pressing F1 or Ctrl +
H will launch the help file in most applications.

Ending a Frozen Program

One of the primary jobs of an operating system is to make sure all the programs get
the resources they need to perform their operations and keep everything moving
along. Unfortunately, sometimes a program can suffer an error or conflict with
another program, causing a program to become inoperable or unresponsive (AKA
“frozen” or “crashed”).

If this happens, press Ctrl + Alt + Delete and click Start Task Manager or right-click
the Taskbar and click Start Task Manager:
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Toolbars

Cascade windows
Show windows stacked
Show windows side by side

Show the desktop

Start Task Manager I},

Lock the taskbar
Properties

Task Manager
* Press Ctrl + Alt + Delete on your keyboard
= Task Manager allows you to close most unresponsive (frozen) programs
and restore normal operation of your computer

Task Manager is a special program that keeps watch over all other programs in the
operating system. The Applications tab shows which main programs are currently
running. As you can see in the picture below, there are four programs open and all of
them are operating fine. (A frozen program will have a status of “Not responding.”)
Highlight the program in the list that is frozen, and then click End Task:

F'wWindows Task Manans c=ren x )

File Options View Windows Help

Applications |Prm:esses | Services I Performance | Metworking | Users |

-~

Task Status
@MSN.cnm - Windows Internet Explorer Rurning
& Snaglt Capture Preview Running
indows Media Player unning
) windows Media Pl Runni

@]WindnwsI-‘LIItimate_Fnundatinn_Inst’u::b::rGuide . Running

?

EndTask || SwitthTo || NewTask...

Processes: 47 CPU Usage: 0% Physical Memory: 26%

il
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If the program still refuses to end, try to save whatever other work you may have
been doing and attempt to shut down or restart the computer.

In some situations, your computer may become completely unresponsive. You may
have no choice but to physically power down the computer by holding in the power

button for a few seconds. You can avoid this by making sure you are aware of what
programs are being installed on the computer and saving often to minimize data loss.

Exiting a Program

Exiting a program is easy - just click the Close button in the upper right-hand corner

of the window:
e O )
ﬁl;:l::usel

The Close or Exit command will also usually be found in the File menu. Pressing Alt +
F4 on your keyboard will also close a window.

2.2 Working with a Window

Every program was designed with a purpose in mind. From the simplest game to the
most advanced physics simulation, if it runs in Windows 7, you can manipulate most
windows very easily. In this lesson you will learn how to manipulate a window as well
as learn some tips to keep your desktop neat and organized.

Using Minimize, Maximize, and Restore

You might already be fairly familiar with these buttons as we have seen them a few
times before. These buttons are located in the upper right-hand corner of nearly every
window:

SRR

From left to right, these buttons are Minimize, Maximize/Restore, and Close.

The red X button will close a

window or a program. | shopping lst - Notepad
| File Edit Format View Help

The Minimize button (leftmost) is
used to reduce the window to a chicken breast
single item on the taskbar:

The middle button is a dual-use
button. The most common form it

takes is Maximize:

Click this to make the window fill
your entire screen:
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3] shopping s Notepad L~ )

File Edit Format View Help

eggs
niti
TOMATo

chicken breast
Caesar salad kit

—— .

You can also maximize a window by double-clicking the title bar. Notice that the

Maximize button has changed to this: . This icon symbolizes that if clicked, it will
restore the window back to the size it was before it was maximized.

Scrolling in a Window

Some files, such as word processing documents or spreadsheets, are usually quite
large in size. Even maximizing a window may not provide you with an entire view of
the data in the file. Therefore, these types of programs have the ability to scroll up
and down and/or side to side through the data.

Take a look at the following WordPad document that is filled with text:

- B
[ | 4 % " = | Document- WordPad L oo
Home View -!_Ea-
5 el | e = = Find
D Calibri -1 - AT AT [EE === - =] Q’?z n
- vy - — 33c Replace
aste u X 2 - - = = == nsert | .
- B I U labe X x ml BE=== s - | i selectall
Clipboard Font Paragraph ] Editing
-g---|---1---|---2---|---3---|---4 | 5 [
o~

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Phasellus porta quam a mulla fauci

dapibus munc mollis. Sed convallis, odio ut venenatis adipiscing, ante nunc ullamcorper do!
feugiat turpis elit ac neque. Aliquam lacus nibh, commodo nec tristique vel, tempus sit ame
Suspendisse vel elit in leo elementum ultrices. Curabitur pharetra tempus lacus sed dictum.
Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egeste
Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos.
Donec luctus, sem et viverra porttitor, eros est volutpat wrna, ac gravida mi leo sed odio. !
non mollis est. Suspendisse pharetra turpis quis arcu facilisis nctus. Nullam risus nibh, auc

nnrttitor id  Adimniceim mie arnc
1 | m

100% (=) {}

41



MS Windows 7 Foundation Manual

On the right and bottom of the window you can see two scroll bars. These scroll bars
allow you to scroll up and down or side to side through the data. Click the arrow
buttons that border the scroll bars to move through the data.

You can also click and drag the scroll bar indicator to move quickly through the data:

I@I

=l 24 Find

ab Replace

Editing
A

T T
‘ullamcorper dol
|, tempus sit ame
acus sed dictum.
i ac turpis egests
‘ptos himenaeos.
1 leo sed odio. !
n risus nibh, auc

[

Moving a Window

You can move a non-maximized window by clicking and dragging the title bar of the
window wherever you like on the desktop:

Home View

s = &3 Find

i

1"l

¥

1"
4

% calibri 1 || A&

2) . Replace

.....

]
I
]
>
1}
4

—
5
m
= §

Paste:  |[mlozlar lael s w2l @Al | [

Windows 7 features a few new ways to interact with your windows versus previous
versions. We will explore some of these new features at the end of this lesson.
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Switching Between Windows

The Windows operating system is a graphical user interface, meaning that you can
interact with different items as if you were moving objects around on a surface.
Therefore, moving between different windows was always meant to be done as easily
as moving papers on your desk with your hand. If you have two or more open
windows on your screen, you can switch back and forth by clicking on some portion of
the window.

In the picture below, there are two open windows. Notice how the WordPad window
has a slightly paler border than the Recycle Bin. Also, the Recycle Bin is on top of
WordPad. This means that the Recycle Bin is the active window:

BlldD 5 | Document - WordPad
Home View
& o
om Y cur : - [EESRIE
m P caibri | . | 4. B> o -
280 - L £ » RecycleBin v | ¥4 ||| Search Recycle Bin
Pajte B F UU s _— e e e o
Clipboard Organize ¥ Empty the Recycle Bin Restore all items S >
&
[ g ter e '11 O Evonics = Minesweeper
Shortcut
B Desktop =
376 bytes
Lorem ipsum dol & Downloads S i
dapibus nunc mol, i Recent Places ii ?ad: Document
feugiat tu'rp15 elit 4 | pics | 0 bytes
Suspendisse vel g/l Sacton St S
ection 2 Case Study
A
Pellentesque habi} | Libraries ——| Rich Text Document
Class aptent taci o =
Donec luctus, ser/ 5| Documents = Torttes
non mollis est. Sul\ 'J’ NEc

If you have several windows open at once, clicking between and moving windows
becomes impractical. That's why every window that is currently open on your desktop
is also displayed in the taskbar. The active window has an icon that looks brighter
compared to the others:

If you want to easily view your desktop, click the Show Desktop button in the bottom
right-hand side of the screen. This will minimize all windows to the taskbar:

2:52 PM

7/28/2009

Finally, you can press and hold the Alt key and then press Tab (Alt + Tab) to cycle
through open windows. As you press Tab to move to the next window, the highlighted
window will appear. You can keep cycling through your windows as long as you hold
down Alt, and then release Alt to make the last selection the active window. You can
even cycle to the desktop (making all windows minimized).

B I '.'.
|ﬂ alll gy
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You can also use Aero Flip 3D to browse through open windows as if you were flipping
through a pile of paper. Press and hold the Windows key...

...and press Tab to cycle through open windows. Release the Windows key when you
have flipped to the window you want:

Hindon Rt Femoihon st oty Mock et W oy -

= Rrﬂq —
AaBLCD  AaBbCCL  4aBbCel Aaa Mo~
S R T A ) et v ,KM,::C‘ AaBOC | Aa8e0eD| AaBACE et ‘A o

Thesengd | Yomu
108 Werdow: ks P | S

KJ\J » Ubrary » Music b All manic

(d'\g sz Pv

Organize v  Steam v Createplaylist =

Bob Acn
») Playlists Bob Acri
4 J3 Music Bob Ach
o Adtizt
3 Album

b
| B Videos ( ;U-ﬁ"'"‘ » Libraries »
=) Pictures o St 3
Recorded TV
~ e [MESCIuf
e R T 3¢ Favorites Libranies ey, I
‘ B Desktop Open 8 Sbrary to see your files and arange them s, d nd othes pr
ninja tui & Downioads 2Documents
1. Recent Places JMusic

Orgenze »  New Sbrary

I Mike {mike-pc)

Richard Stettomy pics wPictures
[_ Hvideos
RICHARD o Libearies

(RN + Documents

o Music

W Pictures

B Videos

Bath rf s "Nﬂ! »
™ Computer

l:m B viesa Guice | & LocatDisk(c)

€ Network

Sizing Windows
Any window that is not minimized or maximized can be manually resized.

Move your mouse pointer to the outside edge of an open window. When the mouse

pointer changes to @, &=, or R"*m, click and drag the border of the window as large or
small as you like.

Window Management

Manually resizing windows is easy with two or three windows, but quickly becomes
impractical when dealing with many windows. Nonetheless, it is easy to arrange
windows by using the Taskbar. Most of these options are available by right-clicking an
empty area of the taskbar:
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Toolbars

Cascade windows
Show windows stacked
Show windows side by side

Show the desktop

Start Task Manager

Lock the taskbar
Properties

Windows 7 gives you four options to arrange the windows currently open on your
desktop:

Cascade All windows are arranged horizontally like a waterfall:
Windows

- v “ Windows7Ultimate_Foundation_InstructorGuide [Compatibi

A

. a

\ : & MSN.com - Windows Internet Explorer

-

] Smmad o
\ —
\JU » Libraries » Videos » v |$,.|| Search Videos
Organize v Share with v Play all Burn New folder =~ [ @ ‘
y -
3¢ Favorites — Videos library i A —
| M Desktop J Includes: 2 locations

& Downloads
%2l Recent Places

- Libraries
E‘] Documents
& Music Sample Videos
[&=] Pictures
¥ Videos

g 1 item

- I -  1a9PM |
> @EH ®|| @ 2 a0 000

Show All windows are stacked together like a stack of boxes:
Windows
Stacked
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!HT»H Inse| Pagef] Mai‘l Rev | Viel| Adc| Des| Lay.] Fo* @

Document Map

ey
lEditinq

Paragraph ‘ Styles

Skill
=l Lesson 2=

Organize v

New library

¢ Favorites
Bl Desktop
8 Downloads

] Recent Places

- Libraries
@ Documents

J Music

-

Libraries

Open a library to see your files a...

‘ L Documents

> Library

I! Music
e Library

S~

v http://www.msn.... v

File Edit View Favorites Tocls Help

¢ Favorites
Bl Desktop
& Downloads
] Recent Places

- Libraries
@ Documents

J Music

Show
Windows Side
by Side

Show the
Desktop

Vid..

* Arrange by: Folder v

.

Sample Videos

Organize v = »

¢ Favorites ‘ 9% @ Suggested Sites v & | Web Slice Gallery v
_l o~ v

1 FLAT stomach rule: You must OBEY

' %' MSN.com |

- 0 @

I Favorites
B Desktop
& Downloads
2 Recent Place

4 Libraries
E] Documents
J Music
[E5] Pictures
B videos

1% Computer
&, Local Disk (¢

?. Network

Libraries
Open a library ...

‘ L Documents|

g 4 Library
! Music
B4 Library

m Pictures

\7 Library

Videos
P Library

1:50 PM
8/18/2009

All windows will be arranged into vertical columns:

VIOl oW e =
e 8 N http://www.msn....
=)

[ File Edit View Favorites Tools

i Favorites | ¢ @ Suggested Sites v

f

1 FLAT stomach rule: You must OBEY ~

‘ %' MSN.com ’

@ Hotmail

@ Messenger

@ My MSN

© Download IE8

»Sign in
Make MSN your homepage
Customize your Page v

% WindowsLive Hot
brings you more. More space
(5GB), more security, still free.

1:52 PM
8/18/2009

All windows are minimized, showing the desktop.
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Windows Aero Desktop

Windows 7 features some window manipulation tools that are new to the Windows
family. Once you start using these new features of Windows Aero desktop, you might
find it hard to go back to anything else!

To maximize a window, you can click and drag the title bar of any window to the top
of the screen. Windows will automatically create the outline of a window around the
entire screen. Release the mouse button to maximize the window:

- i e AR o ——— E—T—————

i d i = -
Recycle Bin Organize Newhrbréry O i @

¢ Favorites — Libraries
Bl Desktop Open a library to see your files and arrange...

& Downloads =
| Recent Places |- & Documents

\? Library
4 Libraries

ﬁ_h Music

5] I[\)Aoctixments \&/ Library
usic

[&=] Pictures

™ videos

Pictures
Library

|
<
1% Computer m Videos
a Local Disk (C:) R Library

A 4 items
o

2:04 PM
8/18/2009

A [mr )

If you commonly use two windows at the same time, it used to take a little effort to
manually resize the two windows to see both of them at once. Now it’s much easier!
Click and drag the title bar of one window to either the far left or far right-hand side of
the screen. Windows will draw a border around 2 of your screen; release the mouse
button to apply this change:
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Recycle Bin

| » Libraries »

Organize ¥ New library

-~

4 Favorites — Librari
[l Desktop Openalib
& Downloads

|

2| Recent Places

m

- Libraries
@ Documents
J’ Music
[&=] Pictures
E Videos B

1% Computer
£ lacal Disk(C 7

A "':"——7] 4 items

2:05 PM
8/18/2009

[ Ll )

Click and drag the title bar of another window to the other side of the screen and
Windows will automatically fill that side with the other window.

If you have several windows open at once and want to hide all but one of them, click
and hold your mouse button on the title bar and shake your mouse back and forth.
This is called Aero Shake. All of the other windows will minimize. For example, let’s
assume we wanted to view only the Internet Explorer window (on the right at the
bottom of the pile):

File Edit View Image Colors Effects Help

Colud 9 -

Y e | 6| B O & [ -
Done Save As  Copy All Print Send E-Mail Catalog Send with FTP

i Brightness ~ =
el |\ CXCIREE Y - JE =)
&g Recolor ~ Paint Tools x |g  : Tasks -
Adjust | | S
Effects
3 Edge Effects
3 spotlight & Magnify
P Perspective & Shear

- <‘.;3' s

Tools
Document Map o

Skill Sh:

Real Estate/Rent:
Watermark Shopping

O sorder Sports

View Edit Help

L]
P
LN

% Tech & Gadgets
E Caption Tv

size | —
&3 Resize Image
[5] Resize Canvas

Trim

|l Rotate & Fip
Color BMW Adv:
Color Depth Conscience cle

Z¥ Color Editing 80 Miles/Tank
B¢ Image Processing == S

—_—
—

Action v ®100% ~

Click and shake its title bar. All other windows will minimize:
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MSN.com - Wind e
& - http://www.msn....
File Edit View Favorites Tools Help

¢ Favorites | 5 @ Suggested Sites v 2] Web Slice Gallery v
v MSN.com 7 ‘7 o~ v [ g= v Pagev

o Hotmail Airfares & Travel Food & Entertain
o Messenger Autos Games e

Careers & Jobs Health & Fitness
@ My MSN City Guides Horoscopes E

© Download IE8 Dating & Personals Lifestyle

» Sign in

Make MSN your homepage 16 LaPtOPS/

Customize your Page v That Broke
Barriers

% WindowsLive Hotmail
brings you more. More space
(5GB), more security, still free.
» Sign up
< Previous

o 2o |
’ 8/18/2009

back. You can shake the title bar of the program you used for Aero Shake in the first
place and all other windows will come back.

If you have several windows of the same program or type open at once, the icon in
the taskbar for that program will appear to be layered. Imagine you had four Paint
windows open. (Paint is a basic drawing program which we will look at later on.)
Hover your mouse over this “stacked” icon and you will see a thumbnail view of each
window:

@ Untitled - Paint & Untitled - Paint & Untitled - Paint € Untitled - Paint

=

If you then hover your mouse over a particular window, all other windows will become
transparent using Aero Peek. If we wanted to look at the green window, just point to
it:
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Now you can click the window to bring it to the front, or close it using the thumbnail’s
red X.

The last of Windows 7’s new enhancements are Jump Lists, which enhance the
functionality of the taskbar. A Jump List appears when you right-click a particular icon
on the taskbar and is different for each program or group of programs. You can also
see a Jump List if you click an icon and try to drag it up off the taskbar.

For example, if we were still using the four Paint windows, this is the corresponding
Jump List:

@l Paint
I -4 Pin this program to taskbar

Close all windows

This list lets you open a new
Paint window, pin the program
to the taskbar, or close all of

) g Frequent
the open Paint windows.
% MSN.com
“Pinning” the program to the *§ windows 7 logon screen - Googl...

taSkbar means that Palnt Wl” T.\' windows 7 ease of access - Googm
become a semi-permanent
fixture on the taskbar, just like

Internet Explorer and Windows
Explorer. [ov Lorem Ipsum - All the facts - Lips...

£7 Windows home - Microsoft Win...

%' Miss Manners: Teaching Young ...

lor Lorem Ipsum - All the facts - Lips...
As another example, here is

the Jump List for Internet
Explorer after a bit of browsing
was done: Tasks

¢y InPrivate

| New Tab

-" lorem ipsum - Google Search

*§ loren ipsum - Google Search

(Note the command to unpin
Internet Explorer from the
taskbar.)

@ Internet Explorer
o Unpin this program from taskbar

Close window
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2.3 Working with Files and Folders

Understanding Files

You can think of a computer in an abstract way by comparing it to a filing cabinet. At
the lowest level, the smallest thing you would put in a filing cabinet is a single sheet
of paper with some information on it. This piece of paper is analogous to a single file
on your computer. Very large files may be several pieces of paper stapled together,
but they would still be considered a single entity.

Understanding Folders

Continuing with our filing cabinet example, a folder in Windows is exactly like a folder
that holds pieces of paper. Many files can fit inside a folder. A folder can be named
anything at all, and a folder can contain other folders.

7,

Understanding Libraries

Libraries are a new organizational component in Windows 7. There are four default
libraries which you can view by opening Windows Explorer:
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-
. o s
[ v Libraries » -4
@ e P
Organize » New library r;i:: - [ @
| 9 Favorites — Libraries
[l Desktop Open a library to see your files and arrange them by folder, date, and other properties,
5 Downloads e
(E:'"—'l- Recent Places i:L Documents & Music
X = —— g Libra i Libra
1 pics ~ Y < v
— 3 Pictures Videas
- Libraries EL‘ Library i Library
@ Documents
Ji Music
[E5] Pictures
! Videos

18 Computer
&, Local Disk (C3)

"“':‘—] 4 items

Libraries can contain files and folders that are scattered all over your computer. You
can also define your own libraries by clicking the New library link near the top of the
window.

Continuing with our filing cabinet example, a library can be thought of as a group of
files and folders that are all related in some way, which would be separated by some
sort of divider inside a drawer of the filing cabinet.

Opening the Computer Folder

Our examination of files, folders, and libraries starts to come together when we
consider the Computer Folder. All files and folders on your entire computer are stored
in the Computer Folder. Open this window by clicking Start > Computer:

E‘{ Getting Started @

‘“7,;5 Paint Velsoft

Documents
| Calculator
3

Pictures
Windows Media Center

Music
e Snaglt8

Games
Sticky Notes

Computer

% Snipping Tool

(@)Y See the disk drives and other hardware connected to your computer,

% Remote Desktop Connection
@! Magnifier

Y | Soliaire

»  AllPrograms

| |Search programs and files

Devices and Printers
Default Programs

Help and Support

Shut down T
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Overview of the Computer Folder

The Computer folder allows you to view all hard drives as well as USB flash drives,
most scanners and printers, and digital cameras. There is also a list of locations along
the left-hand side that allows for quick navigation around the different parts of your
computer. Just click a location to go there.

The Computer folder can be thought of as a way to view the filing cabinet as a whole.
Each of the items listed in the main part of the window (Floppy Disk Drive (A:), Local
Disk (C:), DVD RW Drive (D:)) can all be considered as the different drawers of the
filing cabinet. Inside the drawers you can store files and folders, and easily group files

using libraries.

There are three main areas of the Computer folder:

Control
Area

Favorite
Links

The top portion of the window allows you to navigate through your
computer by selecting specific folders. The text box with the word
"Computer" shows the current "address" of the items in the Viewing
Area. You can also search using the Search bar, as well as use a
number of management tools: organize folders and the information
they contain, view system properties (properties of your computer),
and uninstall or change a program on your computer.

| o e
@Uv‘j“ » Computer » v ‘ 4 H Search Co.. |
| Organize v System properties Uninstall or change a program  » B » [ ‘@‘ l

See the >> beside “Uninstall or change a program?” This shows two
additional options: Map Network Drive and Open Control Panel.
These options may or may not be visible, depending on if the
Computer window is maximized.

There are three additional icons on the right-hand side: Change
view, hide or display elements of the window, and a link to the Help
file.

The left side of the Computer folder contains quick links to various

locations on your computer. Click a name to view the contents of
that location:
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- Favorites
B Decktop
4. Downloads
‘| Recent Places

pics

3 Libraries
3 Documents
,.. Music
k=| Pictures

B videos

M Computer
&, Local Disk (C)

Ei_i Metwork

You may notice a small arrow beside some items if you move your
mouse nearby:

4| o Libraries
4 3 Du:ucumi'f“}ts
; ‘, Music
|| Pictures

ﬁ Videos

Windows uses a tree structure to save files. These triangles are a
way to navigate through the tree. The black triangle beside
Libraries indicates that this item is showing its major folders
contained inside. The folder is “expanded.” If we click the white
triangle beside Documents, we will see any folders contained inside
this library:

4 | Libraries
4 3 Documents
°| My Docurnents
Public Docurmnents
; ‘,. Music
|| Pictures

E Videos

As you can see, the expanded Documents library contains yet more
folders with subfolders. To close an expanded view, click the black
triangle beside Documents. This will “*collapse” that particular
branch of the tree.
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Viewing
Area

The main portion of the window displays the content in the current
folder. The default view of the Computer folder shows you the
upper-most level of your computer; that is the hard drives and
other peripheral devices:

4 Hard Disk Drives (1)

Local Disk (C:)

— .
275 GB free of 297 GB

4 Devices with Removable Storage (2)

L__y Floppy Disk Drive (A:)

> .

@ DVD RW Drive (D%

The blue bar under each hard drive represents how much space has
been used.

If viewing files and folders, the folder location is listed at the top in
the Control Area, and a short summary of the current folder’s
contents is shown at the bottom of the window in a large Status
Bar:

=

@©v| . » Computer » Local Disk () » Windows » h
—
Organize ~ Include in library « Share with = Burn New folder =~ i @
$ Favorites Name ’ Date modified Type ol
Bl Desktop . addins 4/22/2009 6:45 AM  File folder =
4 Downloads . AppCompat 4/22/2009 416 AM  File folder 4
5| Recent Places AppPatch 4/22/2009 6:52 AM  File folder
. pics assembly 7/28/200911:33 AM  File folder
. Boot 4/22/2009 6:45 AM  File folder
4 Libraries . Branding 4/22/2009 645 AM  File folder
3 Documents § C5C 7/23/2009 5:47 PM File folder
& Music . Cursors 4/22/2009 6:45 AM  File folder
=] Pictures debug 7/23/2009 5:51 PM  File folder
H videos diagnostics 4/22/2009 6:45 AM  File folder
. DigitalLocker 4/22/20096:52 AM  File folder
8 Computer . Downleaded Program Files 4/22/20096:45 AM  File folder
&, Local Disk (C3) . ehome 4/22/20099:35 AM  File folder
. en-US 4/22/20096:52 AM  File folder
€ Network \aFonts 7/27/200910:02 AM  File folder o
4 [ ] »
) 91 items '

If you click a folder to select it, you will see some specific
properties:

Bl Desktop

£ | addins eff— 4/22/2009 6:45 AM  File folder
& Downloads . AppCompat 4/22/2009 4:16 AM  File folder
2| Recent Places . AppPatch 472272009 6:52 AM File folder
J pics . assembly 7/28/2009 11:33 AM  File folder
. Boot 4/22/2009 6:45 AM File folder i
4 Libraries - ] 11 | t

addins  Date modified: 4/22/2009 6:45 AM '
File folder
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Navigating through Your Computer

All information on your computer is stored on a hard disk, with all files and folders

expanding in a tree-like fashion from the disk. But Windows 7 uses a separate folder

structure to categorize and display information. You can use this map to help navigate

that structure.

Desktop

(Your Name) -A-‘ Computer 1\ . Network
% =SS System Folder L Systern Folder

System Folder

£ L ocal Disk (C:)
=4Floppy Disk Drive (A:)
= DVD RW Drive (D:)

" Libraries

=~ System Folder
¥

3Document5 Other Computers

J‘.Music
= [Pictures

E\fideos

Media Devices

HContacts
mDesktop

g Downloads

([ Favorites
Plinks

My Documents
ot My Music
=My Pictures
#My Videos
@5aved Games
[iSearches

, Tracing

Systemn Folder h
Bt

Metwork Infrastructure

Control Panel -4

£l

System and Security

Metwork and Internet

Hardware and Sound

Programs

User Accounts and Family Safety
Appearance and Personalization

Clock, Language, and Region

Ease of Access

Recycle Bin
System Folder

I Items to be deleted

All dialog boxes that appear when you save a file or want to navigate through your
computer use a similar style of layout to the Computer folder. The process of
navigation is best shown by example. When you first open the Computer folder, you

will see the default window appear:

( = . [ |
B — T
I\,_./”\,_../l |;l.i k Computser 3 - | 4 | | Ss_:*:v" Co.. P
Organize + Systemn properties Uninstall or change a program > 3=~ O .@.
¢ Favorites 4 Hard Disk Drives (1) I
B Desktop Local Disk (C:)
& Downloads ~ oy
%] Recent Places 275 GE free of 297 GB "
| pics 4 Devices with Removable Storage (2) |
= Libraries C—:L\y Floppy Disk Drive [A:) ]
3 Documents -
rJ'- Music B N
. DVD RW Drive (D:)
= Pictures =
B Videos
Ll
I 1M Computer
&, Local Disk (C)
'&‘! Metwork
. L VELSOFTW7URC-PC Workgroup: WORKGROUP Memory: 4.00 GB
Mz - Processor: AMD Athlon(tm) 64 X2 ...
5 -— - A
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Desktop

. L Computer
=SS System Folder

For most beginner users, this view is suitable to help you find what you are looking
for. In particular, the Favorite Links pane on the left contains links to some of the
main areas of your computer.

For example, click the Pictures link:

' B m:ralrE}ﬂlg o) |
@Qv’gi » Libraries » Pictures » v|‘, ' Search Pict... ,0.
Organize v Share with v Slide show Burn New folder = > O "@3
45 Favorites — Pictures Inb_rary Amangeby:  Folder:

Desktop Includes: 2 locations
& Downloads

x
=/ Recent Places

.

pics

4 Libraries

5| Documents Sample Pictures

@' Music
I || Pictures

- ¥ Videos

Notice that the address has changed to display Libraries > Pictures. Windows has
included a few sample pictures to look at, contained in the Sample Pictures folder.
Notice that under the “Pictures library” title you can see that there are two locations
that are included in this library.

Click the “2 locations” link. A new dialog will appear and list the locations where
pictures for this library are referenced:

If you save pictures in other computer locations, you can add these locations using
the Add button. Click OK to close this dialog. You will be returned to the Pictures
library window.
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Double-click the Sample Pictures folder to view its contents:

=k

. » Libraries » Pictures » Sample Pictures ’ l\.

Organize ¥ Share with v Slide show Burn New folder = o+ [0 @
_ gESktTp 4 = Pictures “brary Arrange by: Folder ¥
’ OWRIaaas Sample Pictures
"=l Recent Places
.. pics
- Libraries
5] Documents Chrysanthemum Desert Hydrangeas Jellyfish
@' Music B | W = ;
[ Pictures . :
= My Pictures
. Public Pictures
BE Videos Koala Lighthouse Penguins Tulips
, 8 items

Notice that the address bar has changed to say we are now viewing Libraries >
Pictures > Sample Pictures.

Windows 7 keeps a record of places you have visited. If you think you may have
double-clicked one folder too far, use the Back button (<) located at the top of the

screen to return to the previous folder:

| .. B
=| . » Libraries » Pictures » Sample Pictures
—

Back to Pictures fhare with w Slide show Burn I
¢ Favorites Pictures library
Bl Desktop H Sample Pictures
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If you have clicked Back, the Forward button (=) is now active, enabling to follow
your previous folder path. Beside the Forward button is a small blue pull-down arrow.
Click this arrow to view an expanded history of where you have been:

P

@@%El ¥ Libraries » Pictures »

Sample Pictures ith + Slide show
¥ Pictures | :
tures library
Desktop des: 2 locations

Windows 7 Ultimate Foundation

Documents
| =+ i

The checkmark beside Pictures indicates our current location. Click any item in this
drop-down list to visit that folder.

Remember the (>) icon beside each item in the address bar? This is actually a drop-
down list that displays all folders “one level down” from the folder in the address bar.
If we click (>) beside the Libraries item, we see the four default libraries, with
Pictures displayed in bold to indicate our current location:

-

@@?|EI PlLibraria-. Pictures »

0 : 0 3 Documents
rganize - = J“ . |
@' Music |
I Favorites k= Pictures
PR Dlesktop ™M Videos
4 Downloads

Even though we haven’t gotten very far in this manual, you now have all the skills you
need to access any file or folder on your computer! Just remember the Back button is

always there if you need to retrace your steps, and keep an eye on the address bar to
make note of where you’ve been.
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2.4 Basics of Menus and the Ribbon

Basics of Menus

Menus are a standard part of nearly every program available for your computer.
Menus are categorized and contain commands (or sub menus) inside. Menus are
usually found at the top of a window:

L‘ﬂy Edit Format View Help
Mew Ctrl+M o
Open... Ctrl+0
Save Ctrl+5
Save As...

Page Setup...

Print... Ctrl+P

Exit

Sometimes menus and their options are accessible by a pull-down menu, such as this
menu in Windows Media Player:

-
@ Windows Media Player

o,
DU b Library » Music » All music

Organize =| Stream +  Create playlist

4

Managlg/glibraries r
Apply media information changes
b Acri
2
Sort by b Acri
Customize navigation pane... =
Layout y D4

Options...

o

Click any menu heading to see the contents of the menu. If a menu item has a small
(>) symbol beside it, this denotes a sub menu containing more specialized options:
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-
@ Windows Media Player
“.
OO b Library * Music » All music
Organize = Stream »  Create playlist ~
Manage libraries b #
Apply media information changes
Sort by I} ] Title b
Customize navigation pane... Album artist
e N Album
Opfinne. Release date
E—" Date taken
= Pictures Mr. Scruff Rating
=) Recorded TV 5 F F '1 File name
MFSCIVFF |
‘ — .~ | Mr. 5cruff

Basics of Ribbons

The Ribbon is a new interface style that was first used by Microsoft in Office 2007.
Instead of using traditional menus, a series of tabs with categorized commands are
displayed. WordPad and Paint are two programs that have been around almost as long
as Windows itself, and in Windows 7 these two programs received a well-deserved
face lift, integrating this new Ribbon style of interface:

| I “» ¢ = | Document - WordPad | = | B = |
Home View @
D & Cut ==z @ ;: & &4 Find
Copy * - - 33 Replace
Pa'ste B 7 U abe X: 3¢ | &~ A - Dag:i:"aend Plct'ure dfﬁa“u?zg £ select al
Clipboard Font Paragraph P} Insert P} Editing
-|--‘g---|--‘1---|--‘2---|--‘3---| 4 - |5|$ 1
@l | [/ % ¢ = | Untitled - Paint [
Home View L7
TR 7 N WL = 1]
Paste o Select £ Resize /0 Q BO O OE:> <:]ﬁ T| S Size Calor | Color —|D|— —“E‘D Edit
: EVIRE R ISR ==t ‘ > OO 1]

Clipboard Image Tools Shapes Colaors

As you can see, there is a heavy emphasis on visual commands used in the Ribbon

interface. The idea behind this is that most people would rather follow pictures and

visual cues rather than read text all the time. Let’s take a moment and focus on the
Ribbon interface used by WordPad, a program that you should be relatively familiar
with by now.

The title bar contains some familiar elements: the file/program name and the
Minimize/ Maximize/Close buttons. The title bar also includes something called the
Quick Access Toolbar (in the red box), a special customizable toolbar that can contain
nearly any command in WordPad. We will explore this later:

The Ribbon contains two parts: tabs at the top and a command area underneath:
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Home View (7]
Cut - 1 | == — <= | 32 Find
E o Tl Bog

.
I11
4

Copy b Replace
Paste B 7 U e X ¢ &# -~ A~ ||= = = = *=~ | Dateand Picture Paint ey
- : = = time - drawing | iE} Selectall
Clipboard Font Paragraph (] Insert P} Editing

In the top left-hand corner are the tabs. The first dark blue tab is a control tab and is
very similar to a standard File menu:

,

E‘h‘
T Recent documents
Mew
1 Skill Sharpener 21
2 Section 2 Case Study |
ﬁ Open _
3 Section 1 Case Study M
ﬂ c 4 Skill Sharpener1.2 I
Save
g 5 Skill Sharpener 1.4 |
ﬁ Save as ¥
| |
gﬁj Print >
Ay Fage setup

Send in e-mail

) 1)

About WordPad

L

¢

The other two tabs (Home and View) contain all of the commands used by WordPad.
The commands on the tabs are ordered together into groups. (For example, you’ll find
Clipboard, Font, Paragraph, etc. groups on the Home tab.)

Some groups, such as the Paragraph group, have a small arrow in the bottom right-
hand corner:

11
i
¥
i
[11
4

Eﬁ: —-j aaf | & Fi
Ik I'I,‘:J |
h: = \’bli;: Re

:gv Date and Picture Faint

time *  drawing | i} 5e
Paragraph y Insert IF] Edi
L 3 '+ * 1 | Paragraph
Show the Paragraph dialog box,

arv doo.
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This button usually opens another dialog containing more specific commands related
to the group that either don't fit in the Ribbon or are more complex than simply
clicking a command.

Sometimes certain commands are grayed out in the Ribbon, indicating that they
currently cannot be used. In the Clipboard group, the Cut and Copy commands are
not available...

.El| = = =+ | Document - WordPad

EI Cut | [alipr 11 <A AT | EE| =
Paste |l e 2 A B EEE
Clipboagd Font Paragraph F
-u---E---u---1---|---2---|---3---|
The guick brown fox jumped over the lazy dog.

...until some text has been selected:

: /
EI # Cutibri -l - AL |EE
2 Copy
B 7 U aghe % x* & - A~

C Font Parag
-g---n---l---n---z\--a
The quick brown fox jumped over the [EREslal:d

In the next section of this manual, we will explore WordPad, Calculator, Paint, and
other programs included with Windows 7 in more detail.

(1L

|
¥
"

Using Shortcut Menus

Shortcut menus are available for a range of different objects on your computer. The
shortcut menu is activated by clicking the right mouse button on an icon, block of
text, or selected item. Once the menu appears, pick any option from the menu and
click it.
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Right-clicking the title bar of a window gives you window management options:

-
@ Windows Media Player
Restore —

OD b Library » Mu Mowe
Size

Organize - Stream - S
= Minimize

o Maximize
Bl Library

[ Playlists x Close Alt+F4
4 Jd Music h Bob Acri

Right-click a program icon in the taskbar to view the Jump List:

Frequent

(=) Fine Music, Vol. 1 - Richard Stoltz...
(=) Ninja Tuna - Mr. Scruff

(=) Bob Acri - Bob Acri

Tasks

& Resume previous list

(= Play all music

|3 Windows Media Player
o Unpin this program from taskbar

Close window
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Right-click a program or shortcut to a program for the following options:

Open file location
Run as administrator
Unpin from Taskbar
Pin to Start Menu

Restore previous versions
Send to

Cut

Copy

Create shortcut
Delete

Rename

Properties

Right-clicking the Recycle Bin gives you the option to empty it without having to open
it (but you will be asked to confirm the deletion):

=
5
JEECTCIEE T
2 Empty Recycle Bin [}
Create shortcut
Rename
Properties
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Right-click a file in the Computer folder for even more options:

Documents library

i . Arrange by:  Folder -
Skill Sharpeners and Case Studies

F Skill Sharpener 2.1 . Skill Sharpener1.4
——| PRich Text Document Open Bt
h=| 888 bytes )
— - Print
Skill Sharpener1.2 . 1dy
4 0 th 3
—— | Rich Text Document pen Wi Bt
[ =3 W -
== 55 bytes Share with b
Restore previous versions
Send to L\} b | 4, Compressed (zipped) folder
Cut Bl Desktop (create shortcut)
o j Documents
g2 Fax recipient
Create shortcut ) Mail recipient
Sesl < Floppy Disk Drive ()
Rename 3 DVD RW Drive (D)

Open file location

Properties

Date modified: 7/28/2009 2:26 PM
Size: 888 bytes

There is no shortage of shortcut options available to you through the right-click menu.
Feel free to try right-clicking different options as you use your computer. With time,
you will likely find yourself using shortcuts instead of choosing the options in the
menu!

Using Shortcut Keys

Just like the right-click button on your mouse shows shortcut options, there are a
number of different commands that can be used by way of keyboard shortcuts. For
example, keyboard shortcuts can be seen by first clicking the menus and noting the
key combinations.

Let’s look at some very common keyboard shortcuts that work for many programs,

including Notepad. We've typed some text, selected the text, and then clicked the Edit
menu:
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| Untitled - Notepad Lo o e |
File | Edf%| Format View Help
The Undo Al over the lazy dog. L
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Deel
Find... Ctrl+F
Find Mext F2
Replace... Ctrl+H
Go Ta... Ctrl+G
Select All Ctri+4&
Tirne/Date F5
4 [

L A

The Edit menu in a word processing program is used to perform Cut, Copy, and Paste
operations. The actions performed by these operations are exactly like they sound:
Cut (Ctrl + X) will remove a highlighted portion of text to be Pasted (Ctrl + V)
elsewhere in the document once. Copy (Ctrl + C) will take a copy of the text which
can then be pasted over and over again.

Sometimes keyboard shortcuts use three keys together, like Ctrl + Shift+ 9 or Ctrl +
Alt + Delete. In the case of three or more key combinations, press and hold the first
two keys, and then press the final key to perform the operation.

Using Shortcut Keys and Menus Together

Nearly everything you can do in a program can be performed by using a menu
command. However, most of the common and repetitive tasks can be performed by
using keyboard shortcuts, such as Ctrl + C and Ctrl + V.

But did you know you can also use a keyboard shortcut in place of the Start menu and
right mouse button? Your keyboard features two special keys to do just that.

In the lower left-hand corner of your keyboard is a key with a Windows logo on it that
looks like this:

The Windows key will automatically open the Start menu. You can then use your
mouse and click an item or use the arrow keys on your keyboard to move up, down,
left, or right in the menu.
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On the other side of the keyboard, just to the left of the right-hand Ctrl key is the
Context Menu key (AKA shortcut key, right-click key) that looks something like this:

This key, when pressed, has the same effect as pressing the right mouse button when
your mouse if over an object. Use your mouse to click an item in the list or use the
arrow leys to scroll up and down through the list.
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Chapter 3: The Basic Windows 7 Applications

In this chapter you will learn how to:

Use WordPad to create documents

Use Calculator to perform calculations, operations, and conversions

Use Paint to draw a picture

Use Notepad to jot down important information

Use Windows Media Player to listen to music, view pictures, and play movies
Use Windows Media Center with your television

Use the Snipping Tool to capture screenshots

Use Sticky Notes to leave yourself a reminder
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3.1 WordPad Basics

We have used WordPad before to demonstrate different concepts and features in
Windows 7. Now, we will examine WordPad as a program by itself. WordPad is a basic
word processor that is designed for letters and simple documents. It has been with
the Windows family of operating systems for a long time and is back again in Windows
7, only this time with a brand-new interface.

Launching WordPad

Launch WordPad by clicking Start > All Programs - Accessories > WordPad:

. Accessories
D Calculator
Command Prompt Velsoft
@3 Connect to a Network Projector
B Connect to a Projector Documents
=) Getting Started
& Math Input Panel Pictures
Mj] Notepad
@l Paint
& Remote Desktop Connection

i3] Run Games

% Snipping Tool

L Sound Recorder
7 Sticky Notes
@ Sync Center

) Windows Explorer

WordPad,

., Easeof A Lec

L. SystemT
. Tablet PC

Back

Music

Computer

Control Panel

Devices and Printers

Alternatively, when you first click the Start button, you can use the Search bar to
launch the program. Since the program is part of Windows itself, searching does not
take long. (In fact, many programs can be found and run in this manner.)

Click Start. At the bottom of the Start menu is the Search Bar, with a flashing cursor
already in place:
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| |55:‘r:r'1 programs and files 2 |

Type "wordpad" into the Search Bar:

Programs (1)

=l WordPad

Documents (3)

| Windows 7 F Draft
_|windows 7 outline
El_]Windows‘ufistaUItimate_FDundation_InstructorGuide

—
#- See more results

|wu:|rdpad| H | | Shut down | » |

As you can see, the program WordPad has listed itself at the top of the Start Menu,
along with any files with names that match the search criteria. Launch WordPad by
double-clicking the program name in the Start menu or pressing Enter.

WordPad
» Click Start > All Programs > Accessories - WordPad
= WordPad is a basic word processing program that can display different
fonts, text effects, and pictures

Interface Overview

We briefly introduced the interface elements earlier, so let’s recap the major
elements:

Quick Access Toolbar Title Bar Minimize/Maximize/Close

5 | + | Document - WordPad

Tabs

Ribbon paste = Y

@ ;‘ I

Igv Date and Picture  Paint
time = drawing

Clipboard C Paragraph (F] Insert (F] Editing

EEEEE EEENEERE EEENEREP SEENE

Working Area

Status Bar
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The blue tab is similar in nature to the File menu used by hundreds of other programs.
This menu is properly known as the Backstage menu, because you can create a new
file, save your existing file, print, or exit the program:

-
,g | + | Document - WordPad
Ev

k Recent documents

HNew
1 Skill Sharpener 2.1

ifal" Open 2 Section 2 Case Study

3 Section 1 Case Study b
4 Skill Sharpener1.2

Save
5 Skill Sharpener 1.4

Save as k

=
=
Eﬁé Print b
%{ Page setup

2 Send in e-mail
@ :bout Wordrad

Exit

Note the list of recent documents created in WordPad. You can click any of the names
in that list to open the file, provided you haven’t moved or deleted it since you last
saved it.

This list of recent documents is also available right inside the Start menu; just hover
your mouse over the (>) button beside the program name. Click the file you want to
open, provided you haven’t moved or deleted it:

—_—

J[ Getting Started Recent

== Skill Sharpener 21
y -,j Motepad |Z=| Section 2 Case Study

|==| Section1 Case Study

@ Snaglt 8 |5 Skill Sharpener1.2

_ == Skill Sharpener14
; /:T Paint

2o

...... Calculator

There are two tabs, Home and View, each with their own commands:
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Home View '@
= Cut . oy N ey e | ey ez T ~a% | &4 Find
Calibri 111 - A A ===~ Eii] _'J {aal)
D Copy '- Q P 2. Replace
Paste B 7 U ahe X x|~ A~ |§ = = =||*=~- | Dateand Picture Paint
- - time - drawing Select all
Clipboard Font Paragraph (] Insert ] Editing
Home View
Q Q T i | Ruler =+ Word wrap ~
J | Status bar 3*3 Measurement units =
Zoom Zoom 100
in out %
Zoom Show or hide Settings
The commands in the ribbon ,
i i | (- ~a3f | @& Find
are separated into groups, ===~ T (o)
; A = Sac Replace
and some gro_ups contain an |§ = = = *=-| Dateand Picture Paint §
arrow button in the lower . — | — == e +  drawing Select all
r|ght'hand corner. Paragraph Insert Fa Editing
f 2 .

Click this button for other
commands specific to this
group:

Make whatever change you
like here and then click OK
to apply them or Cancel to
close this dialog box.

Paragraph

Indentation

Left:

Right:

First line:

Spacing

Line spacing:

Alignment:

=

|:|"

0"

115

[/] Add 10pt space after paragraphs

’ Tabs...

The last part of the interface is called the Quick Access Toolbar (QAT). This toolbar
was a new feature introduced with most Microsoft Office 2007 programs. The Office
suite of programs (and in fact most programs) have always made use of toolbars, but
what sets this one apart is that it is always on and is completely customizable.

WordPad contains three default commands on the QAT. From left to right, they are

Save, Undo, and Redo:
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Let’s briefly go over the basics of the three commands.

Save will either save the changes to an existing file or ask you for a name if saving a
file for the first time.

Undo will revert the last command, such as a font face change, some font effects,
inserting a picture, etc. Basically, if you didn't mean to do something, Undo it.

Redo will “"undo the Undo.” If you undid something you didn’t mean to, click Redo to
apply the last formatting change that was reverted. If you recall our exploration of the
Computer Folder in Lesson 2.3, Undo and Redo work somewhat like the Back and
Forward buttons. Instead of moving backwards and forwards through locations, you
can move backwards and forwards through changes to your document.

There is a pull-down arrow beside the Redo command. If you click this, you have the
option to add some other common commands to the QAT:

= | = | Document - WordPad

= H w
EH~- H.:,n1EI%ustDmize Quick Access Toolbar |
ut MNew
T Open
{[¥] save

| Cdm

e Send in e-mail
Clipboard

L Cluick print
e Print preview
v | Undao

Redo

<,

Show below the Ribbon

Minimize the Ribbon

As you can see, there are already checkmarks beside the Save, Undo, and Redo
commands. The checkmarks mean that those particular commands are already on the
QAT. If you clicked the pull-down arrow and clicked New, that command would be
added to the right of Redo:

Bl 3% ' | = | Document - WordPad

| =R4 Home View

Calibri 111
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You can add nearly any command you like to the QAT. Just right-click a command and

click Add to Quick Access Toolbar. Here, we are adding the Underline command:

E, | & = D + | Document - WordPad

= Cut

- -

= - [

Calibri 11 ~|| A A i= -gg
: Copy
Paste Bfg#xzxzﬁvév |§§§§:fv Dz
_ Add to Quick Access Toolbar
Clipboard
7 1 Show Quick Access Toolbar below the Ribbon

Minimize the Ribbon

v

Elu-—fj Dﬂ:l[}ocun

| =R Home View

- Cut
N Calibri

To remove a command from the QAT, right-click one of the commands and click
Remove from Quick Access Toolbar:

Bl dD |1 U s |Document - WordPad

Bemove from Quick Access Toolbar

s

how Quick Access Toolbar below the Ribbon

Minimize the Ribbon

=
by
=
X
xl.l
R
4
I=
1 -
]
(il
I
ll
-
11
4

Entering Text

All you need to do is click somewhere inside the white area of WordPad and type!
WordPad will automatically move to the next line as you type:

T T T T T T [ BRI
e fial

You are looking at some sample text written in the writing area of WordPad. As you type and
reach the end of the ruler shown above, WordPad will automatically move to the next line.

Press Enter on your keyboard to move manually to the next line.

Once you have entered some text, use your mouse or the arrow keys to move the cursor
anywhere inside the document. You can add new text between other text simply by typing.

WordPad can display copied text from other locations, such as this text that was
copied from the Windows 7 home page and pasted into WordPad:
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& See how Windows 7 features will make using a PC faster and easier - \Mndl o|E] % J
QO » [# oo ~[B]4 [ ] [ vindous7 5~

File Edit View Favorites Tools Help

g Favorites | g (@ Suggested Sites v ] Web Slice Gallery ~
JBSeehcmw-ndmsﬂm... j_| v B v d v Pagev Safetyv

Improved taskbar and full-screen previews

The taskbar at the bottom of your screen is what you use to launch programs
and switch between them when they're open. In Windows 7 you can pin any
program to the taskbar so it's always just a click away, and you can rearrange
the icons on the taskbar just by clicking and dragging. We've made the icons
considerably bigger, too, so they're easier to use. Hover over the icons and
you'll see thumbnails of every file or window that open in that program, and if
you hover over the thumbnail, you'll see a full-screen preview of that window.
Move the cursor off the thumbnail and the full-screen preview disappears.

Home

&3 Find

3 Replace

€ Internet | Protected Mode: On

Improved taskbar and full-screen previews

The taskbar at the bottom of your screen is what you use to launch programs and switch
between them when they're open. In Windows 7 you can pin any program to the taskbar so
it’s always just a click away, and you can rearrange the icons on the taskbar just by clicking
and dragging. We've made the icons considerably bigger. too. so they’re easier to use. Hover
over the icons and you'll see thumbnails of every file or window that open in that program.
and if you hover over the thumbnail. you'll see a full-screen preview of that window. Move
the cursor off the thumbnail and the full-screen preview disappears.

Closing WordPad

When you have finished using WordPad, click the Close button in the upper right-hand

corner of the screen. You can also Click File > Exit to close the program.
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3.2 Doing More with WordPad

Editing Text

If you have discovered a misspelled word or a sentence that perhaps doesn’t make
sense, you can use the backspace key to erase the mistake and then fix it. You can
also use your mouse cursor and click anywhere inside the document. This will place
the text cursor so that you can then fix the mistake.

Read the text in the picture below. Do you see the spelling mistake?

r ™
Ell 5 [1 O = | Document - WordPad ‘ . E@ﬂ
Home View '.@'

= Cut — T == | [ s | 84 Find
Calibri 112 - IEIE iz v ET (e =y
D Copy el " L'-_ J P ah Replace
Paste u x & - A ~|||=|= = =| *=~| Dateand Picture Paint | ..,
- B Z|U |abe| X ||| & = = = = /= time -~ drawing | i Selectall

Clipboard Font Paragraph IF] Insert I Editing

|---g---|---1---|---2---|---3---|---4---|---5---|---a---|--

word. To fix a mistake, move your mous cursor to the area with the problem, click to
insert the typing cursor, and then press Backspace to remove the error or correct the
word. The arrow keys can also be used to move around the document.

Here is some sample text in WordPad. Somewhere in this paragraph there is a misspelled ‘ ‘

& —

If you look carefully at the sample above, the word "mouse” in the second line does
not have an “e” on the end. Simply click at the end of the misspelled word and type
the letter “e” to correct the mistake:

I‘*_"'---|---:|_---|---;_'---|---3---|---.-.1.---|---5---|---
e st

Here is some sample text in WordPad. Somewhere in this paragraph there is a misspelled
word. To fix a mistake, move your mouse cursor to the area with the problem, click to
insert the typing cursor, and then pragl Backspace to remove the error or correct the
word. The arrow keys can also be y€ed to move around the document.

I

Formatting Text

You can format text by making the text bold, italicized, underlined, a different color,
= a
= bulleted
= |ist,
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or any combination of the above. There are two ways to add different formatting
elements to a document. If you know you want to apply formatting, you can set up

WordPad first and then type your text.
a [E=NEER )

p
5 | 5 D U < | Document - WordPad
H~- Home Wiew '.@—"
Cut e ey ey | g T [ e | Find
N Bernard MT Conden ~ 20 ~| A & ==l =~ T h‘ ,..Q;Kf & "
- Copy b = 3ac Replace
Paste B 7 U ae X. w¢||&#~ A~ ||=|= = = *=- | Dateand Picture Paint ey
— | time ~  drawing | 0 Selectall
Clipboard Font Paragraph IF Insert (P Editing

1 L . T I & (N

Tliis fext was lyped alter the fonf face, fonl size, and

ilalicized effect was selecled/

The other option would be to type the sentence, highlight it, and then change effects,
like making the font bold and changing the color:

=3 = |

.E. | K = D U = | Document - WordPad

Home View
— == 24 Find

Calibri -ln - AN ﬂ?':} .;- -.;1:{,{ :
5 = 32 Replace

Il
4

Cut

i Copy
Paste u x 2 - A ~|||=|= = =| *=~| | Dateand Picture Paint | ..,
|B | U |abe| X 22| 2 L |_ = ==L= time -~ drawing | il Selectall
Clipboard Font Paragraph IF Insert P Editing
1 L 1 . T R & CCI

S SRR RN N R

This sentence uses the default font. This sentence was modified by selecting it and then

making changes.

WordPad allows you to orient the text in three different ways: left, right, and center
justification. Use the commands in the Paragraph group of the Home tab:
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Left Justified

Here is a sample paragraph that will be used to show how WordPad can orient paragraphs of
text. WordPad can align all text to match the border on the left, flow all text down the middle,

or align text to the right margin.

Center Justified

Here is a sample paragraph that will be used to show how WordPad can orient paragraphs of
text. WordPad can align all text to match the border on the left, flow all text down the middle,
or align text to the right margin.

Right Justified

Here is a sample paragraph that will be used to show how WordPad can orient paragraphs of
text. WordPad can align all text to match the border on the left, flow all text down the middle,
or align text to the right margin.

You can click the orientation command first and then type the text or highlight the

block of text and then choose your orientation.

Saving your File

If you open WordPad and begin typing in a new document, you will likely want to save
the file for safe keeping or to use later on. Let’s save the document that demonstrates

the different text orientations to the Exercise Files folder.

Click the Backstage menu and then click Save or Save As. Either one will do the same

thing if you are saving a file for the first time:

-

Bl Ed D = | Document - WordPad

_’I New

Recent documents

Skill Sharpener 2.1
Section 2 Case Study
Section 1 Case Study

Open

Skill Sharpener1.2
Skill Sharpener1.4

1| o

Save

[ T B S W R [ ]

sj save | Save (Clrl+S)

Save the active document.

,.q,?{' Print »
VI f
%}é Page setup

j Send in e-mail

qu About WordPad

fl

dr
fl

rd

fl
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When saving a file for the first time, you need to give it a name. If you then do more
work on the document, click Backstage - Save or click the Save icon in the QAT to
save your changes.

If you are working on a file and click Backstage - Save As, you have the option to
save the current file under a new name.

The Save As dialog box will appear. Let’s examine the different parts:

’ B ™
[7] save As 5
C’“\.—_/I 3 v Libraries » Documents » - |4'n_}|| Search Documents

= - - . -
Organize « Mew folder Bz -
't Favorites Documents_ library Amangeby:  Folder +
B Desktop Includes: 2 locations
4 Downloads
‘=] Recent Places E-T.. Windows 7 Ultimate Foundation Windows 7 Qutlines
. P File folder | File folder
J pics
) o I Snaglt Catalog pics
il Libraries .' File folder I | File folder
3 Docurmnents 4
-J: Music I microsoft
= Pictures ¢ Filefolder
B2 videos
File name: Em
Save as type: ’Rich Text Format (RTF)
Save in this format by
4 Hide Folders default [ Save ] [ Cancel

At the top, in the address bar, Windows 7 uses the Documents library as the default
save location. We recommend you save your file here as there is a direct link to them
from various places on your computer (such as the Start menu). However, this is not
required; you can choose to save a file wherever you wish.

To save to a different location, use the list of links on the left and select a location.

At the top of the window is a command for a "New Folder.” You can create a new
folder anywhere you like on your computer with this command.

Give the file a name in the File Name box and then click Save:

File name: -
Save as type: ’Rich Text Format (RTF) v]
Save in this format by
*~ Hide Folders default ’ Save QJ [ Cancel ]
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As a side note, the Save/Save As dialog box might look like this:

r ™
E Save As [} Iﬂ
L}U g 3 v Libraries » Documents » - |4'n_}| Search Documents fo |

File name: -
Save as type: ’Rich Text Format (RTF) v]
Save in this format by
> Browse Folders default [ S ] [ Cancel ]

As you can see, the list of links on the left is not visible. Click "Browse Folders” in the
lower left-hand corner to show this list again.

Opening a File

You already know how to open a file from a folder from the various exercises in this
manual: open the folder containing the file and then double-click the file. If you want
to open the file from inside WordPad, the process works just like saving a file. Let’s
consider opening the “text formatting” file we just saved.

Open WordPad and click Backstage > Open. The Open dialog box will appear.
Navigate to the file you want to use, click it to select it, and then click Open:

' Favorites Docume nts_ library Amangeby:  Folder
B Deskiop Includes: 2 locations
4. Downloads
5 Recent Places E; Windows 7 Ultimate Foundation Windows 7 Outlines
. File folder | File folder
J pics
. o 1 3 Snaglt Catalog P pics
@ Libraries _' File folder (] Filefolder
3 Documents .
I Music i . P text formatting
J . , i ;r.'lllc:_olsclnft- ——| Rich Text Document
= Pictures i lle Tolder = 103KE
B videos -

1M Computer /

&, Local Disk (C) =

File name: text formatting - [AIIWordpad Documents (*.rif, vl

—p | Open{}k‘[ Cancel |

Remember that you can also open recently-used documents made in WordPad by
using the Start Menu:
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5’ Getting Started » Recent

e Snaglt 8
,97‘3_"; Paint

%] shopping list

¢ I_‘ Sticky Notes

% Snipping Tool

% Remote Desktop Connection

@ Magnifier
‘H WordPad

> AllPrograms

| |Search programs and files pe) I . Shut down ' 4 |

SCR=l

3.3 The Windows Calculator

Launching Calculator

Calculator is in the Accessories folder along with WordPad. Click Start > All
Programs > Accessories > Calculator:

. Accessories
Calculator_
Commanﬂ?rompt

B Connect to a Projector Documents
=4 Getting Started

& Math Input Panel Pictures

2] Notepad )
@l Paint S
B Remote Desktop Connection
Run Games

Snipping Tool Gompuer
Sound Recorder

~ Sticky Notes

Sync Center

4 Windows Explorer
WordPad
. Ease of Access Default Programs
. System Tools

| TabletPC Help and Support
4  Back

Control Panel

Devices and Printers

‘ Search programs and files

Shutdown | * |

= —
—o |
b
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You can also type “calculator” into the Search bar and then press Enter to launch the

program:

. Calculator
= C(Click Start > All Programs > Accessories - Calculator
» Use Calculator for everyday math, statistics, and programming
calculations

Programs (1)
| Calculator

adgets installed with Windows

W' Get more gadgets online

&% Uninstall a gadget
Documents (3)

|| Windows 7 F Draft

| windows 7 outline

@]Win dowsVistalUltimate_Foundation_InstructorGuide

=y
4~ Seemore results

calculatorl E @ Shut down |
|

F B B "WNE

Interface Overview

Here is the Standard interface:

|| Caleulator r| =
View Edit Help

0

EIESCIE
L= e e J[e ][ ]
L7 (8 ][ ]le]l=]
L4 ][5 JL6 Jle J[as]
[ 1/ 2| 3 =‘
[ o [ Jle]

83



MS Windows 7 Foundation Manual

The Edit menu allows you to copy and paste values, as well as step backwards
through your calculation history.

Calculator has three other views besides the standard r Calculator C=reeT

view. You can switch between these views by selecting
an interface from the View menu:

Vi Edit Help

@ uStandard

Alt+1

Scientific Alt+2

Programrmer Alt+3

Statistics Alt+4

History Ctrl+H
Digit grouping

@ Basic Ctrl+F4

Unit conversion Ctrl+ U

Date calculation Ctrl+E

Worksheets

Here is the Scientific interface, which provides a

number of advanced mathematical features. You can switch between degrees,

radians, and gradients for various trigonometric functions by selecting a radio button:

-
Calculator

e

View Edit Help

(@ Degrees () Radians

(71 Grads

Inv

In

sinh

cosh

tanh

Exp

The Edit menu allows you to copy and paste values, as well as step backwards
through your calculation history.
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Here is the Programmer interface, which provides a binary counter for whatever
number is on the screen. Switch between:
= Dec (Decimal, base-10, or “regular numbers”)
» Hex (Hexadecimal, base-16, used to denote different colors on a computer)
= Oct (Octagonal, base-8)
= Bin (Binary, base-2, the 1s and Os used at the very core of all computers)

There are also commands for various logic operations:

F B’
Calculator [ -

a

View Edit Help
2088 6088 o868 G888 e86e cees G688 Baee
B3 47 32
2088 6008 08688 GB88 G808 0088 6888 B088
31 15 &
|‘:__|HE}[ | ||MCIC|| A | MC || MR || S || M+ || M- |
oon L[]8
: vl e | |
©oa LY LB -
OBin || ro||ror|| € || 7 || 8 || 9 || « | %
@ Qword | Or ||:{nr| D | i || 5 || G || % | 1/x
(") Dword |
: sn | Rsn || E [ 1 ]| 2 ]| 3 | - |
© Word E 1 2 3 _
() Byte | Mot ||And | F | 0 | . | + |

Any number can be converted to any other format by clicking the appropriate radio
button.

The Edit menu allows you to copy and paste values.
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Finally, there is the Statistics interface.

-
J Calculator ]
.

View Edit Help

%)

|MC || MR || M5 || M+ || Pl- |

(= |[ee]| c || re oo

L7 )18 J{ 9 |l=|2]
L4 5 J{ 6 || == ]|z
1)1 2 ][ 3 || o J{o=a)

L0 J[ - Jl= J{aa)

This interface is a bit different than the others because it allows you to enter a
number of different values as a dataset and then perform operations on them. To do
this, enter a value and click the Add button in the lower right-hand corner. Once you
have entered a number of values, click a statistical operator button to calculate the
result.

The Edit menu allows you to copy and paste values, as well copy, paste, edit, or clear
your current dataset.

Using the Calculator

The calculator is very easy to use: simply click the buttons. The numeric keypad on
your keyboard is ideal for numbers, the decimal point, and the basic calculations like
addition, subtraction, multiplication, division, and equals.

Calculator can store and use a single value in memory using the following buttons:

Memory | WS | Stores a single value in memory.

Store

Memory | MR | Recalls the stored humber from memory to use in
Recall the calculation.

Memory Add | M= | Adds the displayed number to the stored number in
memory. (Click MR to see the sum.)
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Memory | M- | Subtracts the displayed number from the stored
Subtract —— number in memory. (Click MR to see the

difference.)

Memory | MC | Deletes the number stored in memory and resets to

Clear Zero.

Consult the help file by clicking Help > View Help to view a full manual and

command list.

Advanced Calculator Tools

Calculator has been upgraded to include a
number of very useful conversion and calculation
tools. These tools are visible using any of the
four views mentioned earlier.

These tools expand to the right of the working
area in Calculator.

i |:| Calculator =
Vi Edit Help
& Standard Alt+1
Scientific Alt+2
Prograrmmer Alt+3
Statistics Alt+4
History Ctrl+H
Digit grouping
@ Basic Ctrl+F4
Unit conversion Ctrl+ U
Date calculation Ctrl+E

Waorksheets
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Unit conversion offers easy conversion between standard measurements:

r '

View Edit Help

Select the type of unit you want to convert

[Angie

From

Enter value

Degree

To

Degree

Select the unit type from the first drop list, enter a value to calculate From, and then
select the From and To units. For example, this tool can calculate miles per hour into
kilometers per hour:

Select the type of unit you want to convert

Velocity -

From

100

[ Miles per hour b ]

To
1609344

Kilometer per hour b
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Here is a comprehensive table of unit types that Calculator can convert:

Unit category

Angle

Area

Energy

Length

Power

Pressure

Temperature

Time

Velocity

Volume

Weight/Mass

Unit types available for conversion
Degree, Gradian, Radian

Acre, Hectare, Square centimeter, Square feet, Square
inch, Square kilometer, Square meter, Square mile, Square
millimeter, Square yard

British Thermal Unit (BTU), Calorie, Electron-volts, Foot-
pound, Joule, Kilocalorie, Kilojoule

Angstrom, Centimeter, Chain, Fathom, Feet, Hand, Inch,
Kilometer, Link, Meter, Micron, Mile, Millimeter, Nautical
mile, PICA, Rod, Span, Yard

BTU/minute, Foot-pound/minute, Horsepower, Kilowatt,
Watt

Atmosphere, Bar, Kilo Pascal, Millimeter of mercury,
Pascal, Pound per square inch (PSI)

Degrees Celsius, Degrees Fahrenheit, Kelvin
Day, Hour, Microsecond, Millisecond, Minute, Second, Week

Centimeter per second, Feet per second, Kilometer per
hour, Knots, Mach (at one standard atmosphere), Meter
per second, Mile per hour

Cubic centimeter, Cubic feet, Cubic inch, Cubic meter,
Cubic yard, US & UK Fluid ounce, US & UK Gallon, Liter, US
& UK Pint, US & UK Quart

Carat, Centigram, Decigram, Dekagram, Gram, Hectogram,
Kilogram, Long ton, Milligram, Ounce, Pound, Short ton,
Stone, Tonne

89



MS Windows 7 Foundation Manual

Date calculation lets you compute either the difference between the two dates or
add/subtract days to a specific date. By default, the From field contains the current
date. Select a date in the To field and then click Calculate:

Select the date calculation you want

[Cah:uhate the difference between two dates T]

From Fa12000 [El- Ta Q/22/2009 [E=

Difference [years, months, weeks, days)

L month, 3 weeks, 1 day

Difference [days)
53 days

Calculate

Finally, Calculator includes Worksheets that let you plug in certain values and have
Calculator compute the result. Click View > Worksheets and then select a
worksheet:

Calculator
View | Edit Help
& Standard

- Select the date calculation you want
Scientific

Programrmer Calculate the difference between two dates

Statistics

Froam 7512000 [El- Ta 9/22/2009 [

History Difference (years, months, weeks, days)

Digit grouping 1 month, 3 weeks, 1 day

Basic Ctrl+F4 Difference (days)

Unit conversion Ctrl+U 53 days

Date calculation Ctrl+E

- I're WVehicle lease

Fuel economy (mpg)

Fuel economy (L1100 k)
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Enter the values and then click calculate. For example, here is a sample mortgage
calculation:

Select the value you want to calculate

Monthly payment -
Purchase price 100000
Down payment 5000
Term [years) 25
Interest rate (%) 5

555.3605394325801

Closing Calculator

Close Calculator by clicking the Close button in the upper right-hand corner:

Calculator IElﬂu

View Edit Help
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3.4: Paint

Paint is a simple drawing and photo manipulation program that can be used to make
diagrams as well as resize and rotate images.

Launching Paint

Paint is included in the
Accessories folder of the
Start menu. Click Start
-> All Programs ->
Accessories > Paint to
launch the program, or
click Start, type “paint,”
and then press Enter:

. Accessories
D Calculator
Command Prompt Velsoft
@3 Connect to a Network Projector
B Connect to a Projector Documents
=) Getting Started
& Math Input Panel Pictures
ME] Notepad
) Paint_
B Re h'l Desktop Connecticn
i3] Run | Create and edit drawings. } . Games

R Snipping Tool

t, Sound Recorder
" Sticky Notes
@ Sync Center

4 Windows Explorer
5 WordPad

1 Ease of Access Default Programs
.. System Tools

|, Tablet PC Help and Support

Back

Music

Computer

Control Panel

Devices and Printers

| Search programs and files

Interface Overview

Paint
» C(Click Start > All Programs > Accessories - Paint
= Paint is a basic drawing program with a number of drawing tools. Paint
can also open and manipulate popular digital image formats.

Paint has received an interface upgrade to include the Quick Access Toolbar (QAT) and
Ribbon:
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&l g

Home View 71

o [ rEee | gal ] RYOTOmEAN e | = | [ HEENECNENE gy

Copy | Tt L Resize : NS GOD Q|- Fill _ [] [] -
Selvect T P 2 Q Bruines D4 RO SI.ZE Colar Coz\or c:?:;s

Clipboard Image Tools Shapes Colors

100 864 = 540px

At the top of the window, the QAT contains three commands. From left to right, they
are Save, Undo, and Redo.

There

H9 ¢

Save will either save the changes to an existing file or ask you for a name if
saving a file for the first time.

Undo will revert the last command, such as a brush stroke or text overlay.
Redo will *undo the Undo.” If you undid something you didn’t mean to, click
Redo to apply the last formatting change that was reverted. If you recall our
exploration of the Computer Folder in Lesson 2.3, Undo and Redo work
somewhat like the Back and Forward buttons. Instead of moving backwards and
forwards through locations, you move backwards and forwards through changes
to your document.

is a pull-down arrow beside the Redo command. If you click this, you have the

option to add some other common commands to the QAT:

cl | i -RLl Untitled - Paint

B~ Homé Customize Quick Access Toolbar
= Cut Mew

Paste v | save
Clipboard Ll

Print preview
Send in e-mail

Undo

|| %=

Redo

Show below the Ribbon

Minimize the Ribbon
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As you can see, there are already checkmarks beside the Save, Undo, and Redo
commands. The checkmarks mean that those particular commands are already on the
QAT. If you clicked the pull-down arrow and clicked New, that command would be
added to the right of Redo:

él | id || = | Untitled - Paint

Paste - Select |
- < |y Rotate =

Clipboard Image

You can also right-click any command in the Home or View tabs, right-click a
command and click “Add to Quick Access Toolbar.” To remove an item, right-click it in
the QAT and click "Remove from Quick Access Toolbar.”

At the bottom of the screen is the Status bar:

+ 12} 10 864 » 540px 100% (=) () D)

Here you can see what tool is currently in use, the size of the canvas drawing area (in
pixels) and the current zoom level.

The blue area beside the Home tab is called the Backstage menu. This is similar to the
File menu used by many programs:

& D [ = | Untitled - Paint

J' New

Recent pictures

oy
1*7 open

b s l
= 2

lil Save as 3
[ %

= Print > ﬁ
50

j S5end in e-mail

[

. Set as desktop background F
s

N
.-""': Properties
v N
.0_. About Paint
A 2

Exit
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The Color Palette lets

Edit Colors
you choose from a —
number of standard Basic colors:
colors. If you click | |
Edit colors (last — = u
command in the . —
Home tab) you can | =~ -
define custom colors:
L B | |
N | =
Custom colors:
rr [
rrrrr

1T EHEEENF
11 TTHEEER

Define Custom Colars >

| ok || cancel |

L _

Hue: E
Sat: ﬁ

ColoriSolid 1, 125

Blue:

L e,

SN

[ Add to Custom Colors

Drawing in Paint

Drawing in Paint is easy to do - simply click a tool and then click and drag in the
canvas area. Paint lets you draw lines, shapes, boxes, polygons, and apply text to a

canvas. Click a command, move your mouse to the canvas and then click and drag to

add the drawing element. For example, the diagram below features some shapes,

brush effects, color fills, and text:

Clipboard Image Tools Shapes

Colors

(@ @9 e [ = | Untitled - Paint [EE
Home View (7]
X || e = RN g |
O3 0l |zeaicd @z = Ml E ey o rm
Paste Select | . & /0 L‘ W Shapes Size Color | Color Edit
e - Gk s E 1 2 LI IE I T cotors

m

00 864 = 540px

100% (=) -

}

O]

Paint has the ability to read a large humber of different picture formats as well. Click

Backstage - Open to choose a photo or other image. Paint, although versatile, is not

suited for doing much work with photos. However, you can use the commands in the

Home tab to flip, rotate, or scale an image.
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Paint can also save your image in many different file formats. Chose Backstage >
Save or Save As and then use the Save as type combo box to select a file output:

Rt

—

2 e A B »
- " [
i) [&=| » Libraries » Pictures » v | ¥ W Search Pictures L
= . - = == e o= = = e

5+ @

Organize v New folder

— Pictures |lbl’ary Arrange by:  Folder ¥

¢ Favorites
Includes: 2 locations

Pl Desktop
& Downloads
"2l Recent Places

L pics

4 Libraries
@ Documents L3 Sample Pictures
J' Music
[=! Pictures '
¥ Videos

v

File name: Untitled

52

Save as type: |PNG (*.png
Monochrome Bitmap (*.bmp;*.dib) |
16 Color Bitmap (*.bmp;*.dib)
‘4 HideFolders 256 Color Bitmap (*.bmp;*.dib)
i%ﬂ 24-bit Bitmap (*.bmp;*.dib) I
e JPEG (*jpg;*jpeg:* jpe ifif)
GIF (*.gif)
TIFF (*.tif:* tiff)

PNG (*,png)
(1864 % 5S40 0% o

Closing Paint
Close Paint by clicking the Close button or clicking Backstage > Exit.
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3.5 Other Windows 7 Ultimate Programs

Windows 7 Ultimate features a number of other programs for entertainment or to help
you with day-to-day activities. Examples include Notepad, Windows Media Player,
Windows Media Center, the Snipping Tool, and Sticky Notes.

Notepad

Notepad is a no-frills
word processor used to
keep quick notes or
other data. The
advantage of Notepad
being such a lean
program is that file sizes
are very small and easy
to send to others. Even
hundreds of pages of
data or text can still be
less than a megabyte in
size.

Notepad is found in the
Accessories folder:

., Accessories -

D Calculator

Command Prompt elso
@3 Connect to a Network Projector

B Connect to a Projector Do
4 Getting Started

& Math Input Panel T

M_le Notepad ]

l_,‘gfv Paint ml " x o T
%) Remote reates and edits text files using basic text formatting.

i3] Run
% Snipping Tool
L Sound Recorder
7 Sticky Notes
@ Sync Center

) Windows Explorer Ne
p:l WordPad

., Ease of Access Default Progra

. System Tools
;.TabletPC - elp and DPO

Back

I Search programs and files je | hut do

97



MS Windows 7 Foundation Manual

i !

| Untitled - Notepad =RECI X

File Edit Format WView Help

As you can see, Notepad’s interface is quite plain. Simply click in the text area and
type. The menus for Notepad contain the following options:

File

Edit

Format

View

Help

Create a new file, open an existing text document, save your document,
and print.

The standard Cut, Copy, and Paste commands are found here as well as
Find and Replace. You can also insert the date and time.

This menu contains only two items: Word Wrap and Font. When Word
Wrap is enabled, text will automatically wrap to the next line when you
type to the edge of the screen. Notepad has no margins so this feature is
useful. Otherwise your text would be one very big line! The Font option
allows you to change the font of the entire document. (You cannot assign
different fonts to paragraphs like you can in WordPad.)

Enable or disable the status bar:

e |n1, Coll

This displays where the cursor is in the document. It doesn’t really
provide much use as a word processor; however, it is useful when
analyzing output data or jotting down an important piece of information.

Provides a link to the help file.
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Windows Media Player

Windows Media Player is a program used to watch video, listen to music, play sounds,

look at pictures, and play a host of multimedia content on the Internet.

Windows Media Player
= C(Click Start > All Programs > Windows Media Player

and view pictures

= Windows Media Player is used to play different music files, CDs, DVDs,

Launch the program by clicking Start > All Programs > Windows Media Player or

by clicking the icon in the Taskbar:

@ Default Programs
[/ Desktop Gadget Gallery
€ Internet Explorer (64-bit) Velsoft

@ Internet Explorer

"g,] New Microsoft Office Document Documents
5 Open Microsoft Office Document

&4 Windows DVD Maker Pictures

55 Windows Fax and Scan
® Windows Media Center
@ Windows Media Player
E_} Windows Upda h')

Music

Games

¢ Lomputer
. Accessories

1 Catalyst Control Center Coctsal Pandd
. Games
, Maintenance
, Microsoft Office
. Microsoft Visual Studio 2005 Default Programs

. Snaglt8

Devices and Printers

Help and Support

Multimedia content can be played by double-clicking a file you want to play, or will
start playing automatically if a CD or DVD is inserted. Windows 7 includes some
sample audio clips in the Music Library. Let’s quickly go over the interface.

<A XPS Viewer Play digital media including music, videos, CDs, and DVDs.
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In the top left-hand corner, you can browse the Music, Videos, and Pictures libraries,
as well as other folders that contain media. You can also change the library/folder
view using the list on the left-hand side of the window. By default, the Music library
will be shown, as it is in the image below:

s = S|
Uu » Library » Music » All music Play Burn Sync
Organize v  Stream v  Create playlist v = v Searct Je = ‘@} I Save list lo A
Album # Title Length  Rating Contribut... *
B Library Bob Acri Unsaved list
;‘ Playlists Bob Acri 3 Sleep Away 3:20 WIS Bob Acri b
4 Jd Music Bob Acri
& Artist Jazz
() Album 2004
&) Genre = Unsaved list >
& Videos
:.: Pictures Mr. Scruff
&) Recorded TV MESCIVF £ Nirja Tuna 1 Kalimba 548 AR Mr. Scruff Drag items here
P Mr. Scruff to create a playlist
[ Other Libraries Hectionic =
\ﬁ'-" Mike (mike-pc) S— 2008
ninja tuna

Richard Stoltzman
Fine Music, Vol. 1 2 Maid with the Flaxen Hair  2:49 NN Richard S...
Richard Stoltzman
RICHARD -

S ZMAN. Classical

B viedia Guide ~ .
- 0 items
¢ 0 (e !@! bl ® —® =

Under the library headings in the top left-hand corner are commands to Organize
your content, Stream content from external courses, and Create playlist based on
the media that is currently displayed in the open library. In the center of the window,
you can browse the library by scrolling up and down through the list of media. Finally,
in the top right-hand corner are three tabs: Play, Burn, and Sync. Play will let you
choose a pre-saved playlist of media to play, Burn is used to record media onto a CD
or DVD, and Sync works to upload/download media from a portable media player.

At the bottom is a collection of playback buttons for use when listening to music or
watching videos:

Track/Video ProgressBar Shuffle Stop Play/Pause Mute
. Bob Acri el ¢ O | B [Idd I,@J Pl —e =

Current Track/Video Time Repeat Track Backward Track Forward Volume Switch to "Now Playing”

If you are listening to music and you click the Now Playing command, Windows Media
Player will “shrink” and display only the track information (the left image). If you
hover your mouse somewhere inside the window, you will see basic playback controls
(the right image). Click the icon shown by the red arrow (Go to Library) to return
Windows Media Player to “full size:”
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(g i) (@ le(@] = |
Kalimba Kalimba - ‘—

Dw— @ OC)
ninja tuna

If you wanted to play a video file from your library, double-click the file to open it.
Windows Media Player will change to Now Playing view, which works the same way
with video as with audio: move your mouse inside the window to see basic playback
controls:

[ = N

Wildlife in HD

When your video has finished playing, you have the
option to play the video again, go back to the library,
or play any previous playlists of music/video:

) Play again

s+ Go to Library

4= Play previous list

101



MS Windows 7 Foundation Manual

To view photos in Windows Media Player, click the Pictures library in the list on the
left. You can then browse the various pictures in your library:

= — ~
[5] Windows Media Player 1 F N [E=NEEE
Uu » Library » Pictures » All pictures Play Burn Sync
Organize v Stream v  Create playlist v sl v |Search ¥ | '@ bl Save list AL
Titl ) S Tags Rating
=) Library Unsaved list
B Library Monday, March 24, 2008 - 5 i
] Playlists b
4 JJ Music [
£ Artist
(=) Album
© Genre & Unsaved list =»
& Videos
]| Pictures ‘— .
&) Recorded TV Hydrangeas Drag items here
to create a playlist.
I‘FJ‘ Other Libraries Friday, March 14, 2008

Chrysanthemum

Monday, February 18, 2008

E! Media Guide ~

& ~ %) 1

b %4

If you double-click an image, or select an image and then click the Play button at the
bottom of Windows Media Player, you will see a slide show of all pictures in your
library. The pictures will “*play” in a window just like a video clip. You can pause the
slideshow or advance/backtrack through your photos using the controls at the bottom
of the window.

When you are finished with Windows Media Player, click the Close button (in any
view) to close the program.

Windows Media Center

Windows Media Center is a special program designed for using pictures, music, and
video with your television. Some people have a dedicated computer in their living
room (such as a media center PC, media PC, or media server) that is used to play
DVD and Blu-Ray discs, play games, view media content, and watch/record television
programs (with the right hardware). Windows Media Center is designed to let you do
all of this in one location with an easy-to-use interface.

Windows Media Center
= C(Click Start > All Programs > Windows Media Center
» Designed for use with a television, you can use Windows Media Center to
watch video; look at pictures; watch, record, and playback television;
and more
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If you purchased a computer that was designed to be used as a media center, chances
are you received a remote control/receiver as well. The remote probably looks
something like the desktop model shown on the left or the laptop/notebook model
shown on the right:

As you can see, both models include standard play/pause/record and navigation
buttons.

Open Windows Media Center by clicking Start > All Programs - Windows Media
Center:

@ Default Programs
[§% Desktop Gadget Gallery
@ Internet Explorer (64-bit) Velsoft
@ Internet Explorer
9&] New Microsoft Office Document Documents
(& Open Microsoft Office Document
&4 Windows DVD Maker Pictures
&%) Windows Fax and Scan
€ Windows Media Center ¥
I3 Windows Media Play&_) ) 4
Ej Windows Update Opens your home entertainment option for digital and on-demand media, ¥
A XPS Viewer including TV, movies, music and pictures,

Music

. Accessories

If your remote control has been set up and properly configured, you can press the
green buttons with the Windows logo to launch the program as well. By default, the
program runs full-screen, but Minimize, Maximize/Restore, and Close buttons are also
available in the top right-hand corner.

To navigate, use the directional buttons on your remote control, the arrow keys on
your keyboard, or your mouse to cycle through the menu options:
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Music
YErme
i_". oW

L Al

music library

At the bottom of the screen are controls to cycle through the current media category,
increase/decrease the volume, etc. Use these to cycle through pictures, videos, music,
or recorded television:

In the top left-hand corner of the screen, there is the familiar Back arrow (so you can
step back through the media categories you have recently viewed) and the Windows
Media Center button. (Click this to go back to the starting menu; the options you first
saw when you opened Windows Media Center.)
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Snipping Tool

Did you know you can take a screenshot of just about anything using your computer?
To do this, you can press the Print Screen button on your keyboard. On a standard
keyboard, this button is to the right of all the F keys. When you press this button,
your computer will store a snapshot (called a screenshot) of the entire screen in
memory, just like if you Cut or Copied something. You can then open a picture editing
program like Paint, paste the screenshot, and then edit out the information you don’t
need. This is handy, but not very practical because of all the editing work you have to
do after the fact.

Snipping Tool
» Click Start > All Programs > Accessories - Snipping Tool
» Capture a screenshot of something on your screen

Windows 7 features the Snipping Tool, a screen-capture program that gives you much
more control over the screenshot you want to capture. To open the Snipping Tool,
click Start > All Programs -> Accessories -> Snipping Tool:

!

. Accessories

I:l Calculator

E¥ Command Prompt Velsoft

@3 Connect to a Network Projector

B Connect to a Projector Documents
-~} Getting Started

&4 Math Input Panel = Pictures

;ﬂ Notepad )

¢l Paint Bleac

& Remote Desktop Connection
3] Run
K Snipping Tool_ |

1. Sound Recorjh’) Computer

Sticky Notes Capture a portion of your screen so you can save, annotate, or share the
@ Sync Center (295

= = [
2 Windows Explorer Devices and Printers

When you open the Snipping Tool, your desktop will become slightly grayed out and
you will immediately be asked to click and drag a region of the screen to snip:

Games

m
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(o)
. %y e T o0 4 ' + + + B

)

b
(.

Left Justified < Snipping Tool =

L £ ..
2 ™ { 1
Here is a sample paragraph % New |¥[|X| Cancel (:; Options rient pa|

text. WordPad can align all t text dow|
o Drag the cursor around the area (7]

you want to capture.

or align text to the right ma

Center Justified

E rile ¥ Frint ¥

Slid Here is a sample paragraph that will be used to show
text. WordPad can align all text to match the border of
ry or align text to the righ{

Right Justified

Click and drag an area of the screen to snip, such as part of an image:
raer on Ine I1eTtt, TIow all Text aow|

| Lighthouse - Windows Photo Viewer

show |
rder or
1e righi

3 show
rder ot

100%

indows Photo Viewer
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When you release the mouse button, the snipped portion of your screen will be shown
in its own window:

§
S} Snipping Tool | sl elEh

jy’v

File Edit Tools Help

At the top of the screen you have some basic tools to work with your snip:

New Snip @’ New Discard the current snip and prepare to capture a new
- one.

Save Snip H Save the current snip. By default, Windows will direct
o you to the Pictures library. Give the snip a name and, if
you wish, change the file type:

7 | Fbares i Pictiesy

Organize ¥ New folder = v (2]
Bl Desktop &

& Downloads

Pictures library

X Arrange by:  Folder v
Includes: 2 locations

| Recent Places

I pics

—
2 z ——————
4 Libraries ——
[ Documents i T
S NANANAN
N .
i Music Sample Pictures paintbrushed
[&=] Pictures
Videos
File name: Capture v
Save as type: | Portable Network Graphic file (PNG) -I

Date taken: Specify date taken

~ Hide Folders [ swve ][ cance |

107



MS Windows 7 Foundation Manual

Copy

Send Snip

Pen

Highlighter

Eraser

4

&/

The Snipping Tool is capable of saving images in PNG,
GIF, JPEG, and Single file HTML formats. We
recommend you keep the PNG format for best quality.

Clicking this icon will copy the picture to your
computer’s memory. You can then Paste the image into
some other editing program.

Send the snip to someone else via e-mail. You need to
have a Mail profile created and an e-mail program
installed on your computer in order to take advantage
of this command. If you don’t have an e-mail profile set
up but do have access to an online e-mail address, you
will have to save the snip and then manually attach the
image to your message.

You can use the mouse to scribble on the snip. Click the
pull-down arrow to switch between pre-defined pen
types, or customize your own:

7H/ @ |

Red Pen
&  Blue Pen
Black Pen
Custom Pen
i__ Customize...

Click this command to use a yellow highlighter on your
snip. If you have snipped a portion of text, this is a
handy tool to enhance important text.

The Eraser will remove any pen or highlighter markings
from the original snip. This will not erase any part of
the actual snip.
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If you open the Snipping Tool again, you have control over how your initial snip will
captured. The interface is fairly simple:

S Sripring ool

(%Mew v |X]| Cancel {03 Options |,
o

Select a snip type from the menu ®
or click the New button.

be

Click the New command to capture a new snip. Click the pull-down arrow to select the

style of snip:

@,Hm % Zancel {i

Free-form Snip

@ Rectangular Snip
Window Snip

Full-screen Snip

Let’s explore what these snip options would do. Consider the following desktop:

- A =-10g: | BT = | ? M Foe
n Aa Rz~ 18 - [ ORI 4 & Restace
- . s Bl Paint  Dateand Insent
BZ UdeXx Z-A- EEIANES . e M | Bl ekt

4 [ 1 ‘ 2 ' 3 [ : ‘ 5 0
a S

Lorem psum dolor st amet, consectetur adipiscing it Duis sit amet tortor et Suspendisse m
Egada eget Incus ultnicies solicitudin, Ut a felis sem. Maecenas volupat tarpés non nulla iaculls
matsis sodales est placerat. Nullam mnperdiet sapien massa gravida ulk P
Donec consequat malesuada quam, sit amet mattis lorem dapibus et Sed risus turpis, semper id
molis ut, auctor qais neque. Cras scelerisque quam viverra mi tristique sed elementum feks
vehicuda. Pellentesque vitae parus non quam viverra vasms. Cras ut pharetra mibh. Diss vaipatate
vehicuda dapibus. Nullam est eros, faacibes quis omare noa, aoctor vehicula neque. Prom sisl
2, volitpat et accumsan noa, molis mon nibh. Ut id erat felis. Ut meerdum erat i tostor Jobortis
ot egestas est viverra, Maecenas tristique, magna vel vestibuham posuere, enimn leo mmperdiet
Bbero, quis pharetra Bbero lectus et velit

Ut cu enim sit amet risus loborts malesuada noe adipiscing justo. Aencan mollis odio mnperdiet
nis] sagittis fermentiam. Vestibultum a enim ac mauris consequat gravida at id aste. Etiam lobortis
erat sed nulla fringlla vitae portttor arcu bibendam. Duis egestas lacinia vokepat Etizen sagittis,
el vitae ulivices abiquet, ms ante volatpat est, m rutram ocbo dolor ac nisl Morbs eget lorem et
fielis lobortis thoncus solicinadin st amet 3. Cras cursus gravida auctor. Phaselus a quam et
oulls accumsan fringilla ut st amet sapien. Quisque pharetra fermentum Bbero, pharetra laoreet
narpss tincacket ac. Cras vel febis ut fells volatpat iaculis. Nam facilisis viverra tortoe noa
condimestum. Vivamus nisl nisi, venenatis 3 clementam semper, Cursas sit amet massa Aencan

100% (=

Free-Form Snip will let you click and drag a shape with your mouse. For example,
we could capture a snip of the command area of WordPad.

By default, the Rectangular Snip is selected and lets you capture square or
rectangular snips.
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Window Snip will capture a window and its contents. You could capture a screenshot
of the window above faster using Window Snip instead of manually using Free-form or
Rectangular Snips.

Full-Screen Snip will take a screenshot of the entire screen, as shown above.

Finally, the Options button lets you control how the Snipping Tool works in the
background:

Snipping Tool Options @

Application
Hide instruction text

V| Always copy snips to the Clipboard
V| Include URL below snips (HTML only)
| Prompt to save snips before exiting

| Show screen overay when Snipping Tool is active

Selection
Inke color: I Red -

Show selection ink after snips are captured

[ oK || Cancel

Sticky Notes

Sticky Notes takes the popular yellow adhesive note and makes it virtual! These notes
are very easy to use and you can attach them anywhere on your desktop wallpaper.
You can type in them to leave yourself a reminder or you can use handwritten text if
you use a tablet PC or other touch sensitive device.

Sticky Notes
» C(Click Start > All Programs - Accessories - Sticky Notes
= Leave yourself short messages on the desktop with a virtual yellow sticky
note

To make a new Sticky Note, click Start > All Programs -> Accessories > Sticky
Notes:
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W

Accessories

Calculator

B3 Command Prompt

22 Connect to a Network Projector

E=| Connect to a Projector

=1 Getting Started

# Math Input Panel

j MNotepad

2l Paint

% Remote Desktop Connection
5] Run

% Snipping Tool

[, Sound Recorder

' Sticky Notes_

A new note will appear:

@ Sync Centel
) Windows Exg

=l WordPad

Create short handwritten or text notes.

Velsoft

Documents

Pictures

Music

Games

Computer

Control Panel

| Printers

Type into the note to leave yourself a reminder or use a stylus on your touch sensitive

surface to write something:

To make a new note, click the + sign at the top-left of the “active” note:
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+

Call mechanic
555 —12121

To move a note, click and drag the top of the note and drop it wherever you like on
your desktop.
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You can also resize notes by clicking and dragging the bottom right-hand corner:

+

Call mechanic
555 —1212.|

If you need to change the note’s contents, click anywhere inside the note and make
your changes. To delete a note, click the top of the note you want to remove and then
click X. You will be asked to confirm the deletion:

Delete Mote

Are you sure you want to delete this note?

Don't display this message again

Remember that deleted notes are gone forever! They don’t get moved to the Recycle
Bin.
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Chapter 4: Doing More with Windows 7

In this chapter you will learn how to:

Open the Action Center

Recognize threats to your computer and your data
Modify basic security settings

Open Internet Explorer to view Web pages
Navigate through Web pages on the Internet
Use tabs and windows in Internet Explorer
Use Web Slices

Download and install a program

Recognize the different Windows Live services
Use Windows Live Messenger

Use Windows Live Hotmail
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4.1 Staying Safe

The Action Centre is a special all-in-one location that keeps your computer up to date
and helps prevent malicious attacks from others.

Opening the Action Center

The Action Center is available in one of two locations: in the Control Panel and, in
special circumstances, in the System Tray. You should be familiar with the System
Tray, but the Control Panel is a new term for us. The Control Panel contains a
number of commands you can use to change the look and feel of your computer as
well as control the background operation. The commands in the Control Panel are
beyond the scope of this manual, and the Control Panel will be discussed in detail in
the Windows 7 Ultimate Advanced Manual.

Action Center
= C(Click Start > Control Panel > System and Security = Action Center
= All-in-one location that alerts you of issues relevant to computer security

Nonetheless, computer security should be a concern to everyone so even though you
may only be a new user, you should still know the basics of keeping yourself and your
data as safe as possible. Let’s look at the Control Panel method first. Click Start >
Control Panel.

When the Control Panel window appears, click System and Security:

-

—
U@v“_&_ﬂ » Control Panel »

Adjust your computer's settings View by:  Category ¥
il  System and Security wl User Accounts and Family
3 Review your computen_gtatus __Sﬁ; Safety

) Back up your compute System and Security remaove User accounts

Find and fix problems | View and change systern and security
status, back up and restore file and
w,  Network and Inte| system settings, update your nce and
M Connect to the Interng] computer, view RAM and processor . .

- View network status ar| speed, check firewall, and more, lization
CrarmeThe theme
Change desktop background
Adjust screen resolution

parental controls for any user

Choose homegroup and sharing
options
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Now click Action Center:

‘.?3 » Control Panel » System and Security »

Control Panel Home

3? Action Centaf
e System and Security Review your co ter's status and resolve issues I

B Change User | Action Center
Metwork and Internet Troubleshoot cof PEview recent messages and resolve
Restore your co problems with your computer.

Hardware and Sound

Programs ﬂ Windows Firewall

Check firewall status | Allow a pregram through Windows Firewall

User Accounts and Family
Safety
Appearance and ﬂb-!.é'l S‘},-'STE‘I"I"I

Faresmsliesien View amount of RAM and processor speed

m

Iw N -
TR cave e Check the Windows Experience Index '@' Allow remote access

See the name of this computer '@Dex-‘icehﬂanager
[q Windows Update
=) Turn automatic updating on or off | Check for updates
View installed updates

Ease of Access

Before we explore the Action Center, you might have noticed a small warning in your
System Tray stating that there are possible issues with your computer. Click this flag
icon to see more information:

Solve PC issues: 1 important message
2 total messages

2:31 PM
8/18/2009

A |.i al I“):'

When you click this icon, you might see something like the following:

1 important message
2 total messages
Find an antivirus pregram online (Important)

Change Windows Update settings

Open Action Center

Click Open Action Center to view information about these issues. (Keep in mind that
this icon will only appear in the System Tray if there are any issues to be addressed.)
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Action Center Overview

Either method of opening the Action Center will show you a window like the following:

[ o o e |
@U'|P v Control Panel » System and Security » Action Center - | $¢| Search Con... 2 |
T —
i -

Control Panel Home .
Review recent messages and resolve problems

Change Action Center settings Action Center has detected one or more issues for you to review.

'E‘:,f' Change User Account Control

ssiings Security ©
View archived messages
View performance information Virus protection (Important)

Find a program online

Windows did not find antivirus software on this computer.

Turn off messages about virus protection

Windows Defender needs to scan your computer

Scanning on a regular basis helps improve the security of your computer,

m

Maintenance

Set up backu _
P P 1% Set up backup

Your files are not being backed up.

Turn off messages about Windows Backup

See also

Backup and Restore If you don't see your problem listed, try one of these:

Windows Update

) Troublesheoting !’-‘ J  Recovery
Windows Program || Find and fix problems [h« ' Restore your computer to an

Compatibility Troubleshooter carlier time

Before we get into the details of the Action Center, let’s take a look at the features of
this particular window. At the top, you should recognize the Address bar and the
Back/Forward buttons. There is a list on the left that contains other links relevant or
related to computer security. And in the upper right-hand corner, you should see the
blue Help icon.

Now let’s focus on the details in this window. Windows 7 uses a color scheme to rate
the severity of issues on the computer. As you can see, Windows doesn’t think this
computer is very secure! The red color beside Virus protection indicates that no anti-
virus software has been installed. The yellow colors beside Windows Defender and Set
up backup indicate some issues that are not considered critical, but should be
addressed soon.

We will discuss how to deal with these issues later in this lesson, but first let’s go over
some of the basics about computer security.
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Security Essentials

The issue of computer security can be overwhelming to a new user, but keeping
yourself, your family, and your data safe isn't as hard as it seems. In fact, Windows 7
already takes care of a lot of it for you. The following list gives a brief overview of
computer security terms and what to do to stay safe:

Firewall A firewall blocks unwanted Internet and network traffic traveling
to and from your computer. Windows 7 features a firewall that
does a good job of protecting you. We recommended that the
firewall remain active at all times.

Other firewall programs are available for purchase from your
local computer retailer and provide more customizable features,
but you probably don’t need to use them unless it has been
recommended by an IT professional.

Antivirus An antivirus program is not included with Windows 7 and is
highly recommended. This type of program will automatically
scan the files on your computer (even as you use them) to check
for the telltale signs of viruses. Antivirus programs are available
for purchase at your local computer retailer.

There are also a number of free antivirus solutions available
from the Internet, but they do not provide as much coverage or
as many features as subscription-based antivirus software.

Anti Spyware and malware (MALicious soft WARE) are small programs
Spyware/ that are usually more annoying than dangerous, but they still
Malware have the ability to cause a lot of trouble.

Windows 7 features a basic but very good built-in anti
spyware/malware program called Windows Defender. Other
malware solutions are available for purchase at your local
computer retailer, and there are a number of free versions on
the Internet.

Caution and  If you are new to computers, take the time to read program

Common details and reviews. If you receive a file or message that seems

Sense to be out of place, too good to be true, or suspicious, chances
are it is. Simply close these programs and ignore them. Talk to a
friend, look at the help file, or ask someone you know for remote
assistance (which we will cover later in the manual).

It is important to note that more is not always better! If you install multiple anti-virus
programs or multiple firewalls, the programs will start to conflict with each other or
cancel each other out, leaving your computer wide-open to any attack.
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Modifying Basic Security Settings

Now that we know a bit more about computer security, we’ll go over how to change
some of the basic security settings available in Windows 7. Let’s look at the Action
Center again:

( EEEERT)

@l\:jvrﬁ’ v Control Panel » System and Security » Action Center - | +3 | | Search Con... 0 |
_ I

Control Panel Home .
Review recent messages and resolve problems

Change Action Center settings Action Center has detected one or more issues for you to review,

'P:,f' Change User Account Control
settings

Security 2
View archived messages
View performance information Virus protection (Important)

Find a program enline

Windows did not find antivirus software on this computer,

Turn off messages about virus protection

Windows Defender needs to scan your computer

Scanning on a regular basis helps improve the security of your computer,

m

Maintenance

Set up backu —
P P 9 Set up backup

Your files are not being backed up.

Turn off messages about Windows Backup

See also

If you don't see your problem listed, try one of these:

Backup and Restore
Windows Update

T
Troubleshooting ') Recovery
' A L S
Windows Program Find and fix problems [b.e *  Restore your computer to an

C tibility Troubleshoot ier ti
ompatibility Troubleshooter earlier time

Under the Security heading, Windows 7 states two things: it can’t find an antivirus
program, and Windows Defender needs to scan your computer. Let’s focus on virus
protection first.

If you have a connection to the Internet, click the “Find a program online” button for
more information on different Microsoft partners that offer antivirus software.

This will open Internet Explorer 8, a program used to browse the Internet.

Information about different antivirus software manufacturers is listed here; read the
introductory paragraph and then click a company logo for more information:
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p
'_r,é Windows T: Security software providers - Windows Internet Explorer

WS - . . 0= - e
wlied |l’ http:/fwww.microsoft.com/windows/antivirus-partners/windows-7.aspx

£7 Windows 7: Security software providers

¢ Favorites | g5 @8 Suggested Sites v @] Web Slice Gallery =

& &7 = = g%a v Page~ Safety~ Tools~ '@" ”

@ Upgrade your Internet Experience United States

f} WindOWS' Search Microsoft com blﬂg il

Home  Discover Windows Products Shop Downloads Help & How-to

Security software providers

Windows Vista Windows XP

We recommend that you install security software to help protect your computer from viruses and other
security threats, and that you keep your security software up to date

The companies listed below provide security software that is compatible with Windows 7. Just click the company name to
see the Windows 7-compatible product they offer.

Important: Before you install antivirus software, check to make sure you don't already have an antivirus product on your
computer. If you do, be sure to remove the product you don't want before you install the new one. It can cause problems
on your computer to have two different antivirus products installed at the same time.

Microsoft is actively working with the partners listed on this page and additional security independent software vendors
(ISVs) to provide security software solutions tested on the Windows 7 Beta.

Change | All Microsoft Sites

Protect yourself, I"l )
your PC, and

your family.

Check out "Security at
Home."

Windows Vista
Compatibility Center

| Check device
and software
compatibility. @

m

'V'm' ) McAf o
TREND, c ee®
Jm“o BULLGUARD |
i GDATA
PANDA Eavc Norton e i
4] 1 L
& & Intemet | Protected Mode: On 3 ov W100% v

In order to use the products provided by these manufacturers, you will have to

purchase a license or subscription online or from your local computer retailer. This
enables you to receive updates for your software product while you are connected to
the Internet.

You should always install these updates! Your antivirus software will only be effective
if you keep it up to date.

Now let’s look at Windows Defender. Back in the Action Center, click Scan now to start
a scan with Windows Defender:

Windows Defender needs to scan your computer

Scanning on a regular basis helps improve the security of your computer.

(Scannom ]
r

Windows Defender

= Click Start, type “windows defender,” and then press Enter.
= Windows Defender is a program that scans your computer for
adware/spyware (collectively known as “malware”). Windows Defender

can delete or quarantine malicious software.
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Windows Defender will open in a new window and perform a quick scan:

i ™y
3] Windows Defender e wo s [E=REER

N

“_‘ ﬂ']. Home e'_ Scan | 'g History ﬁ T

This might take a few minutes.

Scan type: Quick scan

Start time: 10:15 AM

Time elapsed: 00:00:05

Resources scanned: 1814

Resource: CAWindows\systern32\DRIVERS\pcmcia.sys

This Quick Scan checks the core files and folders associated with Windows. The scan
will take a few minutes to complete.

If everything is okay, you will see the following message:

-
&4 Windows Defender

o n) e -

1 ‘_‘ iy Home = Scan |~ 3 History 0 Too

Protection against spyware and potentially unwanted software

\l, No unwanted or harmful software detected.

Your computer is running normally.

Scan type: Quick scan
Start time: 10:15 AM
Time elapsed: 00:01:01

Resources scanned: 764856
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Close Windows Defender to return to the Action Center. As you can see, the Windows
Defender yellow alert has been removed:

Review recent messages and resolve problems

Action Center has detected one or more issues for you to review.

Security )

Virus protection (Important) ; .
Find a program online

Windows did not find antivirus software on this computer.

Turn off messages about virus protection
Maintenance 6]

Set up backup

[ ) Set up backup

Your files are not being backed up.

W

Turn off messages about Windows Backup

If you don't see your problem listed, try one of these:

F& Troubleshooting .’:‘_ Recovery
= Find and fix problems [b/ = Restore your computer to an

earlier time

It is rare to find a computer that will nhever be connected to the Internet, but not
unheard of. If your computer will never be online or connected to other computers
through a wired or wireless network, then you have little to worry about! You can
disable the warning related to virus protection, and therefore eliminate the issue.

You now have the knowledge to be able to browse the Internet with little worry. Just
remember to pay attention to the things you click and stay away from things that
seem too good to be true. In the next two lessons, we will discuss Internet Explorer 8
and open your computer to a whole new world of content.
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4.2 The Basics of Internet Explorer 8

You should be familiar with using menu bars and different commands.

Internet Explorer 8
»= C(Click Start > Internet Explorer
= Web browsing program that lets you view content on the Internet

Launching Internet Explorer 8

Internet Explorer 8 can be launched by clicking the Internet Explorer icon in the
Taskbar or by clicking Start > All Programs - Internet Explorer:

@ Default Programs
[ Desktop Gadget Gallery
,fé Internet Explorer (64-bit) Velsoft
@ Internet Explorer_
qﬁ] New Microsoft @ce Document Documents
&) Open Microsoft (Finds and displays information and Web sites on the Internet.
& Windows DVD Maker Pictures
&%) Windows Fax and Scan
 Windows Media Center
@ Windows Media Player
E._'i Windows Update
<4 XPS Viewer
. Accessories
) Catalyst Control Center
. Games

Music

Games

Computer

Control Panel

, Maintenance

. Microsoft Office
. Microsoft Visual Studio 2005 Default Programs
. Snaglt8

) Startup Help and Support

Back

Devices and Printers

| lear:h programs and files

When Internet Explorer opens, you will be taken to the home page. This is a pre-
defined page that will always open when the program is opened. You can customize
which page you want as your home page, but we’ll explore that later on.
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Initial Setup

When you open Internet Explorer for the first time, you will be asked to go through
the initial setup procedure. Click Next to continue:

Set Up Windows Internet Explorer .

( Welcome to Internet Explorer 8

Internet Explorer 8 helps you use the Internet even faster than before.

New features like search suggestions retrieve information as you type,
and Accelerators let you preview online services just by pointing your
mouse at them.

Learn about these new features and how to manage their settings

Read the Internet Explorer Privacy Statement online [ Next l [ Ak faee ]

*"Top 10 underrated cars =7\ B | GM: Voltto get 230 m
Next, you will be asked if you want to turn on Suggested Sites. This feature examines

the types of Web sites you visit and suggests other sites that might interest you. Click
the radio button beside Yes or No and then click Next:

Turn on Suggested Sites

Do you want to discover websites you might like based on websites
you've visited?

© Yes, turn on Suggested Sites

© No, don't turn on

Suggested Sites is an online service that uses your browsing history to make personalized
website suggestions. You can turn off Suggested Sites at any time.

Read the Internet Explorer Privacy Statement online [ Back ] [ Next {Q [ Gancel
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Finally, select the other options you would like to enable or disable. We recommend

you go with the suggested settings and then click Finish. (If you have previous
experience with using the Internet, you can choose to customize the different

options.) Make your selection and click Finish:

Choose your settings

Before you get started, do you want to:

© Use express settings
Search provider: Google
Search Updates: Download provider updates
Accelerators: Blog with Windows Live, Map with Live Search, E-mail with Windows Live,
Translate with Live Search
Compatibility View: Use updates

@ Choose custom settings
Review and modify each setting individually.

Read the Internet Explorer Privacy Statement online [ Back ] [ Finisl'!}J [ Garcel

Once you click Finish, you will be shown the default home page, MSN:

& MSN.com - Windows Internet Explorer

QO - |Vﬂtp:.‘"www.msn.com”

¢ Favorites | 5 (@ Suggested Sites v | Web Slice Gallery v

" MSN.com v @ v [0 @ v Pagev Safetyv Toolsv @~

Tuesday, August 11, 2009

A mom's sexy stomach trick: Amazing

V.’V‘f'l) MSN | Images | Videos | Shopping | News | Maps ,/

Search: Titans' fake punt? | Used car prices up? | Space taxis?

© Hotmail Airfares & Travel Food & Entertaining Maps & Directions Real Estate/Rentals Weather
Autos Games Money Shopping White Pages

@ Messenger

»Sign in N
Make MSN your homepage Ways to Keep y NOkia...
Customize your Page v Romance Strong i ‘ My Life, connected.

Laughter, ‘me’ time
& Hotmail & midday hellos
are a few hints
% WindowsLive Hotmail

brings you more. More space L

Video Highlights Today's Picks Nokia Surge Nokia E71x

« Hillary to student: I'm the
secretary of state, not Bill

« NFL gets official toiletries

Shriver dies

Wl founder, IFK's
sister was 88

- Buy a new car on eBay?

msn* autos

Car Wheelin' & Dealin’:
+ Top 10 underrated cars

MSNBC News

GM: Volt to get 230 mpg in city
+ How to negotiate a car deal + Myanmar court convicts Suu Kyi
) + Most-recommended vehicles

Exclusive: "Astro Boy' Trailer
He's built e world

- Best-sellers ... so far
+ Bing: Help with pushy salesmen

Careers & Jobs Health & Fitness Movies Sports Wonderwall
@ My MSN City Guides Horoscopes Music Tech & Gadgets Yellow Pages
© Download IE8 Dating & Personals Lifestyle News v MSN Directory

= atat _N NOK
Special Olympics = > Buy Now Connecting P

Toolbar | Espafiol

f T3 N S 790
OINg| e

< )

Is=

(5GB), more security, stil free. o Get the love q - | ( -
¥ Sign up you want . ’ =
< Previous Next > i t —

Advertisement Ad feedback

« NYT: White House plays defense on health
+ No 'death panel' in health care bill | Video
- 260 saved in town hit by mudslide | Video

T
»
|

-

n

7

& @ Intemnet | Protected Mode: On g

#100% ~
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Other Setup Options

The Internet Explorer interface should now be a familiar site. Other aspects of the
Windows 7 interface use the same general layout.

The top of the Internet Explorer window is referred to as the Command Area. The
standard Command Area looks like this:

& MSN.com - Windows Internet Explorer

UO = |v http://www.msn.com/

¢ Favorites | 5 @ Suggested Sites v | Web Slice Gallery ~

| %! MSN.com

0 v & v 1 @ v Pagev Safetyv Toolsv @~ &

For most users, this default layout contains all the necessary commands to use the
Internet. We will explore the different areas in just a bit, but first we'll take a look at a
few extra features. To see all options available for use, right-click on any empty space

in the Command Area (such as the blank area to the left of the Home icon -

will show a right-click menu:

- 0| (|l

SIASISS

Menu Bar

Favorites Bar

Compatibility View Button

Command Bar
Status Bar
Snaglt

Windows Live Toolbar

Lock the Toolbars
Custo e

i 7] v [ fm v Pagev Safetyv Toolsv @~

Toolbar @ Espariol »

7
790 A Dy-vant

New York, NY

<> XEw)

Estate/Rentals Weather
bping White Pages

s Wonderwall =
& Gadgets Yellow Pages

Use Large Icons
Show Stop and Refresh Buttons before Address Bar

Show All Text Labels
Show Selective Text

Show Only Icons

Add or Remove Commands...

Let’s quickly explore the options of this menu and touch briefly on the interface. We
will explore the interface in more detail later in this lesson.

Menu Bar

Click here to place a check mark and view the Menu Bar. It will

show a list of menus that control much of the background use of
Internet Explorer:

B, This
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Favorites Bar

Compatibility
View Button

Command Bar

-
€& MSN.com - Windows Internet Explorer

Uu v |v http://waw.msn.com/
File Edit View Favorites Tools Help f—

57 Favorites | 55 & Suggested Sites » & | Web Slice Gallery ~

_| %" MSM.com | |

By default, this bar is not visible.

The Internet displays Web pages with a URL (Uniform Resource
Locator), more commonly known as an address. Favorites are
saved URLs that you can access with a single click. We will
explore Favorites in more detail later.

& MSN.com - Windows Internet Explorer

I\../’I U | W http://www.msn.com/

|| 5 Favorites | 55 @ Suggested Sites » & | Web Slice Gallery ~

U " MSh.com |_

The Internet as we know it today has been around for several
years, but many pages have remained around for much longer
than that. Internet Explorer 8 can attempt to correct misaligned
text and images on old pages by clicking this button:

| & l.‘-’ B

v

28 Googe

G E—— =

This button is only visible when Internet Explorer detects an
older Web page.

The Command Bar is a list of commands visible on the right-
hand side of the screen. As you can see below, many of the
commands have a pull-down arrow beside them for extra
commands. Click the (>>) button on the far right to see any
other commands that don't fit in the current window:

Mo v [ o= v Pagev Safetyw Toolsv @~ ”
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Status Bar

Other
Customizable
Add-Ons

Lock the
Toolbars

Use Large
Icons

The status bar is located at the very bottom of the Internet
Explorer window. It displays several pieces of information about
the Web site you are currently viewing, loading, or are going to
visit.

Uhttp:.f.-"www‘msnbc.msn.cnm.-"id.-"32361939fr @) @ Internet | Protected Mode: On 3 v HI0% ~ U

Depending on the different software packages currently installed
on your computer, you may see other programs listed here. Each
of these programs has some direct way of interacting either with
Internet Explorer or the content that is being viewed.

The toolbar is locked by default. Essentially, this keeps everything
neat and tidy together in the Command Area. However, you have

the option to customize the look of the toolbars. If you disable the
lock, you will see a column of small dots appear on the left of each
toolbar.

& MSN.com - Windows Internet Explorer

[|
| @ ‘w‘.tp www.msn.com v l ‘7’ X ’ l"l Google
S

1. Favorites i @ Suggested Sites v & | Web Slice Gallery V\

% MSN.com "’l\ A Dl v ] m v Pagev Safetyv Toolsv *@‘v g

These “handles” allow you to drag any of the toolbars to another
location. As you move one toolbar around, the others will
automatically adjust themselves to move out of the way.

By default, the Command Area uses small icons. Click the Use
Large Icons button to increase the size of the commands.

& MSN.com - Windows Inte

E MEMN.com - Windows Internet Explorer — ’T
6 ; \—) = http: /N

@v- - |‘f‘ http://www.msn.com/

57 Favorites | 55 & Suggested Sites ~

' v, Favorites = @

% MSM.com W MSM.com

Large icons allow those who are harder of seeing to more easily
use a computer.
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Interface Overview

As you may have already guessed, Internet Explorer 8 uses the same sort of interface
used to navigate around your computer with Windows Explorer. Take a look at the
Command Area of Internet Explorer:

€& MSN.com - Windows Internet Explorer

'.’ Google P l

@ bt ® \v http://www.msn.com b ’ s | A
7 Favorites | 55 @ Suggested Sites v 2| Web Slice Gallery v
%* MSN.com T"'I\ v l:j v [ mm v Pagev Safetyv Tools~ ‘@"v i
And Windows Explorer:
@Qv'ﬂ » Libraries » Documents » 7E arch Doc.. P |
— e
’ Organize v 3 Open Share with v E-mail Burn New folder e > [ ‘]@J ‘

We can see right away that there are Back and Forward buttons, an address bar, a
search bar, and other commands:

Back & Forward As you navigate through different Web pages, you can
Buttons retrace your steps backwards (by clicking the left-facing
@@ & arrow) or forwards (right arrow). Click the small pull-down
arrow to jump directly to a particular Web site instead of
moving backwards one site at a time.
Address Bar The address bar lets you click and type a URL.:
|'\q http:/ fwww.msn.com; - | ‘"}| x |

The two buttons to the right of the address bar are Refresh
(blue arrows) and Stop (red X). Click Refresh to re-load the
current Web page or file; click Stop to stop a Web page
from loading.
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Search Bar

Favorites Bar

The Search Bar is to the right of the address bar:

"-"'l Google P |

Click in the Search Bar and type a word or phrase. Then
click the magnifying glass or press Enter to search. For
more options regarding searching, click the pull-down
arrow. These options allow you to choose a different search
provider:

-

= | B -

"'l Google | pe |T,\\l§

| [*]] Google (Default)
b5 Bing

P

o

Find on this Page...

—
E
n
L

Find Mare Providers...

Manage Search Providers

A Favorite in Internet Explorer is a saved URL that is
associated with one Web page or file on the Internet.
Saving a Favorite (and thusly using it later) prevents you
from having to remember a long URL when you want to
visit a Web site in the future. Click the single star to open
the Favorites Center, or click the star with the green arrow
to add the current URL in the address bar to your list of
Favorites:

. Favorites | 93
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Suggested Sites/ These two items are part of the Favorites Bar. If you

Web Slice Gallery enabled Suggested Sites during the initial setup of Internet
Explorer 8, click the pull-down arrow here to view a list of
similar sites:

[é Suggested Sites v{/\‘lé Get More Add-ons -

Top 5 websites that are similar to

MSM.com

¥? Yahoo!

YouTube

&N ChM.com - Breaking Mews, U5, World,...
I Fox News

Mational and Local Weather Forecast,...

Other Suggestions

% +#  https//iconlinemicr.. 3 Microsoft Corpora...

Web Slices are a new addition to the Internet Explorer
product family. Many people visit the same Web sites over
and over again to check for weather news, stock quotes, or
sports scores. With Web Slices, you can set Internet
Explorer to watch that particular “slice” of the Web page
and update you when something changes. We will explore
more about Web Slices in the next lesson.

Command Bar The Command Bar includes commonly-used commands

such as Home (returning to your Home page), Print,
browser safety, and more:

TR v [ o= v Page~v Safetyv Tools~ @~

Internet Explorer also features tabbed browsing which allows you to quickly switch
between many Web pages at once in the same window. We will explore tabbed
browsing in the next lesson.
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Closing Internet Explorer

Click the Close button or (if the menu bar is enabled) click File > Exit. If you have
multiple tabs open, Internet Explorer will confirm that you want to close all tabs
before the program is closed:

Internet Explorer ﬂ I&

Do you want to close all tabs or the
cumrent tab?

—_—

Close all tabs ] | Close curmrent tab

Abways close all tabs

4.3 Doing More with Internet Explorer 8

Using the Address Bar

If you know the URL of the particular Web site you would like to visit, you can enter it
by clicking in the Address Bar text box and typing it manually:

‘& MSN.com - Windows Internet Explorer ‘

bl 3l W www.velsoft.com| T
WDANE I

- Goto " www.velsoft.com Enter
7.7 Favorites

When you have entered the complete URL, press Enter on your keyboard to make
Internet Explorer load that particular Web site.

If you enter an address incorrectly, either by misspelling a word or entering a space
by accident, Internet Explorer might display an error page. This page tells you that
Internet Explorer could not find the server that hosts the particular Web site you
specified. There are other possible causes:

» It is possible that the Web site might not be active on the server at the time, or
the response back from the server was too slow in order for Internet Explorer
to display data in time. (A server that is too slow will prompt Internet Explorer
to time out.) Click the Refresh button or try the Web site later on.

= It is possible that you entered your account information given by your ISP
incorrectly, and will need to contact your provider to help troubleshooting this
problem.

= It is possible that the Web site you are trying to access has higher security
settings than a publicly available server. For example, if you are an employee of
a large company that allows its workers to access the private network from
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home, Internet Explorer can be configured to encrypt the data so only the
intended server at your company will see your data.

In some cases, the Search provider you chose during the initial setup of Internet
Explorer might try to find results close to the web address you entered.

Internet Explorer also features an AutoComplete option that will automatically fill in
Web sites that you have already visited. For example, if you visited Microsoft's home
page in the past, your browser will have saved the URL http://www.microsoft.com in
the computer’'s memory. If you want to visit Microsoft's home page again, click your
mouse inside the address bar text field and begin to type the address for Microsoft
again:

P
& MSN.com - Windows Internet Explorer
@ ad = |\“ www.micral - |
. . http:/ fwww.microsoft.com/ Shift + Enter
5.p Favorites
History v
% MSN.com Internet Explorer 8: Features http:/ fwww.microsoft.com/windows/internet-expl..,
Mom Loses Windows T: Security software providers http:/ fwww microsoft.com/windows/antivirus-part...
See how Windows 7 features will make using a P... http:/Swww.microsoft.com/windows/windows-7/f...
Compare editicns http:/fwww.microsoft.com/windows/windows-7/c...
Welcome to Windows 7 http:/fwww.micresoft.com,/windows/windows-7
Goto " www.micro Enter
@ Hotm

Once you have typed the first few letters of the word "microsoft,” you will see a list of
possible matches listed below the Address Bar text field. Sure enough, Microsoft's
home page URL is the first item in the list. Click this entry or press Shift + Enter to
visit the site at the top of the list.

All URLs have something called a domain. It's usually the part of a URL that includes
the text .com, .gov, .net, etc. In the case of Microsoft, the domain is microsoft.com.
In the picture above, as we started to type the word “microsoft,” other Web sites in
the same domain that were visited in the past are shown here. Move your mouse to
one of the items in the list and click it to visit that particular site.

Accessing a Web Site via a Hyperlink

Nearly every Web site on the Internet features hyperlinks, which connect one Web
page to another. Normally a hyperlink is displayed like this. However, a hyperlink can
be displayed in any color and without underlining the text. (A picture can also be a
hyperlink.)

Thankfully, your mouse cursor can tell what a hyperlink is because it becomes a small
hand icon ({"J) when hovering over a link. Click the hyperlink to follow its path.
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Opening a New Window

If you want to view the weather or review some sports scores you can view each Web

page in its own Internet Explorer window.

To open a new Internet Explorer window, click the File menu and click New Window
the menu bar is enabled):

"E MSN.com - Windows Internet Explorer

l\,_./”\-._./‘l |v http:/fwww.msn.com/
m Edit View Favontes Tools Helg
Mew Tab Ctrl+T #
Duplicate Tab Ctrl+K

Mew Window Ctrl+M

Mew Session

Open... Ctrl+0

Edit

Save Ctrl+5

Save As... _

Close Tab Ctrl+W =
=15
Page Setup... Gu

Print.. Ctr+p  [9'

Print Preview...

Send 2
Import and Export...

Properties 2
Work Offline di

Exit

This will open a new browser window, indicated by a new Internet Explorer button

outline on the Taskbar:
k@l — 2|

It is important to note that the new window will open to the same Web site that you
were viewing when you opened the new window, not your home page. Simply click
the Home button in the Command Bar to navigate to your home page. You can also

(if

open a new Internet Explorer browser window by pressing Ctrl + N on your keyboard.

Hyperlinks also provide the ability to open a new browser window. When your mouse
is hovering above a hyperlink, right-click to display the hyperlink context menu. Click

Open Link in New Window to display the target document in a new browser window:
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City Guides Horoscopes
Dating & Open

Open in New Tab

Open in New Window
Save Target As... I’\\?
Print Target

R
La

Finally, you can open a new window from the Internet Explorer Jump List. Right-click
the Internet Explorer icon (or click and drag the icon up) and then click Internet
Explorer. This will open a new window:

Frequent

W' MSM.com
2 Add-ons Gallery - Web Slice

[ = =
= ' windows media center remote c...

.." windows media center remote c...
"7 Vista Media Center HTPC MCE U...
w# 15 ways to earn 5100 a month - ...
€| Custornizable courseware and tra...
E Microsoft Corporation

Foi MFL tearms up in play for new sp...
Tasks

¢ InPrivate

| Mew Tab

|& Internet Explorer |
o Unpin this pru:ugralr/'}?frnm taskbar
Close window
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Opening a New Tab

Internet Explorer 8 uses browsing tabs. These tabs let you open several Web pages at

once in one Internet Explorer window instead of opening several different windows.
You can open a new tab in one of two ways using Internet Explorer. Using the
Command Area, click the smaller tab found beside the opened tab:

-
€& MSN.com - Windows Internet Explorer

l'\,:..i'l l\...,r‘l |v http://www.msn.com/

|Fi|e Edit View Favorites Tools Help

ﬁ Favorites | {5‘, E Suggested Sites v @& | Get More Add-ons -

%* MSN.com

[ —
Cure YELLOW Teeth - & Secret Trick Mew Tab (Ctrl+T)

When you click the small tab, you will see a new tab that lets you select what you
want to do next (or type a new URL in the address bar):

55|~ | % MSN.com & New Tab x M- v [ =y v Page~
Reopen closed tabs ~ Browse with InPrivate
View tabs that you've closed since starting Internet Explorer. Browse the web without storing data about your browsing
1 sessian.

Reopen Last Browsing Session Open an InPrivate Browsing window

Use an Accelerator »

Show copied text

&3 Blog with Windows Live
& Map with Live Search

'?'l Search with Google

dy Translate with Live Search

Learn more about tabs and tab shortcuts, Accelerators, and InPrivate Browsing

You can also open a new tab by clicking File > New Tab, pressing Ctrl + T, or using
the link in the Jump List.

Open a web service with text that you've copied from a webpage.
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Using Tabs

Switching between tabs is easy: simply click the title of the tab you want to view. The
tab that is currently being viewed is identifiable by its darker blue color:

f\‘f Favorites | ‘1',;5 E Suggested Sites v & | Get e Add-ons =

2g |- | v MSMN.com

| @ Customizable coursew.., X |m Microsoft Corporation | |

To close a tab, click the X beside the currently active tab.

When many tabs are open at once, you will see this Quick Tab button appear to the
left of the tabs:

fata] WN.com | (€ Customi;

Click this button to see a thumbnail view of all open tabs:

p
€ MSN.com - Windows Internet Explorer

@Q @ |v http://www.msn.com/

5. Favorites ‘ 55 (@ Suggested Sites v & | Get More Add-ons v

I~ mm| l Y Y T — p - 5 »
‘S‘E iv ‘VMSN.com X }@Customizable courseware...}mMicrosoft Corporation ‘ ﬁ v & v & @ v Pagev Safetyv Tools~v @~

MSN.com X Customizable courseware and trainin... %

Microsoft Corporation X

Use the pull-down arrow beside the Quick Tabs button to browse opened tabs by
name:

x | {€ Customizable courseware .. | m Microsoft Corporation

oo|

o0

v

& Customizable courseware and training materials for computer training and HR skills training

Microsoft Corporation

Using Web Slices

Web Slices let you keep track of a certain Web site as it is updated. This saves you
having to open a new tab or window, re-typing the URL, and then looking for the

information. Web Slices are very similar to Favorites, only Web Slices can also let you
know when content is updated.
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In order to use Web Slices, the designer of the Web site you are visiting has to

implement them on their own servers. Web Slice-enabled pages will display the Web
Slice icon in the Command Bar:

X
MEIRE
LA
Add Web Slices (Alt+])
Get updates to content from this webpage on the Favorites bar.

EESI * Page~= Safety> Tools~ |@|v

Click the Web Slice button to see a message like the following:

— s

Internet Explorer @

i Add a Web Slice
I - Get updated Web Slice content from this webpage and view it from
your Favarites bar.

MSN.com Slideshow
http:/fwww msn.com.

What are Web Slices? [ Add to Favarites Bar l [ Cancel

Your computer will periodically check online for updates to subscribed feeds,
even when Intemet Explorer is not running.

Click Add to Favorites Bar to add this particular Web site to the Favorites Bar:

':é MSN.com - Windows Internet Explorer

@U - |v http://www.msn.com/
'ﬂ? Favorites '5",3 %" MSN.com Slideshow ~ @ Suggested Sites * & | Get More Add-ons =

90|+ | ¥ MSM.com % | Google

When new content is available, the item will become bold, as shown in the image
above. Click the Web Slice to see the new content:

[V MSN.com ST{eshow v] @ Suggested Sites v 2| Get |
E by :

‘We're Not
Worthy'

'‘Wayne's World' & more
'90s reunions we're, like,

ZICREREE

totally dying to see

< Previous

«» %3  http://www.msn.com/rss/ie8_slideshow.aspx

Click the blue arrow to visit the site or click the Refresh icon to check for new updates
for this Web Slice. To delete a Web Slice, right-click the Slice and click Delete.
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You can also add Web Slices by exploring the web page. Move your mouse around the
page. If you discover Web Slice content, a green border will appear around the
content and the Web Slice icon will appear on the left:

Grammar Got
You Scared?

10 secrets to finally
getting it right

< Previous ) Next =

Click this green button and then click Add to Favorites Bar to add the Web slice.

4.4 Windows Live

Before we can go forward with Windows 7, we first must go back to the past. In 1996,
Microsoft introduced a free Web-based e-mail service, HoTMaiL. The odd name
emphasized HTML (HyperText Markup Language), the language that is used by Web
browsers to display content from the internet. HoTMaiL became Hotmail, which then
became MSN Hotmail, which is now known as Windows Live Mail and/or Hotmail.

Previous versions of Microsoft Windows all included an e-mail client, a program which
was configured to send and receive e-mail. You may recognize the name Outlook
Express (used in Windows XP) and Windows Mail (used in Vista). At this point in the
manual, we would normally discuss how to use this e-mail client, except Microsoft
hasn’t included an e-mail client with Windows 7. Instead, you have the option to
create a personal ID to use Windows Live services. This ID is free to use. Windows
Live is also much more than just e-mail. In this lesson we will explore how to create a
passport, use the different Windows Live services, and create a free e-mail address.

What is Windows Live?

Windows Live is a collection of free services provided by Microsoft to anyone with
Internet access. Here’s just a sample of the services available through Windows Live
at the time of publication of this manual. As you can see, nearly everything is
interconnected and sharing of information in encouraged with other Windows Live
users:

Windows Live Alerts you about information and new e-mail in your
Alerts Windows Live Mail account.

Windows Live Time management software that lets you set

Calendar appointments, set reminders, and share your calendars.
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Windows Live
Essentials

Windows Live
Events

Windows Live
Gallery

Windows Live
(Hotmail)

Windows Live
Messenger

Windows Live
Photo Gallery

Windows Live
Spaces

Windows Live
Toolbar

Windows Live
Writer

Mail

A suite of Windows Live Applications that you can download
and use on your computer. We will explore these Essentials
briefly later in this lesson.

Plan and manage appointments using Windows Live
Calendar, Spaces, and Alerts.

A collection of third-party development applications for the
Windows Live family of services.

A free Web-based e-mail client used to send and receive e-
mail, manage contacts, and manage appointments.

We will explore Windows Live Mail later in this lesson.

A popular IM (Instant Messaging) chat program that lets
you see when friends and contacts come online. You can
use a webcam (a simple camera that connects to or is built
into your computer) that lets you make video calls to other
Windows Live Messenger users.

You may have been asked by a friend for your *"MSN.” This
means that the other person wanted your Windows Live ID
or e-mail address so they could chat with you online. Like
Hotmail, Windows Live Messenger used to be called MSN
Messenger. The easier-to-say "MSN” prefix has stood the
test of time.

We will use Windows Live Messenger later in this lesson.

Perform basic photo editing with your pictures before
uploading them to Windows Live Spaces.

A basic social networking site that lets you make blog posts
(like online journal entries), find people, and share
pictures.

A toolbar that adds itself to Internet Explorer’s interface.
This toolbar lets you quickly access Windows Live
elements.

A desktop blog publishing tool that lets you share journal
entries with other people.

Believe it or not, there are many more services offered, all for free. To further expand
(or complicate!) Windows Live, there are also a host of "mobile” services. These
mobile services are specially designed for cell phones, smart phones, and other
Internet-capable devices that have a small screen and limited usage compared to a

computer.

However, we’re only concerned with the basics of three items: Windows Live
Essentials, Mail, and Messenger. These three services are the most widely-used and
tie into almost all of the other Windows Live services.
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Keep in mind that Web sites and services offered by Microsoft can and do
change on a regular basis!

Before we dive into actually using Windows Live, we need to introduce the concept of
installing a program. We have learned that there are lots of different programs
included with Windows 7, but there are thousands of other applications and suites you
can install on your computer to play games, create desktop publishing pieces, create
video clips, perform financial operations, and more.

Programs can be installed in one of two ways. You can insert a CD, DVD, memory
card, or USB flash drive into your computer and install programs. You can also
download and install programs from online sources, as we are going to do in this
lesson. Every program is different in its own way, but installing a program is a fairly
standard operation: you launch the installation file, make changes to the way the
program installs, and then wait for the files to be copied or extracted from their
source and put somewhere on your computer.

In fact, you have already seen something like a program installation already when we
performed the initial setup of Internet Explorer 8.

Downloading and Installing Windows Live Essentials

You can download Windows Live Essentials in one of two ways. The first is to open the
Getting Started Center (which we covered back in Lesson 1.3) and click Go online to
get Windows Live Essentials. The second method is to open Internet Explorer, type
download.live.com into the address bar, and then press Enter. Click the Download
button in the Web page to get started:

-
€ Essentials - Windows Live - Windows Internet Explorer

_ N
@u @ ’:’ http://download.live.com v 2 | X
¢ Favorites | 31 @ Suggested Sites v & | Get More Add-ons v
£ Essentials - Windows Live fi v B v & @ v Pagev Safetyv Toos~ @~
£7 Windows Live™ Home Profile People Mail Photos Morev MSNY | Search People or web E Sign in [

Essentials

~y

One download, lots of great stuff L
English (English) %
Now in one installation, Windows Live Essentials gives
you instant messaging, e-mail, blogging, photos, and
more.

m

Clicking "Download" means you agree to the
Microsoft service agreement and privacy
statement. The download may include updates to
Windows Live programs you already have. You'll
get future updates to these and other Microsoft
programs from Microsoft Update. Learn more

———> oo
N

Stay in touch. With Messenger, you can chat, swap Use Photo Gallery and Movie Maker to edit and System requirements

photos, and see what's new with friends. Mail organize your photos and movies, and then post
brings together your Hotmail, Gmail, and other them online or send them to friends. Programs you can download include
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You will be directed to a download page and prompted to Run or Save the file. Click
Run to continue or click Save to save this file for later use. (We are proceeding by

clicking Run.)

£7 Windows Live™ Home Profile

Download instructions

Depending on your security settings, you might

1. I you see a message asking if you want

2. Ifyou see a message asking if you want s

Mail Photos Morey MSM ¥

People Search People or web

= =

0% of wisetup-web.exe from download microsoft.com C..

Getting File Information:
wisetup-web.exe from download.microsoft.com

Estimated time left:

tallation doesn't start rig
requirements, or click 1

gain

Bin downloads a standale
puter. This takes a little w

r, depending on your cc

Download to: File Dewnload - Security Warning
Transfer rate:
[] Close this dialog box wh Do you want to run or save this file?

MName: wisetup-web.exe
Type: Application, 1.08MB
From: download.microsoft.com

Run %‘J [ Save ] [ Cancel

i 'jl

= run or save this software. What 's the risk?

While files from the Intemet can be useful, this file type can
potentially ham your computer. i vou do not trust the source, do not

When you click Run, your screen might go dim for a moment while Windows 7
prompts you for your attention. This is an example of Windows’ User Account
Control (UAC) in action. UAC warns you that you are about to make a change to your
computer by installing this software.

Much of the information regarding UAC is beyond the scope of this manual, so click
Allow to continue. (Trust us; we won’t make you install something harmful!)

As the data downloads, you will see a window showing you the progress:

-

~
143 of wisetup-all.exe from download.microsoft.com CD...[ = X

o

wisetup-all.exe from download microsoft.com

7

Estimated time left: 7 min 45 sec (18.1MB of 133ME copied)
Download to:
Transfer rate:

[ Close this dialog box when download completes

Temporary Folder
254KB/Sec

SmartScreen Fitter checked this download and did not report any
threats. Report an unsafe download.

You can also see the download progress by looking at the green bar behind the

Internet Explorer icon:
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Ll
When the program finished downloading, you might encounter another UAC warning.

Click Yes to continue with the installation.

Next, you will be required to agree to the user license agreement and click Accept to
continue:

- ™
£7 Windows Live | = £2 |

Service agreement

To continue, please review and accept the Windows Live service agreement and privacy
statement.

Microsoft Service Agreement Last Updated: September 2008

LI

THANK YOU FOR CHOOSING MICROSOFT!
1. What the Contract Covers.

This is a contract between you and the Microsoft company referenced in section 29, Sometimes the
Microsoft company referenced in section 29 is referred to as "Microsoft,” "we,” "us”™ or "our”, This contract
applies to any Windows Live, Live Search, MSM, Microsoft Office Online, Microsoft Office Live or other
Microsoft software or services, induding updates, that display or link to this contract and that you use
while this contract is in force. All of the software or services are referred to in this contract as the
"service.”

Please note that we do not provide warranties for the service. The contract also limits our
liability. These terms are in sections 20 and 21, and we ask you to read them carefully.

El

View the privacy statement

@ This installation may include required updates to Windows Live programs you already
have. You'll get future updates from Microsoft Update. Learn maore

_’[ Accept ] ’ Cancel

Nearly every program has some sort of license agreement to read before you are
allowed to use the program. Most people don’t bother to read these because they are
long (and not what you would call exciting) legal documents. However, it is
worthwhile to skim over a license agreement and see just what you are agreeing to!

Now you can select which Windows Live Essentials you want to install. The list you see

may be different from what is shown below, but make sure that Messenger and Mail
have checkmarks beside them. Then click Install:

144



MS Windows 7 Foundation Manual

£7 Windows Live = | =) 2R

e —

Choose the programs you want to install

Click each program name for details.

=7 & Messenger Messenger

2 mail Send instant messages to contacts or groups, play
games, share pictures as you chat, and see what's
new with people you know.

v

OFRFERER &

# photo Gallery

&2 Toolbar
b writer Installed with this program:

) + Microsoft Application Error Reporting
8 Family safety « Microsoft Visual Studio Runtime
[~ Microsoft Office Outlook... + Windows Live Communications Platform
Cin + Windows Live Call

f Microsoft Office Live Ad...
B Movie Maker Beta

Space needed: 178 MB
Space available: 273 GB

—b' [ Install ] [ Cancel

As the components install on your computer, you can see the overall progress of the
installation and learn a bit more about Windows Live:

i =
£7 64% complete - Windows Live =1

e ———

We're installing your programs

Sign in for more

To get the most from your new programs,
sign in with your Windows Live ID.

If you use Hotmail, Messenger, or Xbox LIVE,
you already have a Windows Live ID. If not, it
only takes a minute to sign up.

Installing Installer...

Overall progress: 64% complete
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You have the option to install some extra features. Check or uncheck what you like
and then click Continue. (None of these options are required.)

£7 Windows Live = =] =R

You're almost done!

Please select your settings.

Set your search provider

Set Live Search as the default search provider in your browser, and prevent programs from
interfering with this choice. What's this?

[] Set your home page

Set MSN as your browser home page.

[[] Help improve Windows Live

Help us improve Windows Live programs by allowing Microsoft to collect information about
your system, and how you use our software. This data will not be used to personally identify
you. Learn more

Help improve search results

Help us improve our software by allowing Microsoft to collect additional data about your
system, how you use our software, and the web sites you visit. This data will not be used to
personally identify you. Learn more

The final step is to sign up for a new Windows Live ID. This username and password
will be your gateway to all things Windows Live. Click Sign Up to continue:

p
£7 Windows Live

£7 Windows Live —— l

Welcome to Windows Live!

Your new programs are in the Windows Live folder on the Start menu.

Do you have a Windows Live ID?

To get the most from your new programs, use your Windows Live ID to sign in.

If you use Hotmail, Messenger, or Xbox LIVE, you already have a Windows Live ID. If not,
it only takes a minute to sign up.

Sian

Internet Explorer will open and direct you to the next step in the Sign up process.
There are a large number of options here that are required in order to complete your
sign-in. Fill them in and click “I accept” to continue:
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@& velsoft_windows_7 @hotmail.com is
available.

Windows Live ID: yelsoft windows 7 @ hotmail.com -

| Check availability

Or use your own e-mail address

Create a password: gpessese

Retype password: gesessss

Alternate e-mail address: Sﬂmegne@cgmpan}rlcom

Or choose a security question for password
reset

First name: writing
Last name: pgerson

Country/region: United States -

State! pMassachusetts T

| strong |

Strong passwords contain 7-16
characters, do not include
commeon words or names, and
combine uppercase letters,
lowercase letters, numbers, and
symbols.

More about strong passwords

If you have entered all the information correctly, you will see the final confirmation
screen. You're ready to use your new Windows Live account!

" o - -
&7 Windows Live

Get started with Windows Live

Mext, sign in to any of the Windows Live programs on your computer using velsoft_windows_T@live.ca—it's your

Windows Live ID.

You can also use your new Windows Live ID to sign in to the Windows Live home page and get started with all of our

web services. Go to http://home.live.com.

©) 2009 Microsoft | Privacy | Legal

Windows Live Messenger

Help Central | Account | Feedback

By default, Windows Live Messenger starts when your computer starts. You will be
prompted to enter your Windows Live ID and password. The program will then
connect to the Internet and sign you in for usage with all of the different Windows

Live components.

To start Windows Live Messenger manually, click Start > All Programs > Windows

Live > Windows Live Messenger:
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. Startup

.. Windows Live
% Windows Live Call
§5 Windows Live Family Safety
fﬁ] Windows Live Mail

m

' Windows Live Photo Gal

conversations.

Enter your full Windows Live ID and password
into the fields shown at right:

Underneath the username and password
fields are a few check boxes which make
future logins easier.

If you check Remember me, Windows Live
will remember your username so you don’t
have to type it in every time you want to use
Messenger.

If you check Remember my password,
Windows Live will remember that for you as
well.

If you check Sign me in automatically,
then Windows Live Messenger will sign you in
as soon as you start the program.

These options are very handy if you plan to
use Windows Live Messenger in the future
and you are the only person who will use
your computer. If you share your computer
with other people who also use Messenger, it
is recommended that you don’t check
“"Remember my password” or “Sign me in
automatically.”

When you have made your choices, click Sign
in at the bottom of the window.

The Sign in procedure may take a few

22 Windows Live Messem_;;ell;{]':7 | Default Programs

| Windows Live Writer Shows whether your friends are online and lets you have online

Control Panel

Devices and Printers

Sign in
Sign in with your Windows Live ID,
Don't have one? Sign up.

velsoft_windows_7 @live.ca -

|
i

Signin as: B Awvailable -
[] Remember me
[ Remember my password

[ Sign me in automatically

Forgot your password?

) Sign in to Messenger
Privacy statement e Lo

minutes to complete depending on how busy the Messenger servers are.
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Remember, this is a free service! If you have trouble signing in, chances are things
are pretty busy on the other end. Try again in a few minutes and you probably won't
encounter any more trouble.

When you sign in, you will see the following two windows appear:

-
22 Windows Live Messenger E@ﬂ 22 Welcome to Windows Live Messenger S =

Some  (Available) ~

e Welcome to Windows Live Messenger

G~
Windows Live™ Messenger helps you
connect instantly and easily with the

G Welcome to Messenger
people you care about most.

You don't have anyone in your contact list yet. Add a contact

% Windows Live Messenger

All your friends, in one place G ’ l Mary,North' (avaiabie) *

You're not going to believe .. ¥

Adding new contacts to Messenger is easy—all

you have to do is add their IM or e-mail

address. You can even add your Yahoo! friends. [ gl B
Then drag the people you chat with the most "Add o contaxt...
into favorites so you can find them more easily. ey Create 3 group...

Add a contact today! Sroking (e, Croste a categury. .

|
” Y oy
wizge[[ ¥
¥ Join the i'm |n|t|at|ve and rnake every *
im
Ur h [ /r (l,

What's new No new activities from your contacts

Search for peagle..
Add people from other services.
conversation count. Join now
4

tyof  LEARN MORE ABOUT (
X BECOMING A PHOENIX

— i N éc l/'r’//(,d/ W share

CLICK HERE Your life. Your stuff. All together with Windows Live.

The window on the left is the main Windows Live Messenger window. This is where
you will see your name, profile picture, a list of your friends who are associated with
your Windows Live account, a short news feed about what’s going on with your
friends, and links to other Windows Live components.

The window on the right is the Windows Live Today window. When you sign in for the
first time, you can read some information about what Messenger does, current
promotions in the Windows Live community, and more. When you sign into Messenger
the next time and any time after that, you will see a quick news feed about current
world events, celebrity and sports news, local weather, and so on (similar to the
information you would see at www.msn.com). Windows Live Today is not vital to the
operation of Messenger, so you can close this window.

In order to properly g . E@l&‘
use Messenger, you'll 2o Windows Live Messenger ‘

need to add some
contacts. To add a
new contact, click the
button shown here
and then click Add a
contact. You can also Search contacts or the web 2 =
click Add a contact in
the main part of the
Messenger window:

Some (Available) ~

Share a quick message

& Welcome to Messenger [ Add a contact or group |

You don't have anyone in your contact list yet. Add a contact
J J J

/

Next, fill in the required information for your contact and click Next.
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- [r—
e

Enter the person's information o

Enter an instant messaging address, mobile device number, or both, When you add
somecne to Messenger, they also become part of your network on Windows Live,

Instant messaging address:
myfriend@live.ca

Example: example@live.com or example@yahoo.com
I

Mobile device number (for sending IMs as text messages):

[Select the country or region v]

|Addtos category Gelectone) ]

Addtoa cateioi (zelect one) I

[ Mext ] [ Cancel

Now you have the option to send your potential new contact a message. You can also
send an invitation e-mail to the other person if they aren’t yet a part of the Windows
Live network. Click Send invitation to continue:

——
=

Send an invitation

Include your own message (ocptional):

I'veljust installed Windows Live Messenger and [ need to add some contacts, Please add
el

This person will get your invitation when they sign in to Messenger.

Also send this in e-mail in case this person doesn't have Messenger yet

Send invitation

Click to add this contact and send an
invitation
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If the contact accepts your
invitation, you will see their
name in your contact list. You
will be able to contact them, but
only if they are currently
“online” - that is they are signed Search contacts or the web., & -~ BE Eﬂ -
into the Windows Live network

at the time. 43¢ Favorites (1/1

John ‘—

4 Groups (*

Create a group to communicate and share with the people you
choose

4 Available !

John <—

To send one of your contacts a message, double-click their name in your list of
friends. You will then see a chat window where you can interact with them:

0me 5ﬁable) v
Share a quick message ~ [ﬁ

Files Video Call Games Activities Invite

John (Available)

& Don't include information like passwords or credit
card numbers in an instant message.

9 G- @ ¢ A

Save big with the latest laptops deals from Dell. > Shop now

This chat window is pretty straightforward: there is a list of menus and actions that
you can perform with your friend along the top, your profile pictures and chat history
in the middle, and some extra interactive items at the bottom.

To send them a message, type something into the text field at the bottom of the
window and press Enter:
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(& John

Photos Files Video Call Games Activities Invite

John (Available)

R Don't include information like passwords or credit
card numbers in an instant message,

Some says:
= Hello

- F- @ v P @-

Save big with the latest laptops deals from Dell. > Shop now

When your friend writes back, you Some says: .
will see their message shown under « Hello
yours. Continue chatting back and John says:
forth by typing something into the « Hi - how are you?
text field and then pressing Enter: Some says: =
= I'm doing fine. Are you still open for that
That's as simple as it gets! Close concert on the weekend?
the chat window to end the John says: N
conversation when you have « Yes, I'll meet you at 8:30 at the bus stop. z
finished. Last message received at 10:38 AM on 8/12/2008.
Great'.|

O- O- & v P L A

If you know someone who has used Windows Live Messenger in the past, ask for their
permission to add them as a contact and chat with them about all of the different
features. If you get stuck, you have the best resource to help you: a real person on
the other end!

Messenger (and most other IM protocols that you can use on the Internet) lets you
change your status. Even though you may be signed into the Windows Live network,
you might be busy with something else or have gone away for lunch while you left
your computer on. You can change your status by clicking the pull-down arrow beside
your name in the Messenger window and selecting a new status:

152



MS Windows 7 Foundation Manual

25 Windows Live Messenger l = | (=] |_i:hl
—
SOME (Available) ﬂ
o B Available
B Busy
B Away

Appear offline

457 Favorit Sign out from here (VELSOFTWTURC-PC)

Change display picture...
- Johr
= Change scene...
Change display name...

4 Groups
Options...

Create a gr
choose

|
4 Available l

& John
|

If you do change your status to Busy, Away, or Appear Offline (you still sign in but
appear as if you are not signed in to your contacts), remember to change your status
back when you actually do want to chat.

We could fill an entire manual just with the different features of Windows Live
Messenger, but we need to move on. Don’t be afraid to explore on your own or ask a
more experienced friend for some more tips on using this handy program!

Using Windows Live Hotmail

Windows 7 does not include an e-mail client (a program you can configure to send
and receive e-mail). By using your new Windows Live ID, you do however have your
very own online e-mail account. In some ways, this account is easier to use than a
client installed on your computer because:
* The basics of the account are already set up
* You have lots of space for messages, including large messages with attached
pictures and other media (more on this in a moment)
= Because it is online and maintained by Microsoft, you can access it from
anywhere in the world where you have Internet access
= It's free!

You can sign into Windows Live Mail in one of two ways: online or through Windows
Live Messenger.

To sign in online with a web browser, type mail.live.com into the address bar and
press Enter. Enter your Windows Live ID information and click Sign in:
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£7 Windows Live

One Windows Live ID gets vou into Hotmail, Messenger, Xbox LIVE — and other places you see 3

Hotmail Sign in

Fowerful Microsoft technology helps

fight spam and improve security. 3 Windows Live ID: velsoft_windows_7@live.ca

(example555@hotmail.com)
l} Get more done thanks to greater ease

and speed. Password: sssssess

{ﬁl Enjoy 5 GB of storage that grows when Forgot your password?
vou need it. More cool stuff on the
way. Remember me on this

computer (7]
[[]remember my password (7]

Don't have a Windows Live ID?

Use enhanced security

More about Windows Live ID

Learn maore

Frivacy Folicy
22009 Microsoft Corporation  About  Privacy  Trademarks Account | Help Central | Feedback
As you can see, there’s a lot happening in front of you when you first sign in. But

don’t feel overwhelmed, because the basic layout of this page is similar to other
programs and folders we have seen so far:

T —
£7 Windows Live® Home Profile People Mail Photos Morev MSNv Search the web [<] Some~ i
sign out

Hotmail Mew | Get newsletters | Read our blog &2 Messenger v | Options+ @~
velsoft_windows_7@li...

Inbox (1) Hi, Somel! Wednesday, August 12 | Search your e-mail b |

Junk You have ever-growing storage. Learn maore

Drafts ; i .

‘L personal signatures automatically add your contact
Sent information (or anything else) to every message you send.
Deleted

Manage folders  \Arhat's new with your network

Add an e-mail . )
Favorites | Surprise me

account

People in your network haven't done anything new lately.
What's this? | Add people to your network

Want to start with your inbox? To skip the Today page when you
sign in, change your settings.

Birthdays
% Add your birthday so we can remind all the folks in
Related places your network when the big day is.

Today

Contact list

Calendar ,ﬁ ?f ‘—% %
nsr msn"'

Privacy >
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At the top are a number of options to visit the different areas of the Windows Live

network, a place to search the Internet using a search engine, and options to change
your Windows Live account settings.

In the middle there is a small news feed about your current e-mail status and other

happenings in the Windows Live network. However, the list on the left is what we are
most concerned with. Here is where you can access your e-mail account.

There are five default folders associated with your e-mail account. Before we get into
sending and receiving e-mails, let’s see what these folders mean:

Inbox

Junk

Drafts

Sent

Deleted

All new e-mail messages sent to you will appear here. If you
have new messages, the folder will appear bold with a number in
parenthesis, like this: Inbox (5). As you can see in the picture
on the previous page, we have already received one e-mail! We'll
look at it in @ moment.

Junk e-mail is an unfortunately reality associated with the
Internet. These e-mails are usually advertisements for anything
and everything, can sometimes appear by the dozens, and are
fake 99% percent of the time. The best advice we can offer when
you inevitably encounter junk e-mail is to ignore it and use
common sense. If you have never heard of the sender before or
have no idea what they are talking about, be very cautious.

Most e-mail programs/clients (including Hotmail) have very good
ways of detecting junk e-mail and will automatically move new
messages that are considered junk into this folder. However,
don’t rely 100% on this feature. Sometimes legitimate messages
are treated as junk and vice versa. Again, we encourage you to
use common sense. If it's too good to be true or completely
incomprehensible, just leave it alone.

Hotmail automatically deletes messages in the Junk folder every
few weeks.

When you write a new e-mail message, you don’t have to send it
right away. You can save the e-mail as a draft in this folder and
then come back later to finish it and send it to the recipient.

A copy of every e-mail you send is stored here.

This folder works like the Recycle Bin. If you delete an e-mail
message, it isn’t actually deleted; it has been moved to the
Deleted folder. Be cautious, however; messages that end up here
are permanently deleted after a few weeks.
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Click the Inbox folder to view any messages you have received:

T ——
£7 Windows Live™ Home Profile People Mail Photos Morev MSMv Search the web (_-‘| Some~ ‘
Sign out
Hotmail New | Delete Junk | Markasv Movetov | 620 & Messenger v | Optionsv (7
velsoft_ windows 7@liveca | [[] Sort by » | Search your e-mail p |
Inbox (1) Wind Live Hotmail Mem... 1:54 P B i
| | ) 2 Windows Live Hotmail Mem No message is selected =

Getting started with Windows Live Hotmail

Junk Click any message to view it in the reading pane.
Drafts Attachments, pictures, and links from unknown
senders are blocked to help protect your
Sent .
privacy and safety.
Deleted

To show messages automatically when you
. select a folder, change your reading pane
Add an e-mail account seftings

Manage folders

m

Messages in bold are new arrivals or haven’t been opened yet. To open a message,
just click the message title from the list of messages in the middle. The message will
open in a preview area to the right of the list of messages:

[ Sortby« Search your e-muail D

I £2 Windows Live Hotmail Member.. 1:54 PM | Reply Reply all Forward = & 4 Eull view
Getting started wh_/Windows Live Hotmail

Getting started with Windows
Live Hotmail

From: & Windows Live Hotmail Member
Services (member_services@live.com)
Sent: Wednesday, August 12, 2009 1:54:18

m

PhA
To:  velsoft_windows_7@live.ca
£7 Windows Live™

Welcome to Hotmail.

Windows Live Hotmail® is faster and safer
than ever before and filled with new ways to
stay in touch. Storage space* that grows with

you means you shouldn't have to worry about
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To compose a new e-mail message, click the New link at the top of the Hotmail
window:

£7 Windows Live™ Home Profile Pec

Hotmail Mew | Delete Junk | M

velsoft_windows_7 @live.ca }T??rite a New message h
Inbox I_ Windows Live F

E-mails have four basic parts:
= A From field; your e-mail address
* A To field; enter the e-mail address of your recipient (or recipients)
= A Subject; a short explanation for the recipient knows what the e-mail is about

= A body; the actual message you want to send

Once you click New, you can compose your message:

From: velsoft windows 7 @live.ca »
someone@company.com someaone_else@company.com
Subject: | TPS Reports
A B2 5

=
I
[l
il
1
i
18
“nr
¥
]
b 2
=
il

&4 53 [ Verdana v | 10~ B I

Hi everyone

A friendly reminder that all TPS reports need to have title pages.
Thank-you for your understanding.

Your friend,

The Boss|

Once your message is complete, click Send at the top of the browser window:
£7 Windows Live™ Home Profile People

HDtma” Save draft Attach

velsoft_windows_7 @live.ca + velsoft windaow

Junk :
Subject: = TPS Reports
[ P

E-mails can include attachments. Attachments are supplemental files that provide
the recipient with extra information about your message. For example, if you have
created a draft meeting memo in WordPad and want to pass it around to the meeting
participants, you can attach the file to an e-mail message and then sent it to

everyone.

Many people also add pictures or Microsoft Office PowerPoint presentations to e-mails.
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To add an attachment, click the Attach command at the top of the message:

Send | Save draft Affac Spell check Rich te:

Iive.ca v
someone@company.com

Subject: | TPS Reports

From: wvelsoft_wi

This will open a window where that you can use to browse your computer and locate
the file to attach. Select the file to attach and then click Open:

F - .
&7 Windows Live™

Hotmail

velsoft_windows_7 @live.
Inbox
Junk
Drafts
Sent
Deleted

Manage folders

Add an e-mail account

Related places
Today
Contact list

Home Profile People Mail Photos Morev MSNw |Search the web (_-‘| So

.
@ Choose File to Upload M

@Qv| N >_MeEting Memo = |‘?|
Organize » New folder =~ 0 @

Search Meeting Memo 2 |

¢ Favorites Mame Date modified Type Size

Ml Desktop 5| draft memo 8/12/200912:41 PM  Rich Text Document
4 Downloads

= Recent Places

L pics

m

= Libraries
@ Documents
J? Music
[E5] Pictures
B videos —

- Computer
5._?, Local Disk (C:) = 4| T ¥

File name: draft memo v [AnFies -

| Open {}J[ Cancel |

=i

t

B

—

The attachment will upload itself and then be listed underneath the subject line of the
message. You can repeat this process as many times as necessary until you have
attached all files you need or filled up the 10 megabytes of available space:
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Send | Save draft ;;-ttaché Spell check Richtext» | ¥ L | Cancel

From: wvelsoft_windows_7@live.ca »
someocne@company.com someone_else@company.com

Subject: | TPS Reports
M Total size: 0.2 KB of 10.0 MB

draft memo.rtf (0.2 KB) ‘—

& 53 @ Verdana | 10+ |B|I U

i
il
Il
e
[11
sen
11
TEA]
"I
¥
m
i
b
il

Hi everyone

A friendly reminder that all TPS reports need to have title pages.

We’'ve come a long way since the beginning of the manual! By now you should be
comfortable with navigating around your computer, familiar with using the programs
included in Windows 7 to get things done, and hopefully had a bit of fun using the
Internet and Windows Live.
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Chapter 5: Getting Help in Windows 7

In this chapter you will learn how to:
* Launch Help in different ways
Recognize the different parts of Help and Support
Search for a Help topic
View Windows tutorials
Navigate through the Help file
Use the table of contents
Print a Help topic
Ask for help with Remote Assistance
Set Help options
Recognize the difference between online and offline help
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5.1 The Basics of Help

Windows 7 was designed to be intuitive and visual-driven so even someone who has
never used a computer before can find their way around, once they understand how
to interact with the keyboard and mouse. Many features and commands in Windows 7
will give a brief explanation or name of the command to help you out.

Launching Help from the Start Menu

Windows 7 bases all of its help files in one place: the Help and Support Center. Click
Start > Help and Support to open the center:

@ viagnirier
§1 Default Programs

m WordPad (T
— Help and Support

» Al Programs k T

Find Help topics, tutorials, troubleshooting, and other support services.

’7 Search programs and files 7 | Shutdown | > | IA_;

Windows Help and Support
= C(Click Start > Help and Support
= Contains a complete help file for all of Windows 7. Help and Support can
be used offline (local help content) or online (checks with Microsoft to
see if there is new or edited help content).

At the top, there are Back and Forward buttons, some other commands, and a search
text box. (Does this look familiar?) The Windows Help and Support Center was
designed for quick usage. Type a word or term into the search text box and press
Enter.

In the middle, there are three links that you can follow to find out more about the
basics of Windows 7 and using your computer. At the bottom, there is a link to visit
the Windows 7 Web site and a place where you can switch between Online and Offline
Help.

Launching Help from within a Windows Application

Each program is different in its own way, but most desktop applications have a Help
file that is accessible in more or less the same way. You can usually open this file by
pressing F1 on your keyboard, clicking Help - Contents, or Help = Help Topics. You
should also be able to open Help by clicking the help icon in the window, which usually
looks like a question mark:

@
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For example, here is WordPad'’s Help file:

'l ™y
0 pandows Help o SUPPDFA @ﬂu

@ ) m - il Ak Options
| Search Help 2|
Using WordPad H
WordPad is a text-editing program you can use  In this article
to create and edit documents. Unlike s Create, open, and save
Motepad, WordPad documents can documents

include rich formatting and graphics,
and you can link to or embed objects,
such as pictures or other documents,

Format documents

Insert dates and pictures
to decumnents

View documents
Change page margins

Print documents

- 7 m— —— —_— o ¥ P
U Calibsii il = & A e &E = - __} [— Y e
——— —a P
Faste B S O aa o #-A- [IEE 3 W 5| Deand Pidue Fank
- L [ drawing
Chpbastd Fant Parsgracs Inee
dg o e 8

& More support options

€0 OnlineHelp ~

You can read the Help file from start to finish or click one of the links on the right to
jump to a section of the document. When you are finished with the Help file, just close

the window.

Overview of the Help and Support Window

The top of the window features the standard Back and Forward navigation buttons as
well as some other commands and a search text box:

-
0 Windows Help and Support

o © ® < W ﬁ Ask Options B

l Search Help

ol

The commands on the right side of the screen provide quick links to different features

of help:
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Home

Print

Table of
Contents

Ask
Someone

Options

@ This will return you to the main welcome screen of
’ the Help and Support Center.

This will print the current help topic on your printer.

=

il This command will let your view the contents of the
entire Windows help file.

§' Ak You can request assistance with a problem with this

link. This enables you to allow another user to use
your computer from a remote location, post or ask a
guestion online, or contact Microsoft’s technical
support.

You can change the size of the text on your screen,
find a certain word or phrase on the current page, or
opt into some Customer Feedback Programs.

Searching for a Help Topic

When you first open the Help and Support Center, you can enter a search term into
the search text box and press Enter. You will then be shown a list of matching search
results. For example, if we search for “hard disk,” we are presented with a number of
topics related to the term:

( (g Windows Help and Support @M‘
@ >/ @ - il i&_% Ask Options -

| hard disk Ll

Best 30 results for hard disk
1. "Install or remove a hard disk drive”
2. "Create and format a hard disk partition”

3. "Delete a hard disk partition"

4, "Improve performance by defragmenting your hard disk”

5. "Can I repartition my S.:;)d disk?"
6. "Convert a hard disk or partiticn to NTFS format”

"Convert a hard disk or partition to FAT32 format”

@, Maore support cptions

6 Online Help -

Click one of the links to read the associated article. Remember you can use the Back
and Forward buttons to navigate, click the Home button to return to the opening
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screen, or just type in a new search term into the text box to look up information on
something else.

Often in the Help files there are links to open a program or feature in Windows. For
example, the link in the image below opens another program in Windows where you
can perform an action:

@ g,; i] _§' Ask Options

[hard disk 2|

Improve performance by defragmenting your hard disk

Fragmentation makes your hard disk do extra work that can slow down your
computer. Removable storage devices such as USB flash drives can also become
fragmented. Disk Defragmenter rearranges fragmented data so your disks and drives =
can work more efficiently. Disk Defragmenter runs on a schedule, but you can also
analyze and defragment your disks and drives manually. To do this, follow these
steps:

1. = Click to open Disk Defragmenter.

2. Under Current status, select tha\gisk you want to defragment.

3. T? determine if the disk needs to bedfif rw Disk Defragmenter
disk. * If you are prompted for an adm =
type the password or provide confirmati

> Disk Defragmenter consolidates fragmented files on your computer's hard disk to improve system

Once Windows is finished analyzing the + performance. Tell me more about Disk Defragmenter.
of fragmentation on the disk in the Last
above 10%, you should defragment the Schedule:
@ More support options = 5
Scheduled defragmentation is turned on [ % Configure schedule...

Run at 1:00 AM every Wednesday

Next scheduled run: 8/19/2009 1:49 AM
Current status:

The help file also includes some text written in green. These are definitions that
describe a bit more about the more technical aspects of a computer. To read a
definition, click the green text:

Improve performance by defragmenting your hard disk

Fragmentation makes your hard di_%lﬁ do extra work that can slow down your cc

hmen
The primary storage device located inside a cornputer. Also called a hard |z g ;

drive or hard disk drive, it is where your files and programs are typically | thes
stored.
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Ask Someone

The Ask Someone section of the Help and Support Center gives you three main

options:

Windows
Remote
Assistance

Windows Remote Assistance allows another Windows 7 user to
connect to and control your computer through the Internet. They
have full access to the mouse and keyboard, and can control any
aspect of your computer.

Click the Use Windows Remote Assistance link, and select if you
are requesting help or are offering to help:

N L Windows Remote Assistance

Do you want to ask for or offer help?

Windows Remote Assistance connects two computers so that one persen can help troubleshoot or fix
problems on the other person's computer.

= Invite someone you trust to help you
Your helper can view your screen and share control of your computer.

= Help someone who has invited you
Respond to a request for assistance from another person.

Read our privacy statement online

Cancel

=

If you require help, you can send an invitation e-mail to another

user. If you are offering to help, you can browse your computer for
the invitation file the other user has given you in order to connect.

You can also connect to a computer via the computer name or IP
address (electronic address of the physical computer).
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Microsoft
Answers

Computer
Manufacturer/
Microsoft
Customer
Support

Clicking this link will launch Internet Explorer and open the

Microsoft Answers Web page. This page is a special forum where
people can ask and answer different questions related to Windows.

Use the search bar at the top of the Web page to search for

relevant results to your question, or use the find list on the left to

browse through the available topics:

United States - English Microsoft.com ‘Welcome

ol web

w.j Connect with Microsoft
* and others in the

WindowsVista' Answers Forums,

. Getting Ready for Windows 7
rowse tOD answers.
[“ Top Microsoft Resources

Home Windaws 7

8 Top Answers in the Forum 3]

Getting Ready for Windows 7 Forum IT Pro or technical expert? Check out

Uninstalling Windows 7 RC the Windows 7 Springboard Series
What happened to Windows Mail? 1
can't find it in Windows 7277

Will Photo Gallery and Movie Maker be
included in Windows 77

&Y

tl
..g Appearance and Personalization
Don't lose your data! Get tips for

Gaming backing up your PC

a Hardware and Drivers See what's new in Windows 7

B 1mprove Performance More...
Windows 7 looks cool, should I install

&9 Install, Upgrade, and Activate the Release Candidate?

Sign in

@ 1nternet Explorer

i, Programs

F Security and Privacy
N Sound and Media
Wireless and Networking
Windows Update

weamo  GEMting Ready for Windows 7

What's the best way to back up my
pC?

Will the Win7 beta automatically
update to the Release Candidate?
How long can 1 use the Windows 7
beta?

What does "clean installation” of the
RC mean?

Does testing Windows 7 get you a free
copy of the real thing?

Get Help Now

Contact support by E-mail, Cnline, or
Phone
Find Compatible Devices &
Applications
Visit the Windows Vista Compatibility
Center
Help us Improve

Give feedback

You can also sign into Windows Live using this page.

This link provides contact information for a wide variety of
computer manufacturers as well as information on how to get in
touch with Microsoft.
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5.2 Using Windows Basics

Choosing a Preset Topic

Open the Help and Support Center and click Learn about Windows Basics:

Mot sure where to start?

= How to get started with your computer

m |earn about Windows Basics

= Browse Help topics

There are six topics to choose from:

Learn about your These topics start right from the ground up by describing
computer the different parts of a computer, how to use your mouse
and keyboard, and how to properly turn off your computer.

Desktop The parts of the desktop, Start menu, Taskbar, Gadgets,

fundamentals and other standard features are all covered here. You can
also learn how to control a window and how to interact with
the various bars, buttons, and menus in Windows.

Programs, files, This section talks about how to use different programs like
and folders Paint and WordPad, techniques for working with files and
folders, and an introduction to printing with your computer.

Internet and e- Topics here include an introduction to the Internet and

mail Internet Explorer. You can also view topics to become
familiar with the basics of computer security and wireless
networks.

Pictures and Read more here about how to have a bit of fun with your

Games computer by working with pictures and playing games.

Help and Support These topics introduce how to use the basic help
functionality of Windows and how to take advantage of the
accessibility features (for people who are differently-abled).

Choosing Subtopics

Click any of the links in the different sections to read more about a topic:
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Programs, files, and folders
& lsing programs

& Waorking with files and folders

& Getting started with prir‘lti{ﬂ
& (Getting started with Paint

The subtopic will then open in the same window so you can read more:

Getting started with printing

You can print almaost anything with Windows: documents, pictures, In this article
webpages, or e-mail. » Buying a printer

This article is designed to introduce new computer users to  Connecting your printer
common printers and the basics of printing in Windows, * Printing in Windows
Buying a printer

Printers you encounter on store shelves are usually grouped into three categories. These are the most
commaon types of printers sold for home or office. Each technology has pros and cons.

Inkjet printers
What's DPI?
Inkjet printers squirt srnall dots of ink onto the page to reproduce text

and images. Inkjets are popular because they're relatively inexpensive,
There are also many meodels to choose from, including ones designed
specifically for printing color photos,

DPI, or dots per inch, is a
rmeasure of a printer's
resolution. DPI

The downside? Inkjet printers are often slower (measured in pages-per- determines how crisp and

minute) than laser printers and require regular ink cartridge changes. detailed your document
or picture will appear. It's

an important
consideration when
buying a new printer.

Moving Back and Forward

As you search for a topic or for your own interest, you may find you have gone too far
ahead, too far back, or have simply traveled down a wrong path. Click the Back
button to go back to the previous page in your history or the Forward button to
retrace your steps if you have clicked the Back button.

You can also click the Home icon or the book icon to visit the welcome page or table
of contents, respectively:

@ @ m - m ﬁ% Ask Options -

t 4

168



MS Windows 7 Foundation Manual

Printing a Topic

If you come across a particularly helpful or complex topic, you might want to print a
hard copy so you have something quick and easy to refer to. Simply navigate to the
topic you wish to print and then click the Print icon:

i ™y
(&3 Windows Help and Support EIM
= i~ o :
xe XA
| hard disk P

Getting started with printing

[ »

m

You can print almost anything with Windows: documents,  In this article

pictures, webpages, or e-mail. s Buying a printer

This article is designed to introduce new computer e Connecting your printer
users to common printers and the basics of printing ® Printing in Windows

in Windows,

This will open the Print dialog box. Select your printer from the list and then click
Print:

'
e Print - ﬁ
Gereral | Options

Select Printer

% Add Printer 5 Snaglt &
=i Fax
=0 Microsoft PS5 Docurmnent Writer

1 | 1] [ 3

Status: Ready [ Print to file

Location:

‘||  Comment: l

i Page Range
1 @ Al Mumber of copies: 1
Selection Curment Page

L L

(") Pages: 1 Collate

Erter either a single page number or a single _]_)ﬂ _2)2 jﬂ

page range. For example, 512

Print k])[ Cancel || Apply |

|
. k] g
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5.3 Using the Table of Contents

The Table of Contents gives you access to the entire Windows 7 help file. There are a
broad range of categories to help you find the answer to nearly every Windows
feature.

Opening the Table of Contents

Click Browse Help Topics in the Help and Support Home screen or click the blue book
at the top of the window:

i B’
Windows Help and Support E@g

P ppo
G U P o W B o s

| hard disk + 2|

p Find an answer quickly
& Enter a few words in the search box above,

Mot sure where to start?

m How to get started with your computer

m Learn about Windows Basics

= Browse Help tCEif ‘—

More on the Windows website

& My Check out the Windows website, which has more information,

Choosing a Topic
To select a topic, simply click the book icon containing the topic information you are

interested in. Each book icon acts like a category, and each category has its own
topics:
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i ™
(§d Windows Help and Support El&lg
@ ) m mﬁ' m ﬁ Ask Options =

| hard disk 2|

AllHelp » Internet — going online and using the web

Topics ‘—

7

|22] What do [ need to connect to the Internet?

7

2g] Cennectto the Internet

25| What is an Internet Service Provider (ISP)?

Categories "—

' Setting up an Internet connection
' Connecting to the Internet with mebile broadbkand
' Browsing the web with Internet Explorer

' Troubleshooting Internet connection problems

g_i. More support options
€ Online Help ~

Choosing a Subtopic
A single topic inside a category looks like a small page from a book. This indicates that

you have reached the lowest level in this path and this topic does not contain any
subcategories.
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r@ Windows Help and Support -D-Ehg‘
@ @ @ = ﬂ _6.% Ask Options

[ hard disk ol

What do I need to connect to the Internet?

You need an Internet service provider (ISP) and some hardware to connect to the Internet.

& ISP. An ISP provides access to the Internet. You sign up for an account with an ISP just as
you do for telephone service or utilities,

o Hardware. For a broadband connection, such as Digital Subscriber Line (D5L) or cable,
you need a D5L or cable modem. This might be included as part of the start-up hardware
from your ISP when you sign up for a broadband account. If you plan to set up a network
in order to share Internet access with multiple computers, you'll also need a router. For a
dial-up connection, you need a dial-up modem. Many computers come with a dial-up
modem already installed.

For more information, see Connect to the Internet.

Was this helpful?

| Yes | No |  Somewhat

Read the privacy statement online
l:@, Muore support options
€ OnlineHelp ~

You can also rate the helpfulness of each topic you read. Microsoft records the number
of helpful, unhelpful, and somewhat helpful topics that people report. If many people

report an unhelpful topic, this particular help topic will likely be updated at a later
date.

Moving Back and Forward

You guessed it — the navigation buttons at the top of the page will move you
backwards and forwards through the path you have followed in the Help and Support

Center. You can always click the Home button or use the Table of Contents to jump to
a particular topic.

@ @ @ - ﬂ g% Ask Options -

P44

Printing a Topic

If you want a paper copy of a help topic, open any topic of interest to you and click
Print:
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g Print =
General | Options

Select Printer
% Add Printer % Snaglt 8
= Fax
=0 Microsoft XPS Document Writer
1 | i [ 3
Status: Ready [ Print to file
Location:
! Comment: '
Page Range
@ Al Mumber of copies: 1 =
Selection Curment Page
(7 Pages: 1 Collate
Erter either a single page number or a single 111 212 313

page range. For example, 512

| Prnt “U Cancel || Apply |

|
e k'] _1

Choose the printer or printing service you want to use, specify the number of pages
and copies, and then click Print.

5.4 Advanced Help and Support Tools

Remote Assistance

Remote Assistance is like a virtual link between two computers. The host sends an
invitation to another user who in turn connects to the host’s computer. The other user
then has full control over the keyboard and mouse on the host computer. You can ask
for help from another Windows 7 user or offer to help someone else.

Let’'s examine the steps needed to invite someone to help you. First, launch Windows
Remote Assistance by clicking Start - All Programs > Maintenance - Windows
Remote Assistance:

) Games

Control Panel

. Maintenance
;@ Backup and Restore
Iy Create a Systern Repair Disc
® Help and Support Default Programs
.-E.nWindows Remote Assistance [
;M m}su:uft Office Help and Support

Invite a friend or technical support person to connect to your computer and

help you, or offer to help someone else,
|

Devices and Printers
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Windows Remote Assistance
» Click Start - All Programs > Maintenance -> Windows Remote
Assistance
* This program lets you invite another user to share your computer and
help you. You can also provide help to another person.

Click the top option to invite someone to help you:

' | EE

{ \ F - -
o) L Windows Remote Assistance

Do you want to ask for or offer help?

Windows Remote Assistance connects two computers so that one persen can help troubleshoot or fix
problems on the other person's computer.

< Invite someone you trust to help you
Your helper can view your screen and share control of your computer. Ib

You now have the option to send an e-mail invitation in one of two ways. You can
send an invitation file to another person using a Web-based e-mail service like
Hotmail or you can send it via a third-party e-mail client you have installed on your
computer.

Remote Assistance invitations are capable of being accepted and used by people who
use Windows Vista and Windows 7.

The third option is to use Easy Connect. This is a new protocol that lets two Windows
7 users share information more easily, but this feature is beyond the scope of this
manual.

We will click the first option to continue with this example. This will open a Save
dialog that asks you to save the invitation file somewhere on your computer. You can
save it wherever you like but we recommend the Desktop because it is probably the
easiest place to find a file:
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@ L Windows Remote Assistance

How do you want to invite your trusted helper?
p
> Save As
@vvll Desktop » v | 4 ’ I Search Desktop
Organize ¥ New folder B v @
\ . Pa o ]
A Favorites M " | Libraries Velsoft
Bl Desktop —= || System Folder & System Folder

4 Downloads

=] Recent Places  \ f Computer | Network
s £ = System Folder | System Folder
. pics <

n

- l Exercise Files
“?:(\leranes | File folder
|°5] Documents | 4 '
& Music
[&=] Pictures
E Videos

-~

File name: Invitation -

Save as type: | RA Invitations (*.msrcIncident) v}

. Hide Folders Save Cancel ]

Click Save to save the file.

Once the file has been saved, Windows Remote Assistance will open and present you
with a password, like this:

-

o Windows Remote Assistance | = | = 2 |
Eﬁ- . Chat F Settings Troubleshoot @ Help
[FVERtIOT) Give your helper the invitation file and password
ZM4V5P24NQMT
@ Waiting for incoming connection...

Windows Remote Assistance will wait until you have e-mailed the Invitation file to
someone else. Don’t close Windows Remote Assistance! If you do, you’ll have to
follow this process again to create a new invitation and password.

When they open the file, they will require the password that Windows Remote

Assistance has given you. You can send the password via e-mail, call them on the
phone, or use some other method (such as Windows Live Messenger).
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Setting Help Options

In the upper right-hand corner of the Help and Support Center you may have noticed
one final menu: the Options menu. This menu offers options to make using Help and
Support easier:

=
W Ask |Options

Print...

ﬁ

. Browse Help

Text Size

Find {on this page]...
Settings...

Print This option will print the currently displayed topic.

Browse Help This option is a link to the table of contents for Windows 7.

Text Size If you are having trouble reading the help file because the text is
too small (or too big), use the sub menu to adjust the text size:

|
W Ask |Options ~

Print...

= Browse Help

Text Size »

Largest
Find {on this page]... Larger

Medium

Settings...

Smaller

Smallest
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Find If you have used the search bar to look for a particular
keyword, use the Find option to easily pinpoint the place in the
help topic where the keyword was found. Every instance will be
highlighted!

|w

[=[=] = ]

@ Windows Help and Support
A i) %, -
@ &) ® > i] 3% Ask Options =

|windows defender pl

Using Windows Defender

Windows Defenderis Eﬂtlm software that's included with Windows and runs automatically
when it's turned on. Using antispyware software can help protect your computer against
spyware and other potentially unwanted software. Spyware can be installed on your computer
without your knowledge any time you connect to the Internet, and it can infect your computer
when you install some pregrams using a CD, DVD, or other removable media. Spyware can also
be programmed to run at unexpected times, not just when it's installed,

Windows Defender offers two ways to help keep spyware from infecting your computer:

» Real-time protection. Windows Defender alerts you when spyware attempts to install
itself or to run on your computer. It also alerts you when programs attemnpt to change
important Windows settings. -

Find ﬂ for spyware that might be

asis, and to automatically

Find:  spyware
date definitions. Definitions are
[ Match whole word only [ Match case are threats, Windows Defender
Highlight all matches t software detected is spyware

N itions up to date, Windows
ew definitions as they're
r updated definitions before

rate and hoe tnomanoalhe

@ Online Help ~

Settings You can choose to browse the online help file as well as the
local Windows 7 help file for answers to your questions. You
can also opt into the Help Experience Improvement Program,
which is designed to anonymously send information about your
search topics to Microsoft. This data is then used by Microsoft
to better suit the help file to the types of questions people are
asking:

@ Help Settings

Help Settings

Search results

hﬂ'mremymmjlsbyusingodiml-lelp

We update Help frequently. To see our latest content, select
this check box.

Help Experience Improvement program

[¥] Join the Help Experience Improvement program

By participating you can help us improve the quality and
relevance of your Help experience. The information
collected is not used to identify or contact you.

Read the privacy statement online
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Online vs. Offline Help

At the very bottom of the Help and Support Center is

a combo box used to select whether you would like -
online or offline help. Online help requires an Internet
connection, but will contain the most up-to-date
information. Offline help is faster to search, but you
might not be getting complete or accurate
information if changes are made to the Windows 7
operating system and Help file in the future.

@' COnline Help
@  Get online Help
Get offline Help

Settings...

The Settings link prompts you for the same information as the Settings option in the
Options menu.
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Chapter 6: Customizing Your Desktop

In this chapter you will learn how to:
* Move, lock, unlock, and resize the taskbar
» Customize other taskbar properties
» Interact with and customize taskbar icons
= Add and create toolbars on the taskbar
» Use and customizing the Start menu
= Use the Start menu’s pinned list
= Customize your desktop
= Move and sort desktop icons
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6.1: Customizing the Taskbar

Locking and Unlocking the Taskbar

The taskbar holds the Start button, displays icons for open programs, tells the time,
and displays other information about the computer:

1037AM |

- [m o)

8/18/2009

By default, the taskbar is locked. This means it cannot be modified to look or function
differently. However, as we explore different concepts in this and following lessons,
we will need to know how to unlock the taskbar.

To unlock the taskbar, right-click in an empty area of the taskbar and click Lock the
Taskbar to uncheck this field:

Toolbars

Cascade windows
Show windows stacked
Show windows side by side

Show the desktop

Start Task Manager

Lock the taskbar
Properties

Windows 7 doesn’t give you any visual indication that the taskbar has been locked or
unlocked. You will have to right-click an empty area of the taskbar again to be sure.

Moving the Taskbar

The Taskbar is a feature that has been around since Microsoft introduced Windows 95.
It has always been displayed by default at the bottom of the screen. However, it can
be displayed on the left, right, or top of the screen as well, depending on how you like
your screen to be set up.

Moving the Taskbar is easy to do. Make sure the taskbar is unlocked and then click

and drag an empty part of the Taskbar to the side of the screen of your choice, such
as the left side:
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|-i il

i)
10:45 AM
8/18/2009

—

As you move the taskbar around, any open windows or icons on the desktop will
reposition themselves to account for this change.

If you are satisfied with the location of the Taskbar, we recommend that you lock the
taskbar to prevent accidentally clicking and dragging it somewhere else.

Resizing the Taskbar

If you use many programs at once or use a smaller screen resolution, your taskbar
can start to look cluttered. This can make switching between different windows more
difficult. With the taskbar unlocked, move your mouse to the top edge until your
cursor changes into a double-headed arrow. Click and drag to raise or lower the
height of the Taskbar to your liking:

"z

10:50 AM
all Tuesday

8/18/2009
i)

You can take up half of the screen with the Taskbar if you want:
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However, if you need that much space for all of the work you want to do, you might
instead consider hiring an assistant or purchasing a few extra monitors!

Other Taskbar Options

The taskbar features a few more tricks if you would like further customization. For
example, imagine you are an animator or graphic artist and only use one or two
programs during the course of your workday. Despite the taskbar being fairly small to
begin with, you would rather have all the space on your screen available. In that case,
you can make the Taskbar go away until you need it again with the AutoHide feature.

Right-click some empty space on the taskbar and click Properties. The Taskbar and
Start Menu Properties dialog will appear:

L Taskbar and Start Menu Properties ‘ M
Taskbar |Start Menu [ Toobars

Taskbar appearance
[ Lok the taskbar

[ Auto-hide the taskbar

[ use smal icons

Taskbar location on screen: [Botton'l - ]

Taskbar buttons: [Alwa\rs combine, hide labels V]

Notification area
Customize which icons and netifications appear in the
notification area.

Preview desktop with Aero Peek

Temporarily view the desktop when you move your mouse to the
Show desktop button at end of the taskbar.

Use Aero Peek to preview the desktop

How do I customize the taskbar?

ok | [ cancel
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Check the box marked “Auto-hide the taskbar” and click OK. This will make the
taskbar disappear except for a single line across the bottom of the screen. Move your
mouse to the bottom of the screen and the taskbar will reappear:

On the other hand, if you work in desktop publishing and have many different
documents open at the same time, the Taskbar will group windows of the same
program together into one button. Windows 7 does this by default, creating a
“stacked” icon:

Hover your mouse over the stack to see a thumbnail image of each view. Point to a
thumbnail to use Aero Peek and view the window, click the thumbnail to open that
window, or click the close button beside the thumbnail to close the window:

If you wish to turn off this grouping feature and view the names of the
programs/folders open on the desktop, use the Taskbar buttons combo box:

Taskbar buttons: [Nwavsmrbine, hide labels v]

Always combine, hide labels
Combing when taskbar is full

Mever combine
Customize which icons and notificauons appear o

notification area.

Motification area

Preview desktop with Aero Peek

Temporarily view the desktop when you move your mouse to the
Show desktop button at end of the taskbar.

Use Aero Peek to preview the desktop

How do I customize the taskbar?

o) (o ] oo )
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Taskbar buttons: Mewver combing v]

Motification area
Customize which icons and notifications appear in the
notification area.

Preview desktop with Aero Peek

Temporarily view the desktop when you move your mouse to the
Show desktop button at end of the taskbar.

Ise Aero Peek to preview the desktop .
‘j) 1 item

How do I customize the taskbar?

Ok ][ Cancel ]

/: E Libraries ﬁ Documents

For example, the “"Never combine” option displays taskbar icons in the traditional way,
with the icon shown beside the name of the program or folder that is currently open.
Click Apply to confirm the changes or OK to confirm the changes and then close the
Properties dialog box.

6.2: Advanced Taskbar Options

Interacting with Inactive Icons

When you install certain programs on your computer, sometimes the programs install
small programs that reside in the System Tray. There are two types of icons. The first
kinds are system icons and are included with Windows. These are directly related to
the operation of Windows and your computer. These include the volume icon and a

link to the Action Center:

You may see a small arrow to the left of the icons in the taskbar. Any programs listed
here are the second type of icon, called hidden or inactive icons. These small
programs start when Windows starts or start when a program is launched to provide
quick access to different program features. Click the arrow to show any inactive icons.
Note the Customize link which we will use in a moment:

g &

Customize...
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If you hover over an icon for a moment, you will usually see a small description of the

icon appear:

Mew updates are available

Depending on the program, you should be able to click or right-click any of these
icons and interact with them.

If you click the Customize link, you will be able to customize the way every icon (both

the inactive and system icons) is shown:

Select which icons and notifications appear on the taskbar

If you choose te hide icons and notifications, you won't be notified about changes or updates. To view hidden
icons at any time, click the arrow next to the notification area on the taskbar.

»

Icons Behaviors

ﬂ:éj‘ Action Center

Solve PC issues: 1 important message ..

4
m

l Show icon and netifications

affll Network N . lShow icen and notifications "l
ransems-donotmess Internet access

) 1:.I'CI|LII‘:I"I? o lShow icon and notifications "l
Headphones: 677

Bl Catalyst Control Centre: Host applica... lOnIy <how notifications 'l

Color32 Bpp, 1440 x 900, Landscape

Turn system icons on or off
Restore default icon behaviors

[] Always show all icons and notifications on the taskbar

[ oK ][ Cancel ]

Make any changes using the pull-down menus to the right of the options and then
click OK.

Customizing Icons in the System Tray

If you click the Customize link in the list of inactive icons, you will be able to
customize the way every icon (both inactive and system) is shown. If you don't
happen to see the small up arrow used to view any inactive icons, right-click the
taskbar, click Properties, and then click the Customize button shown here:
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. Taskbar and Start Menu Properties

Taskbar | Start Menu | Toolbars |

Taskbar appearance
Lock the taskbar

[ auto-hide the taskbar

[ Use small icons

Taskbar location on screen: [Elottmn v]

Taskbar buttons: [Always combine, hide labels v]

Motification area

Customize which icons and notifications appear in the
notification area.

Preview desktop with Aero Peek

Temporarily view the desktop when you move your mouse to the
Show desktop button at end of the taskbar,

IIze Aero Peek to preview the desktop

How do I customize the taskbar?

)

o | seorcon 5|
Z]

Select which icons and notifications appear on the taskbar

If you choose to hide icons and netifications, you won't be notified about changes or updates, To view hidden
icons at any time, click the arrow next to the netification area on the taskbar,

Icons Behaviors

ﬂ:ﬁ Action Center

- . Show i d notificati
Solve PC issues: 1 important message .. ’ W icon and netimications

il Network

. N ’Show icon and natifications
ransems-donotmess Intemet access

Velume

Headphones: 67% ’Show icon and notifications

Catalyst Control Centre: Host applica...

Color:32 Bpp, 1440 x 900, Landscape ’OMY show notifications

Turn system icens on or off
Restore default icon behaviors

[C] Always show all icons and notifications on the taskbar
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Make any changes using the pull-down menus to the right of the options:

Icons Behaviors

[th‘ Action Center
Solve PC issues: 1 important message ...

Show icon and notifications

Show icon and notifications

Hide icon and notifications
alll Metwork e e

Only show notifications

Click OK at the bottom of the dialog to commit your changes.

Adding Toolbars

A toolbar on the taskbar is a small cluster of commands used to open a specific
program or programs. There are a few toolbars that come standard with Windows 7.
To view them, right-click the taskbar, point to Toolbars, and then select a toolbar to
make active:

Toolbars Address

Cascade windows Links

Show windows stacked jlabiletRC Input Kanl h

Show windows side by side Desktop

Show the desktop Mew toolbar...

Start Task Manager

Lock the taskbar
Properties

The toolbar will then appear somewhere on the taskbar:

Tablet PC Input Panel
Nra -
rZd - |

Click the toolbar to open the respective program:

=1 — e |
Correcting Deleting Splitting Joining
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Let’s quickly review the other toolbars:

Address

Links

Tablet PC Input
Panel

Use this toolbar as a basic way to visit a Web site or
network address. Simply type the address in the text box
and press Enter. Your default Web browser will launch and
proceed to that Web site or location:

The Links toolbar is connected to Internet Explorer’s list of
links. Links are a special folder of Favorites, a list of saved
URLSs for your favorite or often visited Web sites. Click the
(>>) icon to show the links; click any link to open that
Web page in Internet Explorer:

@& Suggested Sites
£ | Web Slice Gallery

Links n |I {: 3
In « [%F .l W2
b

819,

A tablet PC is similar in design to a laptop; however, the
screen is touch-sensitive. You can also use tablet tools with
any other touch-sensitive screen. When you write
something on the screen with the special stylus pen (which
doubles as the mouse), your handwriting is translated into
text that gets written into whatever program you may be
using. This tool also contains an on-screen keyboard so
you can tap the letters instead of writing them by hand:

[ = | [ R |
Correcting Deleting Splitting  Joining |
CIELBECS )
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Desktop The Desktop toolbar allows you quick access to different
locations on your computer. Click >> to view available
locations:

- Libraries

2 Velsoft

18 Computer
E‘h Metwork

Ed Control Panel
o] Recycle Bin
Ed Control Panel

*
Desktop h PO ST ]

Creating Custom Toolbars from a Folder

You can add program icons directly to the taskbar for easy access. However, if you
create your own toolbar, you will be able to add both program icons and folders. The
toolbar can then be enabled when you need it and disabled when you don't.

You can add a custom toolbar by selecting a folder that contains program shortcuts
and/or other folders and data, which means that you might have to construct a folder
first before adding it as a toolbar. Let’s create a custom toolbar that contains a link to
Windows Media Center and the Videos library.

We will do this by first creating a new folder somewhere on our computer. We will
create one right in the root of the hard drive (C:). First, open the Computer folder by
clicking Start > Computer or navigating to Computer using Windows Explorer.

Next, we will double-click the C: drive to open and view its contents:

4 Hard Disk Drives (1)

Local Disk (C:)
=
278 GB free of 297 GB I},

With C: open, click "New folder” in the command area and then give the folder a
meaningful name:

. Windows
“ msdiaB0.dll

L=}

| My Toolbar Folderd |

Now we need to add shortcuts to Windows Media Center and the Videos library to this
folder. To do this, we will right-click on the item we want to add to the folder. Point to
Send to and then click Desktop (create shortcut):
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Open

'@' Run as administrator
Open file location
Pin to Taskbar
Pin to Start Menu

Restore previous versions

@ Default Programs

Send to
. Desktop Gadget Gallery
@ Internet Explorer (B4-bit Cut
& Internet Explorer Copy
'E}Q Mew Microsoft Office DY
% Open Microsoft Office [ Delete
& Windows DVD Maker | % Rename
52 Windows Fax and Scan p "

Windows Media Center FOPEMIEs

We will repeat this process for the Videos library:

sl U @& E N

| |> B Videos | ! L

Expand

a8 Cgm puter

Local Di
i |M Share with

Open in new window

Don't show in navigation pane

B ?! Metwork
Send to

Copy

Delete

Rename

Compressed (zipped) folder
Desktop (create shortcut]
Documents

Fax recipient

Mail recipient

Fleppy Disk Drive (Az)

DVD BW Drive (D)

8/19/2009 11:43 AM

bkUEN

Desktop (create shortcut)
Documents I}
Mail recipient

Floppy Disk Drive (A:)

DVD BW Drive (Dv)

With both shortcuts added to the desktop, you can tr;en move the icons into the
toolbar folder. We have done this below by opening My Toolbar Folder and then
clicking and dragging the icons from the desktop into the folder:

ol x |

/(-\ - Local Disk (C:) » My Toolbar Folder _ SearchMy ... P

Organize v Include in library v
! =
¢ Favorites — Name

Bl Desktop

Share with v

New folder

B 0 @

Date modified Type

This folder is empty.

& Downloads

g {-) Move to My Toolbar Folder ]
[t

- Wilias!

g

2| Recent Places
(VIETI S ETILET]

4 Libraries
@ Documents
J’ Music
[=] Pictures
# videos

’ 0 items
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Now we can add the folder and its contents as a toolbar to the taskbar. Right-click the
taskbar, point to Toolbars, and then click “New toolbar:”

Toolbars Address
Links
Tablet PC Input Panel

Cascade windows

Show windows stacked

Show windows side by side Desktop

Show the desktop Mew toolbar...
Start Task Manager

Lock the taskbar

Properties

Browse your computer, select the folder to add and then click Select Folder:
e [ . y . 3 p— -
) [seorch LocelDsk ©) ]

Organize * Mew folder 4= - I@
< Favorites Mame : Date modified Type Si
Bl Desktop L. ATI 8/18/2009 1:08 PM File folder
& Downloads . My Toolbar Folder 8/19/2009 11:53 AM  File folder
£ Recent Places .. Perflogs 7/14/200912:20 AM  File folder
E .. Program Files 8/19/2009 9:39 AM File folder
- Libraries .. Program Files (x86) 8/18/2009 :52 PM File folder
@ Documents . Users 8/18/200912:45 PM  File folder
Jﬂ Music o Windows 8/18/2009 2:51 PM File folder
[E=] Pictures |
B2 Videos
Lo Computer - 4| m b

Folder: My Toolbar Folder

Select Folder El ’ Cancel ]

Your new toolbar is added and ready to use:

E Videos - Shortcut
 Windows Media Center

® . 11:56 AM

My Toolbar Folder o [m= g oW
) J = h | %l W 8/19/2009
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Removing Toolbars

You can remove toolbars by removing the check mark beside its name in the list of

available toolbars:

Toolbars

Cascade windows

Show windows stacked

Show windows side by side

Show the desktop

Start Task Manager

Lock the taskbar
Properties

Address
Links

Desktop
My Toclbar Folder

Mew toolbar...

6.3: Customizing the Start Menu

Tablet PC Input Panel

3

Using the Start Menu

You should be fairly comfortable using
the Start menu now, but a refresher
never hurts. Click the Start button in
the lower left-hand corner of your
screen to view the Start menu:

Click an item in the list on the left to
open the program, and use the links
on the right to access different areas
of your computer or change settings.

@ Windows Media Center
@ Snaglt 8

B :

; Getting Started

\j, 7

,o‘iﬁ Paint
E Calculator

Sticky Notes

% Snipping Tool
% Remote Desktop Connection

,' Magnifier

A= WordPad
=

All Programs

Velsoft

Documents
Pictures

Music

Games

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support
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Point to the (>) arrow beside a program name to open content or features recently
used by that program:

‘@ Windows Media Center k
: i}— [ Play Favaorite Pictures

e Snaglt 8 6} Play Favorite Music

= Tasks
d’ Getting Started *

,u_""f})? Paint

Frequent

I= TV Program Guide

Search parts of your computer by typing part of a file or program name into the
Search Bar at the bottom of the menu:

Programs (2)

|G Windows Media Center
@ Windows Media Player

Control Panel (11}
L+ Media streaming options

Ea Change default settings for media or devices

g Play CDs or other media automatically

Ea Start or stop using autoplay for all media and devices
@ Wiew devices and printers

@ Device Manager

Documents (5)

Windows7Ultimate_Intermediate_InstructorGuide
Windows7Ultimate_Foundation_InstructorGuide
|| Windows 7 I Draft

|| Windows 7 F Draft

|| windows T outline

p See more results

Finally, you can click Shut down to turn off your computer or use other power options:
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Default Program Switch user

Log off

Hel d5
elp and Suppo Lock

Restart

Sleep

Customizing the Start Menu

Most people will find the default Start menu layout easy to use. However, if you would
rather not have so many icons, or have a very specific layout that you like to use,
Windows lets you customize just about everything. To customize the Start menu,
right-click in an empty space on the taskbar and click Properties.

When the Taskbar and Start Menu Properties dialog box appears, click the Start Menu
tab, and then click Customize:

'Y Taskbar and Start Menu Properties

Start Menu | Toolbars

To customize how links, icons, and menus look and
behave in the Start menu, didk Customize.

Power button action: [Shut down v]

Privacy
Store and display recently opened programs in the Start menu

Store and display recently opened items in the Start menu and the
taskbar

How do I change the way the Start menu looks?
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The Customize Start Menu dialog box will appear:

© = ™

‘fou can customize how links, icons, and menus look and behave on the
Start menu.

i Computer i
@ Display as a link

() Display as a menu

() Don't display this item
|:| Connect To
[ Control Panel

@ Display as a link

(7) Display as a menu

(7) Don't display this item
Default Programs
Devices and Printers
¢ Documents

i@ Display as a link

(") Display as a menu

) Don't display this item
# Downloads

(7 Display as a link =

Start menu size

Mumber of recent programs to display:

Mumber of recent items to display in Jump Lists:

[ LIse Default Settings ] QK

The list at the top of the window allows you to modify many of the main commands in
the Start menu. Each of the items in the Computer Control area of the Start menu can
be displayed as a link to a folder, displayed as a submenu inside the Start menu, or
removed from the Start menu.

You can choose to enable/disable the Favorites folder which gives you quick access to
all the stored Web sites on your computer. You can also choose to highlight any
programs that have been installed recently:

[C] Favorites menu ‘—

_‘! Games
@ Display as a link
(") Display as a menu
() Don't display this item
Help
Highlight newly installed programs "_

There are other options that can be enabled here as well. If you have a network of
printers that you have access to, you can add a Printers link to view the properties
and print queues of the different machines. You also have the option to add a Run
command, which lets you open programs by entering their specific launch command.

You can also control how many recently used programs to display and how many
recent items to show in a Jump List (like how many previously visited Web pages in
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Internet Explorer). Finally, you can undo any changes and restore the default Start
menu by clicking the Use Default Settings button:

Start menu size

Mumber of recent programs to display: 10 F=
Mumber of recent items to display in Jump Lists: 10 F=
[ Lise Default Settings ] [ Ok ] [ Cancel ]

Click Cancel to discard any changes you have made or click OK to accept the changes.

Using the Pinned List

The Start menu contains an area at the top where you can “pin” commonly used
programs. By default, there are no items pinned to the list; instead, the order of
programs shown when you click the Start menu will change depending on how often
you use the program.

You can add any program to the pinned list by right-clicking a program icon in the
Start menu and clicking Pin to Start Menu:

@ Windows Media Center

@ Snaglt8 Velsoft

Documents

3’ Getting Started »

Pictures

|K;fo_" Paint
= Open
Calculator "‘g' Run as administrator

()

4

Pin to Taskbar
Sticky Notes
Pin to Start Menu %

% Snipping Toc Remove from this list

&é Remote Desk Properties

Now each time you click the Start button, that program will always be at the top of
the Start menu and separated from the other icons with a faint line:
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ﬂfz Paint ‘_

) . Velsoft
Windows Media Center 4

Documents
% Snaglt 8

Pictures

:‘! Getting Started »
E

Conversely, if you want to remove an item from the pinned list, right-click the pinned
icon in and click Unpin from Start Menu.

Other Start Menu Properties

There are a few other commands that you can use to modify the Start menu. Right-
click the Taskbar and click Properties, and then click the Start Menu tab:

Power button action: [Shut down v]

Privacy
Store and display recently opened programs in the Start menu

Store and display recently opened items in the Start menu and the
taskbar

By default, the power command in the Start menu will shut down the computer. You
can click the combo box and select a different power option, like Restart or Log off.

You can also enable or disable the ability to display recently used programs and
files/items in the Start menu.
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6.4: Customizing the Desktop

Changing Your Wallpaper

Your wallpaper is the image that is displayed as the background picture on your
desktop:

Your wallpaper picture can be anything you like and nearly any image file format is
usable as wallpaper.

To change your wallpaper, right-click on any blank area of the desktop and click
Personalize:

EL Catalyst(TM) Control Center
Wiew
Sort by
Refresh

Paste
Paste shortcut
Undo Delete Ctrl+Z

Mew

!I Screen resclution

W Gadgets
g Personalize
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The Personalization folder will appear and offers several commands to adjust the

visuals of your computer. To adjust your wallpaper, click the Desktop Background

button at the bottom:

(

—

{

Control Panel Home

Change desktop icons
Change mouse pointers

Change your account picture

See also
Display
Taskbar and Start Menu

Ease of Access Center

")k E ) Control Panel » All Control Panel ltems » Personalization
p—

Change the visuals and sounds on your computer

Click a theme to change the desktop background, window color, sounds, and screen saver all at once.

My Themes (0)

Aero Themes (7)

Get more themes online

N

m

Desktop Background

Harmony

Window Color
Sky

2 ®

Sounds Screen Saver

Windows Default None

This will show you a window with various background options:

Q EJ » Control Panel » All Control Panel ltems » Personalization » Desktop Background

Choose your desktop background

Click a picture to make it your desktop background, or select more than one picture to create a slide show.

Picture location: ’Windows Desktop Backgrounds

v” Browse... ]

Clear all ]

Selectall J |

Picture position:

N )

|30 minutes

Change picture every:

[7] Shuffle

[ Save changes ] [ Cancel

R —

v Search Con... O

o
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At the top of the window, you can use the combo box to choose the source for your
wallpaper. You can also click Browse to select another folder that contains images.

Picture location: | Windows Desktop Backgrounds h Browse...
Windows Desktop Backgrounds
Select all [Pictures Library
Top Rated Photos r
Solid Colors 8 o

Next, you can select one or more images to use as your wallpaper. To select multiple
images, hover your mouse over a picture and then click the checkbox. Repeat this
until you have selected all the images you want:

4 Landscapes (6)

img9

Item type: JPEG image
Rating: Unrated
Dimensions: 1920 x 1200
Size: 1,10 MB

1 ane

Picture position: Change pict

Now you can adjust how the image will be displayed on your screen. These options
will force the image to conform in different ways relative to your screen resolution:

Picture position:

Finally, if you have selected more than one image to use as a background, you can
control how often Windows switches between images:
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Change picture every:
[30 minutes ﬂ Shuffle

10 zeconds

30 seconds

1 minute

3 minutes

5 minutes

10 minutes
815 minutes
20 minutes

1 hour
2 hours
3 hours
4 hours
6 hours
12 hours
1 day

Moving Icons
The Windows desktop is designed to be used as you would a desk or table. Items can

be arranged in any order, folders and files can be saved on the desktop, and all
programs run in windows on the desktop. Consider the following desktop:

-

Recycle Bin

D =
Internet accounting
Explorer information

shopping list

Icons can be moved one at a time around the desktop by clicking and dragging. If you
want to move many icons at once, click and drag a box around the icons first:
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BpINg ISt

Now if you click and drag any of the selected icons, you can move all of them as a
group:

accounting
information

'

shopping list

Sorting Icons

If you use your desktop as a place to dump files and deal with them later (like me) it
sometimes comes in handy to first sort the icons in different ways. Consider the
following icons on my desktop right now:
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-

Recycle Bin

shopping list

El -
Internet
Explorer

accounting
information

K

picture

archive

As you can see, there are files, folders, and other icons arranged in no particular
order. Windows allows you to sort these icons by Name, Size, Type, and the Date they
were modified. To do this, right-click on any empty space on the desktop, point to

Sort, and click an option.

Since I have lots of different kinds of files, I will sort by name:

EX Catalyst(TM) Control Center

View
Sort by
Refrezh

Paste
Paste shortcut

Undo Rename
Mew

!u Screen resolution

W Gadgets

uﬂn Personalize

Mame I}

Size
Itemn type
Date modified

203



MS Windows 7 Foundation Manual

Now all of the icons will be arranged alphabetically:

e

Recycle Bin

accounting
information

4
m -

Internet
Explorer

MyJournal

shoppinglist

Setting View Options

By default, Windows displays medium size icons and aligns the objects to an invisible
grid. However, Windows allows you to modify lots of display options, including the
look of the icons themselves. You can change view options by right-clicking on the
desktop and pointing to View:
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View
Sort by I’\\}
Refresh

Paste Auto arrange icons
Paste shortcut v Align icons to grid
Unde Rename Ctrl+Z e p
Mew » Show desktop gadgets

B Screen resolution

W Gadgets

'E: Personalize

ST

Ei Catalyst(TM) Control Center

[ Large icons
b | & Medium icons

Small icons

Let’s explore the different options:

Icon Size

Auto Arrange

Align to Grid

Show Desktop
Icons

Show Desktop
Gadgets

Choose between large, medium, and small icon sizes:

Recycle Bin Recycle Bin | Recycle Bin

If you arrange your icons by name as we did earlier in this
lesson, then enabling Auto Arrange will automatically sort
any new folders or file types alphabetically into the icons that
already exist. For example, if your desktop contains
biographies of famous people and you sorted all of them by
name, then any new file would automatically be placed in
alphabetical order for you.

All of the icons on the desktop are by default arranged in a
grid pattern. Any new icons added to the desktop are
automatically fitted into an invisible grid to keep everything
neat. However, you can turn that alignment off if you like.

Enable or disable this option to show or hide the Recycle Bin.

Enable or disable this option to show or hide your gadgets.
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Deleting Icons

To delete something from the desktop, you can click and drag an icon on top of the
Recycle Bin or right-click the icon and click Delete. If you try to remove a shortcut to a
program, you will see a warning like this:

Are you sure you want to move this shortcut to the Recycle Bin?

Windows Media Player
Play digital media including music, videos, CDs, and
DVDs.

To truly remove something from your computer, empty the Recycle Bin.
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Chapter 7: Advanced File and Folder Tasks

In this chapter you will learn how to:

Use a Search box in a folder and the Start menu
Search your search results

Better refine your search

Open and use Windows Explorer
Customize the layout of Windows Explorer
Change the view of Windows Explorer
Create a new library

Create and manage files and folders

Cut, copy, and paste files and folders
View file and folder properties

Share a file or folder

Burn files and folders

Print a file

Use the command prompt
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7.1: Using Search

Windows has robust search capabilities, and a search box or search tool is never very
far away.

What is File Indexing?
Windows uses an indexing system to help keep track of files.

An indexing system basically makes a quick alphabetical list of all items inside a
folder. Whenever you search for a particular item inside a folder using the Search box,
only the items that are contained inside that folder will be searched (instead of all the
files on your computer being searched at once). An indexing service does have a
disadvantage, however, in that when a folder is first opened, every item is analyzed.
If a folder contains hundreds or thousands of items, your computer will become
noticeably slower for a short time while the index is built. However, once the indexing
has been completed, searching becomes much faster and therefore allows computer
navigation to become much faster. This quickly makes back the time spent on
indexing.

Not all areas of your computer are indexed. Most of the files associated with the inner
workings of a program, for example, are not indexed. This is because there can
literally be thousands of files associated with a single program. If every single file was
indexed, there would eventually come a point where the time it took to search the
index would actually take longer that it would take to blindly search the files!

Using a Search Box

Every folder contains a search box, usually right at the top of the window. To use a
Search Box, just type in the name of a file you are looking for. You don’t even need to
press Enter; results of your search become more refined as you enter more
information:

=JLEL_X

wlts in System32 » i | I
1 Burn = - E;l l@l
1-indexed locations: Ch\Windows\System32, Click to add to index... X

notepad.exe.mui
ChAWindows\Systemn32ten-US

......

notepad
R CAWindows\System32

Search again in:

= Libraries (M Computer Custom...

Date modified: 7/13/200911:30 ...
Size: 12.0 KB

Date modified: 7/13/72009 10:39 ...
Size: 189 KB

@ Internet o] File Contents
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Using Search in the Start Menu

Searching locally inside a folder is easy to do with the Search bar, but doesn’t help
you very much if you don’t know what folder to look in! Therefore Windows includes a
broad search tool in the Start menu, just above the Start button.

Type the first few letters of the file name or program you are looking for and Windows
will display some of the best matches for you as you type based on files that have
been indexed.

Search Results Window

The Start menu is an easily accessible location where you can search for things.
However, if there are many responses to your search and you don’t think any of them
are quite what you were looking for, you can see the full list of results by clicking “See
more results:”

Programs (24)

€ Windows Media Center
1 Windows Explorer

@ Windows Media Player
£ Windows DVD Maker

Control Panel (67)

ﬂWindows Firewall
¥4 Windows Defender
a Windows Card5pace

Documents (17)

. Windows 7 Ultimate Intermediate
@] Windows7Utimate_Foundation_InstructorGuide

) Windows 7 Ultimate Foundation
Files (107

@] Windows7Utimate_Intermediate_InstructorGuide
|| WindowsLiveMessenger-uccapi-0.uccapilog
£ | Get Windows Live

U.} See more results .
[

|windo-|
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This will open the Search Results window:
[E= ="
> serchresats <o fwne ]

Organize = Save search Burn = - O @
i S -
W Favorites F % WindowsLiveMessenger-uccapi-O.ucc...  Date modified: 8/19/200912:2... [
Bl Deskiop 1 ChlUsers\Velsoft\Tracing Size: 0 bytes E
Downloads : :
® | Get Windows Live Dste modified: §/19/2009 9:32...
)y Lz ChUsers\Velsoft\Favorites\Windows Live Size: 133 bytes
| pics = )
E | Windows Live Gallery Date modified: 8/19/2009 9:32...
- _ ChyUsers\Velsoft\Favorntes\Windows Live Size: 133 bytes
= Libraries
@ Documents | Windows Live Mail Date modified: 8/19/2009 9:32...
d‘, Music ChUsers\Velsoft\Favorites\Windows Live Size: 133 bytes
=] Pictures | Windows Live Spaces Date modified: 8/19/2009 9:32...
B videos b Ch\Users'Velsoft\Favorites\Windows Live Size: 133 bytes
8 Computer i. Windows 7 Ultimate Intermediate Date modified: 8/18/2009 3:04...
= P il ' ChiUsers\Velsoft\My Documents i
& | cal Mick e
p 25 items

In the Search Bar at the top of this window, your original search term will appear. All
results from indexed locations that match your search term are highlighted in the
center of the window. Double-click any item to open it.

At the bottom of the search results, there are a few links to search different areas of
your computer again:

Search again in:

/M Computer Custn:nr‘n... & Internet

=l Libraries |
You can tell Windows to search exclusively in the Libraries, on the Internet, your
entire computer (including non-indexed locations), or define a Custom search.

If you click the Computer link, Windows will search your entire computer. While the
computer is searching, you will see a green progress indicator behind the address bar
showing the approximate overall progress of the search:

Organize ¥ Save search Burn =~ [0 @

Once the search has completed, you can scroll through the results. Be warned
however, that some searches of your entire computer may yield quite a few results!
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;) 23,560 items

If you click the Custom option at the bottom of the Search Results window, you can
specify which indexed or non-indexed locations will be included in your search.

,

Change selected locations
4 Ml Desktop
> |4 Libraries
2 Velsoft
o 1M Computer
> ‘E‘ﬂ Metwork
; @ Control Panel

» |4y Search Folders

O OO0

v Or type a location here Add

Summary of selected locations

=
Included Locations In Folder Exclusions

Mo locations have been selected.

4 L I

I Ok Cancel

Sometimes you may have better luck by telling your computer where not to look!\

Searching Tips and Tricks

There are numerous ways to help improve your search results. We know that the
Search tool only searches indexed locations, which are all commonly used folders, but
only a very small part of your computer. You can try to be more specific with your
search term(s), but being too specific may not yield any search results. And searching
your entire computer may find the file, but it might take you a long time to search
through the search results!

Luckily, there are a few different things you can do to make your searches more
efficient.

If you only know part of the file name, you can use the asterisk (*) character to help
find files that have similar names. If we were to search for “sym*,” the * represents
any possible characters after the letters “sym.” Search results might include things
like “symbol,” “symphony,” and “symbiosis.”
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If you press Ctrl + F when the Search Results window is open, you can add more
criteria to your search. You can search based on the following criteria:

Kind

Date
modified

Type

Size

Define the kind of file you are looking for. This includes
documents, pictures, music, movies, etc. Windows will examine
the file extensions and search for relevant matches.

For example, common picture file extensions include .jpg, .gif,
.png, .bmp.

Specify the date the file or program was last modified.

The Type option is a more precise version of the Kind searching.

Define the exact type of file extension you are looking for.
Windows 7 recognizes a large number of different file
extensions, and the more programs you have installed on your

computer the more file types Windows will be able to recognize.

You can define approximately how large the file is in bytes.

To use one of the search criteria, just click one of the options in blue:

For example, if you click the Kind option, you can choose the general file type from

the list:

windows

Add a search filter
Kind: Date modified: Type Size

Calendar

Communication

Contact

m

Document

E-rnail

Feed I}?
Falder

Game

Instant Message -

If you click the E-mail option, the criteria will be added to the search field:
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Add a search filter
Date modified: Type: S5Size:r Mame

This will further refine your existing search or let you search for something else based
on the criteria.

You can combine several search criteria together so you could be very specific with

your search. If you know you are searching for an e-mail approximately 100K in size,
and you know the subject started with “P,” chances are if it does exist you will find it!

Setting Search Options

To specify with even more detail how the Search tool should operate, click the

14

Organize button and then click “Folder and search options:

,'D' b Search Results in Comp

Organize « Save search Burn

Cut
Copy
] Paste
Undo
Redo

Select all

[C] Layout A’

Folder and search options

7% | Delete r
Rename 3
Remove properties
Properties

Close
——r
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When the Folder Options dialog appears, click the Search tab:

|
o N =

Search

What to search

i@ In indexed locations, search file names and contents.
In non-dndexed locations, search file names only.

(71 AMlways search file names and contents {his might take
several minutes)

How to search

Include subfolders in search results when searching in file
folders

Find partial matches

[7] Uze natural language search

[ Don't use the index when searching in file folders for system
files (searches might take longer)

When searching nondndexed locations
Include system directories
[] Include compressed files (ZIF, CAB...)

[ Restore Defaults

[ OK ][ Cancel ] Apply

1 -

Adjust the options here to change how the Search tool functions. Enabling some
options will require extra search time; however, they may yield much more accurate
results.

Let’s explore the different options:

What to search Specify how you want the Search tool to look for and how
deep in a file to dig for it. Specify if you want to always use
indexed locations or if you want Windows to search
everywhere, including the contents of the file.

How to search The options here let you specify how much freedom you
want to give to the Search tool. The two default options
shown above (Include subfolders, Find partial matches) are
best to use for an all rounded approach.
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When searchinga  We know that some folder locations are indexed, meaning

non-indexed that a list of information about the files in a folder has been

location compiled, making searching faster. If you want to search
every nook and cranny of your computer in order to find a
system file or file that is stored in a compressed folder,
enable both of the bottom options.

Depending on the information you are looking for, some combinations of search
options can produce very slow search times. Unfortunately it is impossible to provide
a perfect solution for everyone; it will simply involve some trial and error.
Nonetheless, you can always return the search options to their defaults by clicking the
Restore Defaults button.

7.2: Using Windows Explorer and Libraries

Windows Explorer is a program that is used like a folder to navigate through the
different parts of your computer. Using Windows Explorer, you can view file hierarchy,
move large volumes of files at once, and more.

Launching Windows Explorer

Windows Explorer is found by clicking Start > All Programs -> Accessories >
Windows Explorer. It is also attached to the taskbar by default:

@ Sync Center
4 Windows Explorer \m

g WordPad h) Default Proarams
|, Ease of Access Displays the files and folders on your computer.

Devices and Printers

Sticky Notes ‘ }
|

., System Tools Help and Support
. Tablet PC
. Windows PowerShell

When you open Windows Explorer, you will see links to the four default libraries:
Documents, Music, Pictures, and Videos.
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Windows Explorer Overview

At the top of the window is the command area. There are Back and Forward buttons,
an address bar that shows you the current folder or drive you are viewing, and other
commands that change depending on the content included in the folder.

For example, when you first open Windows Explorer via the Start menu or taskbar,
you have the option to create a new library:

Organize = Mew library

-~

- Favorites [ Create new library. ]
Bl Desktop Open a library to see you
4 Downloads -
Zl Recent Places & Documents
| pics -7 Library

When viewing a folder that contains a variety of items, you will see these commands:

Organize = Share with - Burn Mew folder
't Favorites Documents library
Ml Desktop Includes: 2 locations

These four commands are the most common ones you will see when using Windows
Explorer.

Let’s take a moment to go over what each command does.

Organize This option is available all the time when using Windows Explorer.
This general menu lets you perform a number of common tasks:

Organize vt} = Open Share w

4

Cut

Copy
Paste

@ i

Undo

Redo

Select all

] Layout 2

Folder and search options

75 Delete
Rename
Remove properties

Properties

Cloze

Share with  Windows has the ability to communicate with other computers that
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are part of the same network. Most offices have some sort of
network established so all computers can save files in one location
or share a printer. Many homes also have a network, either a wired
one that was installed when the house was built or a wireless one
via a wireless router.

Windows 7 has the ability to communicate with other types of
computers. Two or more Windows 7 computers can create a
Homegroup; a simple network that allows for easy sharing of files.
Most of the information relating to networking is beyond the scope
of this manual. However, if you click the “Share with” option, you
can share files with other users on your network:

Share with = E-rmail Burn

ﬁ Mobody
Homegroup (Read)

Homegroup (Read/\Write)
Specific people...
Burn Burn the contents of the current folder to a CD or DVD.

New folder Use this command to add a new folder inside the current location.
Click the command, then type a name for this new folder:

Share with = E-mail Burn Mew folder == ~ [ [ﬁl

Documents library

Includes: 2 locations il

Mame Date modified Type Si
. microsoft 8/18/2009 2:49 PM File folder
. 8/20/20091:31 PM  File folder
J Snaglt Catalog 8/18/20091:13 PM File folder
, Windows 7 Qutlines 8/18/20091:11 PM File folder
. Windows 7 Ultimate Foundation 8/18/2009 3:00 PM File folder

o
o

20/200812:54 PM  File folder
F2009 2:20 PM Rich Text Format

) Windows 7 Ultimate Intermediate
] shopping list

[e5]
=
[e5]

If you are viewing files that can be played with Windows Media Player, you will see the
“Play all” command:

Play all Burn Mew folder

lusic |It[ Play all music in this folder. l

Click this command to play all items in the folder.

If you are viewing a folder that contains pictures, click “Slide show” to view all files at
once:
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Slide show Burn Mew folder

ictur’es || Display all or the selected pictures
and videos in this folder as a slide
show,

tludes: 2 loca

b

Choosing a Layout

If you want to choose a different layout for Windows Explorer, use the Organize
command and point to Layout. You can enable or disable different parts of the window
here:

Organize - Mew library

Cut
’ es

Copy rary to see your files and arran
Paste
Undo Documents
Bedo Library
Select all Pictures

] Layout b Menu bar
Folder and search options T o=

. Delete [l Preview pane
Rename ¥ | Mavigation pane
Remove properties v Library pane
Properties
Close

Let’s go over the different components:

Menu bar The Menu bar is disabled by default. This option adds some menus
to the top of the window:

= » Libraries »

File Edit View Tools Help

Nraaniva - Nasas lilrans

File lets you create and manage objects in the folder. Edit lets you
select, cut, copy, and paste items. View lets you change how items
in the folder are displayed. Tools offers advanced networking
options. Finally, Help lets you view the Help file and legal
information about Windows.
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The Details pane is visible at the bottom of the window. It shows

Details
pane vital statistics about the folder or the selected item(s):
IE gl 4 items selected Date modified: 8/18/2009 2:20 PM - 8/20/2009 1:31 PM
p Koala Date taken: 2/11/2008 11:32 AM Rating: 3f % 3f BF Size: 762 KB
JPEG image Tags: Add atag Dimensiens: 1024 x 768
Preview The Preview pane is useful when viewing pictures or other graphical
pane media. It displays a small image on the right side of the window:
Organize v =] Preview v Share with v Slide show Print E-mail Burn  » o Sy | @
5 Favorites ~ Pictures library A i okl
B Desktop Sample Pictures =
& Downloads N b: Date
| Recent Places
b pics | = Tulips 2/7/200811:33 AM
) “| = Penguins 2/18/2008 5:07 AM
=5 Libraries &= Lighthouse 2/11/2008 11:32 AM
T — |[=] Koala 2/11/200811:32 AM
& Music = Jellyfish 2/11/2008 11:32 AM
] Pictures |=| Hydrangeas 3/24/2008 4:41 PM
B Videos = Desert 3/14/2008 1:59 PM
' =] Chrysanthemum 3/14/2008 1:59 PM
1% Computer v A — —] ’
J5g® Koala  Datetaken: 2/11/2008 11:32 AM Rating: ¢ 07 07 14 1 Size: 762 KB
JPEG image Tags: Add atag Dimensions: 1024 x 76
Navigation This lists the major folders and locations on your computer:
pane
W Favorites
B Deskto
p
4. Downloads
| Recent Places
i pics
- Libraries

@ Documents

Jﬁ Music

[ Pictures

i Yideos
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Library The Library pane is only visible when viewing libraries. It shows the
pane library name, a link to the number of locations referenced by the
library, and a menu to arrange the data in the library:

Music IIbrary Arrange by:  Folder ‘h ‘I
Includes: 2 locations Loz
. @  Folder
Mame Contributing
Album
| Pete Gooding Artist
| Sample Music Song
Genre
Rating

View Options

Windows lets you display file information in a variety of ways. Experiment with these
options when viewing a folder that contains a lot of files. To explore the view
commands, click the “More options” command:

o)
@

ties.

This command lets you choose between a variety of different views.

Extra Large lcons

| Large Icons

i Medium Icons

Small Icens
e List
i== Details

S2 Tiles

jE Content

Extra Large, Large, and Medium icons are great when viewing folders containing
pictures:
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» Leone » Pictares + Sample Pictures CAETY B sy O

COrgance v Shace mth v U3 3t Bum Yot toder

W Fovootes
L

& Downlosds

2 Pacent Places

Pictures library

b opes

o Litranes
* Docements
& Musc
»~ Pxctices
B videss

W Computer
£ Loct Dk (09

S Netwere

’ B tems

List and Details are great when viewing data or system files, or many files of the same
type.

Below is an example of the Details view, which provides vital statistics about different
files:

[N
K\o)s| > Computer » LocalDisk(C) » Windows » System32 » = [43]
=~ O @

Organize » Include in library + Share with - Burn Mew folder

>

Mame Date modified Type

F
W Favorites =

(4

B Desktop
4 Downloads
15l Recent Places

| pics

. Libraries
@ Documents
Jﬂ Music
[ Pictures

B videos

-

, 2,637 items

b ActionCenter.dll

3| ActionCenterCPL.dII

s ActionQueue.dll

5| activeds.dll
activeds.tlb

5| acbeprgy.dll
AdapterTroubleshooter

5 admparse.dll

5 AdmTmpl.dll

5| adprovider.dll

7/13/2009 10:40 PM
7/13/2009 10:40 PM
7/13/2009 10:40 PM
7/13/2009 10:40 PM
7/13/2009 8:53 PM

7/13/2009 10:40 PP
7/13/2009 10:38 PM
7/13/2009 10:40 PM
7/13/2009 10:40 PM
7/13/2009 10:40 PM

Application extens...
Application extens...
Application extens...

Application extens...

TLE File

Application extens...

Application

Application extens...
Application extens...

Application extens...

Creating a New Library

We've already used libraries quite a bit in this manual. They are essentially folders
that reference one or more different locations on your computer at once. The four
default libraries included with Windows 7 will probably be enough for most users.
However, if you are responsible for working on many different projects that each
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require a lot of supplemental information, it might be easier for you to create a new
library instead of adding more and more folders to the Documents library.

To create a new library, open Windows Explorer or click the Libraries link in the
Navigation pane.

Then click the “New library” command:

ol 5 > libies > ~]h] Sovnibois o]

Organize « Mew library B 0 @
4 .7 Favorites nd [Create new library. }

B Desktop Open a library to see your files and arrange them by folder, date, and other properties.
4. Downloads =
“Z| Recent Places | &| Documents i? Music
-k
b pics "“'-._,P Library s Library

- — = Pictures Videos

| 4 Libraries (- &? Library i Library

[ @ Documents

A new library will appear under the others. Give the library a meaningful name and
press Enter:

Libraries
Open a library to see your files and arrange them by folder, date, and other properties.

_--'.
4 Documents Music
Library

<P liboy &
i—J Pictures i Videos
< Library e Library

=
~ ibrary

Now double-click this new library to open it. In order to use the library, it needs
something to reference. Click “Include a folder” to continue:

ﬁ —| Accounting is empty
|
.._:;%J,'f

Mo folders have been included in this library.

[ Include a folder H}
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Next, navigate to the area of your computer containing a folder you want to add.
Highlight the folder and then click “Include folder:”

Search Local Disk (C:)
Organize » Mew folder = o (7]
& Downloads i Mame Date modified Type Size
"5l Recent Places )
. ) ATI 8/18/2009 1:08 PM File folder
| pics
R J BMW M3 Challenge 8/20/200912:18 PM  File folder
) o / My Toolbar Folder 8/19/2009 11:55 AM  File folder
& Libraries )
) /| Perflogs 7/14/200912:20 AM  File folder
@ Accounting i ;
J Program Files 8/20/200912:14 PM  File folder
@ Documents ] o )
Jﬁ e J Program Files (x86) 8/20/2009 9:47 AM File folder
e | Users §/18/200912:45 PM  File folder
[ Pictures ) )
E . J Windows 8/18/2009 2:51 PM File folder
ideos
. Accounts receivable 8/20/2009 2:38 PM File folder
| Accounts payable 8/20/2009 2:38 PM File folder
Lo Computer )
- J Payroll 8/20/2009 2:39 PM File folder
&, Local Disk (C) _
. Expenses 8/20/2009 2:39 PM File folder
1 Accounts paya
) e 0 | 3
Folder: Accounts receivable
Include folder DJ [ Cancel ]

The new location will then be shown in the library:

Accounting library

: Arrange by: Folder *
Includes: 1 location

Mame Date modified Type Size

4 Accounts receivable (1)
Ch

@ receivable &/20/2009 2:41 PM Microsoft Office E...

To add another location, click the blue “1 location” text under the library title. Browse
and choose another folder. Repeat this process until you have added all the folders
you need to the library.

Don’t forget, you can add more locations to the default libraries too!
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You can even delete the existing libraries if you wish; just right-click the library you

want to remove and click Delete:

Libraries
Open a library to see your files and arrange them by folder, date, and other properties.
l“‘ ‘l‘ Accounting & Documents
\ ; h 1
\_-\/v/ Library <7 Library
= Music 4 Pictures ‘\
' Library “’v Library
Open in new window
ﬂ Videos
s, Library Share with 4

dified: 8/18/2009 4:08 PM

Don't show in navigation pane
Send to 4

Copy

Create shortcut
Delete

Rename

Properties

If you delete a library, you aren’t deleting the data included in them. Remember that
a library is just a convenient way to reference several file locations at once. If you
want to delete data for good, you will have to delete the source data manually.

7.3: Managing Files and Folders

The operation of every single computer program involves reading and processing the
instructions found in a file. From something as basic as Notepad to Windows 7 itself,
everything you can do and everything you see on the screen is a result of information

being read and processed from a file.

Creating and Naming Folders

You can create a folder just about anywhere on your computer in one of two ways. If
you are creating a new folder on the desktop, or in a folder, right-click on an empty
area, point to New, and click Folder (at the top of the list):
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Ei Catalyst(TM) Control Center

View
Sort by
Refresh

Paste
Paste shortcut

Undo Rename
New

Screen resolution
Gadgets

Personalize

CELEREJCEERBER BNE BME

Give the folder a name and then press Enter.

Folder I}

Shortcut

Microsoft Office Access 2007 Database
Bitmap image

Contact

Microsoft Office Word Document
Journal Document

Microsoft Office PowerPoint Presentation
Microsoft Office Publisher Document
Text Document

Windows Live Call

Microsoft Office Excel Worksheet
Compressed (zipped) Folder

Briefcase

Windows allows you to create a new folder at the same time you are saving a file. For
example, if you wanted to make a new folder for WordPad documents, you can do so
while saving the file. When you see the Save As dialog appear, click the “New folder”

command:
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Bid =9 - ~dlDocum MordP:

| =R Home View

L Cut = || === — —
-] Calibri T A& == EE RS
Copy
Paste B 7 U e X. |2~ A-|IE=E=E=E = | | Picture
- — — _— — — = -
Clipboard Font Paragraph

- g

1R 12

sample document

-

2 Save As

GG Jr@ b Libraries » Documents
Organize = Nmfolderh P

&
0 Favorites — [ Create a new, empty folder. h’
B Neckinn | | Includes: 2 locations

A new folder icon will appear. Give the folder a name and then press Enter:

Documents library

Includes: 2 locations

Mame

. BMW
. microsoft

| J.|WordPad Decuments] Il
. Snaglt Cataleg

In order to save something in the new folder, double-click the new folder’s icon, give
the file that is to be saved a name, and then click Save.
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Renaming and Deleting Folders

You can rename or delete a folder at any time (unless you are trying to save
something inside a folder that you are also trying to delete; Windows prevents these
errors). Simply right-click on the folder and select Rename or Delete. This can be
done with folders in Windows Explorer, in a Save dialog box, or folders on the
desktop:

Open

docUrment i
r Open as Motebook in OneMote

Share with
Snaglt

Restore previcus versions

Include in library
Send to

Cut

Copy

Create shortcut

Delete

Rename

Properties

If you click Delete, Windows will ask you to confirm your choice:

»

—  Are you sure you want to move this folder to the Recycle Bin?

' M™ '\ . documents
Date created: 8/20/2009 317 PM

Ves hJ[ No

Windows will not allow you to delete a folder if any of the files contained inside are
already in use.
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Creating and Naming Files

Creating a file is easy to do and is very similar to creating a folder. If you are not
using a program but know that you want to create a new text document (usable by
Notepad and others), right-click on an empty space on the desktop or in a Save
dialog, point to New, and then choose the file type:

El Catalyst(TM) Control Center
View
Sort by
Refresh

Paste
Paste shortcut
Undo Delete Ctrl+Z

New h
| B Screen resolution
@ Gadgets
& Personalize

Folder
Shortcut

Microsoft Office Access 2007 Database
Bitmap image

Contact

Microsoft Office Word Document

Journal Document

Microsoft Office PowerPoint Presentation
Microsoft Office Publisher Document
Text Document

Windows Live Call

Microsoft Office Excel Worksheet
Compressed (zipped) Folder

b
@
@
)
=
e
&
&
A
£
&

Briefcase

When you see the new icon appear on the desktop or in the Save dialog box, type a
new name for the file and press Enter.
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Sometimes programs are capable of saving a file in more than just one format. Paint,
for example, can save an image file in eight different image formats:

[ Pictures
B videos -

File name: Untitled

Save as type: EPN-G (*Eﬁ:,l

Menochrome Bitmap (%bmp*.dib)
16 Color Bitmap (*.bmp;*.dib)
* HideFolders 256 Color Bitmap (*.brmp;*.dib)
24-bit Bitmap (*.bmp;*.dib)
S JPEG (Mgt peg:tpe fif)
GIF (*.gif)
TIFF (*.tif* tiff)

Click the pull-down arrow beside the Save as type box and choose a format. Then
enter a name in the File name box and click Save. (Notice too that Paint will save a
file by default in the Pictures library.)

Renaming and Deleting Files

As you may have guessed, you can rename and delete a file just as you can a folder.
Right-click the file and click the appropriate command. Keep in mind that you cannot
rename nor delete a file while it is in use:

Open
Print

e

llaizy D

Create shortcut

Delete

Rename

Properties
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Cutting, Copying, and Pasting Files and Folders

Nearly every file type and every folder can be cut, copied, and pasted. If you are not
already familiar with these commands, they are used extensively by many programs.

The Cut command will remove the information from one location and store it in a

special part of the operating system called the clipboard. The clipboard is a repository
memory location that can only hold one item, but that item can be of any size. Using
the Paste operation, the object that was cut can be placed somewhere else one time.

The Copy command makes a 1:1 copy of the original and keeps it in the clipboard.
The object can then be pasted as many times as needed into a location. Whenever a
new item is cut or copied to the clipboard, it overwrites the old object.

These concepts are best shown by example. Imagine you are looking at a word
processing document and want to perform some editing on the document:

Title

Opening Paragraph
Faragraph 1
Faragraph 2
Faragraph 3

Conclusion

You want to remove the title, blend the Opening Paragraph into Paragraph 1, and
move Paragraph 3 before Paragraph 2. You can simple erase the title if it is no longer
needed, though you could cut it if you like. Next, combine the opening paragraph and
Paragraph 1 together:

Opening Paragraph / Paragraph 1
Faragraph 2
Paragraph 3

Conclusion
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To cut and paste Paragraph 3 and put it in front of Paragraph 2, highlight Paragraph
3:
Opening Paragraph / Paragraph 1

Paragraph 2

Conclusion

Then press Ctrl + X to cut the object. It will be removed from the document and
saved in the memory of the computer:

Opening FParagraph / Paragraph 1
Paragraph 2
| —

Conclusion

Click between the opening and Paragraph 2 (press Enter to create a new space if you
like) and then press Ctrl + V to paste Paragraph 3:

Opening Paragraph / Paragraph 1
Paragraph 2
Paragraph 3

Conclusion

The same operation of Ctrl + X and Ctrl + V works for files and folders too. You can
cut a folder from the desktop and paste it just about anywhere using these
commands. They are also accessible by right-clicking on a file or folder and clicking
Cut:

Open
Open as Notebook in OneNote

Share with
Snaglt
Restore previous versions

Include in library

Send to

Cut
Copy

An icon that has been “cut” will appear faded while placed on the clipboard:
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Now open a target location, right-click inside the folder, and click Paste. If you want to
place the same file or folder in many locations, use the Copy command. The original
object will remain where it is, and a copy will be placed in the clipboard. Now you can
Paste the object as many times and you like into many different locations. The copied
object will remain in memory until it is overwritten by cutting or copying something
else, or the computer is restarted.

7.4: Advanced File Management

Viewing File Properties

Every file has properties. These include the date and time of file creation, the name, if
the file is labeled as read-only, and more. You can view the properties of a file by
right-clicking it and clicking Properties:

= Chrysanthernus
Preview
Set as desktop background
Edit

Open file location

Properties
s

The <file name> Properties dialog box will appear. Though every file has different
property values, the four main categories of properties are the same for every file.

Let’s go over the four main property categories:

‘ | General | Security | Details | Previous Versions | ‘

General Vital statistics about the file itself, such as when it was
created, last accessed, and modified; how large the file is; and
more. Some interesting properties include the ability to make
the file read-only or hidden. A read-only file cannot be
modified or deleted, while a hidden file does technically still
exist, but is hidden from the standard file view.

Security You can restrict which users can see the file and how they can
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interact with the file. Permission to modify these settings is
limited to computer administrators.

Details Properties listed here are like the properties in the General
tab, only these properties are based on the characteristic of
file. Some files, such as a picture file, can have over 60
different properties. Which of these properties can be modified
in the Properties dialog box depends on the type of file.

Previous If you used the backup feature of Windows to create a backup

Versions of this file (or the folder that contains this file) you can revert
a file to a previous version. Select a backup instance from the
list and click Restore.

Click OK to accept any changes you have made.

Viewing Folder Properties

Folders, like files, also have properties. To view the properties of a folder, right-click
on the folder and click Properties:

Open

Open as Notebook in OneMote

Share with

Rename

Properties I

LAY

The <folder name> Properties dialog box will appear. Like the File Properties dialog
box, it too has common tabs:

o S

| General |Sharir1g | Secuﬁt'_.rl Previous Versions | Custumize|

General Vital statistics about the folder such as save location, how
large the folder and its contents are, and how many files are
contained inside. You also have read-only and hidden
properties to enable or disable if you wish.

Sharing You can share the contents of the folder with another person
on your network. You can also allow the folder to be shared
over the whole Internet, modify who has which permissions,
and more.
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Security

Previous
Versions

Customize

You can restrict which users can see the folder and how they
can interact with the contents. Permission to modify these
settings is limited to computer administrators. Folder security
differs from Sharing properties in that the Security settings
only apply to local users who have an account on the
computer.

If you used the backup feature of Windows to create a backup
of this folder you can revert a folder’s contents to a previous
date. Select a backup instance from the list and click Restore.

The Customize tab lets you design the look and feel of the
folder itself. You can make a folder look like a Pictures or
Music folder, change the picture that is displayed on the
folder, and change the picture used for the inside of the
folder’s icon.

Click OK to accept any changes you have made.

Sharing a File or Folder

Windows allows you to share a file with other users of the local computer or someone
else across a network of computers, including the Internet. To share a file, right-click
on the file and click “Share with:”

Open
Print

Edit

Open with

Share with & Nobody

Restore previous versions % Homegroup (Read)

Send to Homegroup (Read/Write)

Cut Specific people...

If you select Nobody, that particular object will only be accessible by your account. If
you share a file with your Homegroup, other Windows 7 users on the same network
will be able to read or read/write (make changes) to the file.
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If you click Specific people, the File Sharing dialog will open. Click the pull-down arrow
to select a name from the list (or opt to share the file with everyone in the list of
users). When you have highlighted a name, click Share:

Choose people to share with

Type a name and then click Add, or click the arrow to find somecne,

Velsoft
Everyone
Create a new User..,

I'm having trouble sharing

[ I@Shr:ma ][ Cancel ]

After you click Share, you will be shown a list of successful file(s) that have been
shared. Click Done to complete the sharing process:

Your file is shared.

You can 2—ma|§ someone links to these shared items, or copy and paste the links into another program.

Individual Iterns

& shopping list
7' YWWELSOFT-PC\Users\Velsoft\Desktopshopping list.bt

ﬁ Shared iterns aren't accessible when your computer is asleep.

Show me all the network shares on this computer.
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Sharing a folder is very similar. Open the File Sharing dialog box by using the right-
click command or the folder properties. Select which user you want to share the folder

with and click Share.

Burning Files, Folders, and ISOs

We know that we can burn any file type to a recordable CD or DVD. Imagine that you
want to make a hard copy of all items in your Documents folder. Open the folder to
view all files and then click the Burn command:

Date modified
8/21/2009 9:30 AM
8/18/2009 2:49 PM
8/21/2009 9:26 AM
8/18/20091:13 PM
8/18/20091:11 PM
8/18/2009 2:00 PM
8/21/2009 10:09 AM
8/20/2009 3:12 PM
8/18/2009 2:20 PM

Organize = Share with = Burn MNew folder
W Favorites : Documﬂ Burn the selected files and folders to I
Ml Desktop Includes: 2 | disc.
& Downloads Name .
= Recent Places
) L . Fax
 ples 1 . micrasoft
o ./ Scanned Docurments
w3 Libraries ) ./ Snaglt Catalog
gl] Accounting R . Windows 7 Qutlines
@ DDCL-.IFI"IEr'ItS . Windows 7 Ultimate Foundation
J’ MUSIC . Windows 7 Ultimate Intermediate
= Pfctures . WordPad Documents
E Videos shopping list
_ - 4| e
=5 10 items

Insert a blank CD if you haven't already. (We are using a CD-R.)

-

Burn to Disc

=2

b
>

Insert a disc

Pleasze insert a writable disc into drive D,

Help me choose a disc

Cancel

<9 M) BT
=~ 0l @

Arrange by:  Folder =

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

m

Rich Text Format -

3
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Next, give the disc a title. You may also see the following options depending on your
hardware or the type of disc you have inserted. Make your choice and click Next:

s )
Burn a Disc @

How do you want to use this disc?

Disctitle:  Documnents backup

(71 Like a USE flash drive

Save, edit, and delete files on the disc anytime. The disc will
work on computers running Windows XP or later. (Live File
Systemn)

i@ With a CD/DVD player
Burn files in groups and individual files can't be edited or
removed after burning, The disc will alse work on most
computers. (Mastered)

Which one should I choose?

[ ng[ Cancel |

h_ — i

Windows will start to burn the files onto the CD showing you progress as the process
is working. When completed, the disc will eject and ask if you want to burn another
copy of the same thing on a new disc. Once the process is completed, you can browse
the disc contents using Windows Explorer or by clicking Start > Computer and then
double-clicking your CD or DVD drive.

Windows 7 includes the ability to burn ISO files without having to download a third
party program. An ISO file is a CD or DVD image file. If you download programs from
the Internet, sometimes the programs come in ISO form. These types of files are
usually quite large (hundreds of megabytes) and contain the complete image of a
program disc.

Windows 7 will recognize ISO files. To burn an ISO image, just double-click the file:

C=a e X
Downloads - [ ¥4 | Search Download's ye |
library = Share with = Burn Mew folder ==« i .@.
MName Date modified Type Size
| |24 Program_Mame.iso " 8/18/2009 3:54 PM Disc Image File 354,244 KB|

b

Windows will prompt you to insert a recordable CD or DVD. Click Burn to record the
image file:
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%

. Windows Disc Image Burner

Disc image file: Prograrm_Mame.iso
Dizc burner: DVD R Drive (D) vl
Status

To start burning the disc image, click Burn.

[] Verify disc after burning

Burn {}J ’ Cancel

Printing a File

Many programs have the ability to print the file you are working on. The printing

dialog box is different for each program, and each printer has different specifications.
Nonetheless, many of the printing dialog boxes have similar characteristics. Let’s look

at the Print dialog box for WordPad:

o

gég Print

S

General

Select Printer

% Add Printer
w Canen Inkjet MPT60 Series

= Fax

@Micrusnf‘t KPS Documen
re= Snaglt 8

k

1 | 1]
Status: Ready (7] Print to file
Location:
Comment:
Page Range
@ Al Number of copies: 1 =
Selection Curmrert Page
(") Pages: 1-65535 Collate
) ) ) 1213 1213
Enter either a single page number ar a single 1 1
page range. For example, 512
Prirt ,\J [ Cancel ] Apphy
L
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Select Printer

Preferences

Page Range

Number of Copies

Collate

Choose a printer or printing service to print the file. Most
users only have access to one printer at a time, and that
printer will be installed as the default printer so this step
becomes largely unnecessary. However, there are software
programs that can take the printed document that your
computer would send to a printer and instead turn it into
some other document, such as a PDF file that can be
viewed on many different computer platforms.

Nearly every Print dialog box has a Preferences or
Properties button which is used to adjust the settings of
the printer. This button will allow you to select your paper
size and paper type, print quality, and more depending on
the capabilities of your printer.

If your document is more than one page, you have the
option to print the entire document, print only selected text
(useful when printing from Internet Explorer), printing only
the currently displayed page, or printing a range.

Specify as many copies as you like. Either type a number
in the text box or use the small arrow buttons to adjust the
range. Windows will keep printing copies as long as there is
paper!

Check this box to activate collation printing. Most printing
programs will print multiple copies of a three page
document like this: 1, 2, 3, 1, 2, 3, etc. until the desired
number of copies has been printed.

If you click the collate checkbox, three copies of a four
page document will print like this: 1, 1, 1, 2, 2, 2, 3, 3, 3,
4, 4, 4. This will make separating the document easier in
some situations.

Click the Apply button to save the current print settings for future use when using this
particular printing program. Click Print to begin printing your document.
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